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VISION

To ensure that the Diploma Level Technical Education constantly matches the latest
requirements of technology and industry and includes the all-round personal development of
students including social concerns and to become globally competitive, technology led

organization.
MISSION

To provide high quality technical and managerial manpower, information and consultancy
services to the industry and community to enable the industry and community to face the

changing technological and environmental challenges.
QUALITY POLICY

We, at MSBTE, are committed to offer the best-in-class academic services to the students and
institutes to enhance the delight of industry and society. This will be achieved through
continual improvement in management practices adopted in the process of curriculum design,
development, implementation evaluation and monitoring system along with adequate faculty

development Programs.

CORE VALUES

MSBTE believes in the followings:

« Skill development in line with industry requirements.

« Industry readiness and improved employability of Diploma holders.
« Synergistic relationship with industry.

« Collective and cooperative development of all stake holders.

- Technological interventions in societal development.

« Access to uniform quality technical education.
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Preface

The primary focus of any engineering laboratory/field work in the technical education
system is to develop the much-needed industry relevant competencies and skills. With this in view,
MSBTE embarked on this innovative ‘K’ Scheme curricula for engineering diploma programs with
outcome- based education as the focus and accordingly, a relatively large amount of time is allotted
for the practical work. This displays the great importance of laboratory work, making each teacher,
instructor and student realize that every minute of the laboratory time needs to be effectively utilized
to develop these outcomes, rather than doing other mundane activities. Therefore, for the successful
implementation of this outcome-based curriculum, every practical has been designed to serve as a
‘vehicle’ to develop this industry identified competency in every student. The practical skills are
difficult to develop through ‘chalk and duster’ activity in the classroom situation. Accordingly, the
‘K’ scheme laboratory manual development team designed the practicals to focus on the outcomes,
rather than the traditional age-old practice of conducting practical’s to ‘verify the theory’ (which
may become a byproduct along the way).

This laboratory manual is designed to help all stakeholders, especially the students, teachers
and instructors to develop in the student the predetermined outcomes. It is expected from each
student that at least a day in advance, they have to thoroughly read through the concerned practical
procedure that they will do the next day and understand the minimum theoretical background
associated with the practical. Every practical in this manual begins by identifying the competency,
industry relevant skills, course outcomes and practical outcomes which serve as a key focal point for
doing the practical. The students will then become aware about the skills they will achieve through
the procedure shown there and necessary precautions to be taken, which will help them to apply in
solving real-world problems in their professional life.

This manual also provides guidelines to teachers and instructors to effectively facilitate
student- centered lab activities through each practical exercise by arranging and managing necessary
resources in order that the students follow the procedures and precautions systematically ensuring
the achievement of outcomes in the students.

VLSI (Very Large Scale Integration) technology plays a pivotal role in the design and
development of modern electronic systems, enabling the integration of millions of transistors onto
a single chip. It forms the foundation of advanced processors, memory devices, digital circuits, and
system-on-chip (SoC) architectures used in computing, communication, automation, and consumer
electronics. Understanding the principles of MOS devices, CMOS technology, digital logic design,
and chip-level implementation is essential for aspiring engineers in the fields of electronics,
communication, and embedded systems.

Although best possible care has been taken to check for errors (if any) in this laboratory
manual, perfection may elude us as this is the first edition of this manual. Any errors and suggestions
for improvement are solicited and highly welcome.

Maharashtra State Board of Technical Education i
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Program Outcomes (POs)

Following program outcomes are expected to be achieved through the practical of the course.

PO1: Basic and Discipline specific knowledge: Apply knowledge of basic mathematics,
science and engineering fundamentals and engineering specialization to solve the broad-
based Electronics Engineering group program problems.

PO2: Problem analysis: Identify and analyze well-defined Electronics Engineering group
program problems using codified standard methods.

PO3: Design/ development of solutions: Design solutions for broadly-defined technical
problems and assist with the design of Electronics Engineering group program systems
components or processes to meet specified needs.

PO4: Engineering Tools, Experimentation and Testing: Apply modern Electronic
Engineering group program tools and appropriate technique to conduct standard tests and
measurements.

PO5: Engineering practices for society, sustainability and environment: Apply
appropriate Electronics Engineering group program technology in context of society,
sustainability, environment and ethical practices.

POG6: Project Management: Use Electronics Engineering group program management
principles individually, as a team member or a leader to manage projects and effectively
communicate about well- defined engineering activities.

PO7: Life-long learning: Ability to analyze individual needs and engage in updating in
the context of Electronics Engineering group program technological changes.

Maharashtra State Board of Technical Education
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List of Industry Relevance Skills

The aim of this course is to attend following industry/employer excepted outcome through
various teaching learning experiences:
Develop VLSI-based electronic circuit/component using VHDL

= Ability to write, simulate, and debug hardware description language programs-essential
for FPGA/CPLD design and ASIC development.

= Using tools like Xilinx ISE, Vivado, ModelSim to verify design correctness before hardware
implementation — a Key step in professional VLS| workflows.

= Hands-on experience programming and testing designs on FPGA/CPLD trainer Kits
bridges the gap between simulation and real hardware.

Maharashtra State Board of Technical Education
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Practical - Course Outcome matrix

Course Level Learning Outcomes (COs)

CO1 - Interpret CMOS technology circuits and its applications.
CO2 - Develop digital circuits on CPLD and FPGA devices
CO3 - Use VHDL to develop and test digital circuits.

CO4 - Develop VHDL program for given application.

CO5 - Interpret VHDL simulation and synthesis

Sr. ) . CO | CO | CO CO (6{0)
Title of the Practical
No. 1 2 3 4 5
*|dentification of internal block and pin configuration of FPGA
1 | andCPLD ; v . ]
5 *Installation of EDA tool and the relevant libraries for VLSI
" | code development - - v - -
3 *Develop VHDL code for basic and universal gate for data flow
" | model - - v | - -
Develop VHDL code for basic and universal gate for behavioral
4. | model - - v | - -
5 *Realize the half and full Adder on FPGA board
. - - \/ - -
6 *Realize the Multiplexer on FPGA board
. - - J - -
Realize the De-multiplexer on FPGA board
7. - i v - -
Design 4:2 encoder on FPGA board
8. . - v R -
9 Design 3:8 decoder on FPGA board
. - - \/ - -
*Realize the D and T flipflop on FPGA board
10. R - v - -
Design Comparator on FPGA board
11. _ - v - -
Design Up Counter on FPGA board
12. - - v - -
Design Synchronous counter on FPGA board
13. . R v R -
14 Design binary to gray code converter circuit using FPGA board
. - - J - -
*Design digital to analog converter (DAC) using FPGA board
15. - - _ v -
*Design stepper motor Controller using FPGA board
16. - - - - v
Design of 4-bit ALU/ sequence detector using FPGA board
17. - - - - v
Maharashtra State Board of Technical Education iv
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10.

11.

Guidelines to Teachers

Teacher should provide the guideline with demonstration of practical to the students
with all features.

Teacher shall explain prior concepts to the students before starting of each practical.
Involve students in the performance of each experiment.

Teacher should ensure that the respective skills and competencies are developed in the
students after the completion of the practical exercise.

Teachers should give opportunities to students for hands-on experience after the
demonstration.

Teacher is expected to share the skills and competencies to be developed in the students.
Teacher may provide additional knowledge and skills to the students even though not
covered in the manual but are expected of the students by the industry.

Finally give practical assignments and assess the performance of students based on tasks
assigned to check whether it is as per the instructions.

Teacher is expected to refer complete curriculum document and follow guidelines
for implementation

At the beginning of the practical which is based on the simulation, teacher should make
the students acquainted with required simulation software environment.

Teachers should use the projector/smart board effectively by preparing materials in
advance, ensuring clear visibility, engaging students interactively, and maintaining proper
digital discipline and equipment safety.

Instructions for Students

Listen carefully to the lecture given by the teacher about course, curriculum, learning
structure, skills to be developed.

Organize the work in the group and make a record of all observations.

Do the calculations and plot the graph wherever it is required in the practical
Students shall develop maintenance and safety skills as expected by industries.
Student shall attempt to develop related hand-on skills and gain confidence.

Student shall develop the habits of evolving more ideas, innovations, skills etc. those
included in scope of manual

Student should develop the habit to submit the practical on date and time.

Student should prepare well while submitting a write-up of exercise.

Maharashtra State Board of Technical Education
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Content Page
List of Practical’s and Progressive Assessment Sheet
Dated
Sr. Title of th ical Page Date of Date of Asigzsrrﬂgnt Scl)gn Remarks
itle of the practica issi i
No. Y No. | performance | submission (25) teache (if any)
r
1 *1dentification of internal block and pin 1
configuration of FPGA and CPLD
2 *Installation of EDA tool and the relevant 8
libraries for VLSI code development
*Develop VHDL code for basic and universal
3 17
gate for data flow model
Develop VHDL code for basic and universal
4 . 33
gate for behavioral model
*Realize the half and full Adder on FPGA
5 41
board
6 Reali . 52
ealize the Multiplexer on FPGA board
7 Realize the De-multiplexer on FPGA board 61
8 L 71
Design 4:2 encoder on FPGA board
9 . 80
Design 3:8 decoder on FPGA board
10 |, . . 91
Realize the D and T flipflop on FPGA board
11 |Design Comparator on FPGA board 104
12 |Design Up Counter on FPGA board 112
13 |Design Synchronous counter on FPGA board 124
14 Design binary to gray code converter circuit 139
using FPGA board
15 *Design digital to analog converter (DAC) 151
using FPGA board
I .
16 Design stepper motor Controller using FPGA 163
board
17 Design of 4-bit ALU/ sequence detector using 175
FPGA board
Total
Note: Out of above suggestive LLOs —
e "*Marked Practical’s (LLOs) Are mandatory.
¢  Minimum 80% of above list of lab experiment are to be performed.
o Judicial mix of LLOs are to be performed to achieve desired outcomes.
Maharashtra State Board of Technical Education Vi
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Practical No.1: *Identification of internal block and pin configuration of FPGA

\4

and CPLD

Practical Significance

A Field Programmable Gate Array (FPGA) is a reconfigurable digital device consisting of an
array of logic cells and programmable interconnects, all of which are fully controlled by the
user. This flexibility allows designers to implement, modify, and optimize digital circuits
according to specific application requirements. Similarly, a Complex Programmable Logic
Device (CPLD) is an integrated circuit used to design and implement digital hardware systems
such as those found in mobile devices and embedded applications. Through this practical,
students will gain hands-on experience in identifying various functional blocks, architecture,
and pin configurations of FPGA and CPLD, thereby understanding their roles in digital system
design.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome
through various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Develop digital circuits on CPLD and FPGA devices.

Laboratory Learning Outcomes

e LLO 1.1 Identify various blocks of FPGA and CPLD.
e LLO 1.2 Test the functionality of various pins of FPGA and CPLD.

Relevant Affective Domain related outcomes

e Demonstrate in exploring and implementing digital circuits using CPLD and FPGA
platforms.

e Practice good housekeeping.

e Exhibit responsibility while handling programmable logic devices and related laboratory
equipment.

Relevant Theoretical Background

Field-programmable gate array (FPGA): A field-programmable gate array (FPGA) is an
integrated circuit designed to be configured by a customer or a designer after manufacturing,
hence "field-programmable”. The FPGA configuration is generally specified using a hardware
description language (HDL), similar to that used for an application-specific integrated circuit
(ASIC) (circuit diagrams were previously used to specify the configuration, as they were for
ASICs, but this is increasingly rare).

FPGAs contain programmable logic components called "logic blocks™, and a hierarchy of
reconfigurable interconnects that allow the blocks to be "wired together" — somewhat like
many logic gates that can be inter-wired in different configurations. Logic blocks can be
configured to perform complex combinational functions, or merely simple logic gates like
AND and XOR. In most FPGAs, the logic blocks also include memory elements, which may
be simple flip-flops or more complex blocks of memory

Maharashtra State Board Of Technical Education 1
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Complex Programmable Logic Device (CPLD): A Complex Programmable Logic Device
(CPLD) is a combination of a fully programmable AND/OR array and a bank of microcells.
The AND/OR array is reprogrammable and can perform a multitude of logic functions.
Microcells are functional blocks that perform combinatorial or sequential logic, and also have
the added flexibility for true or complement, along with varied feedback paths

VIl  a. Suggested block diagram:

[Inputmutput Blocks ]
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Fig. no. 1.2 Block Diagram of CPLD

Maharashtra State Board Of Technical Education 2



VLSI Applications (316340)

b. Actual block diagram used in laboratory with related equipment rating.
e CPLD Development board:

e FPGA Development board:

Maharashtra State Board Of Technical Education
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VIl Required Resources/apparatus/equipment with specifications
Table 1.1 Required Resources
Instrument/ R :
S.N. Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
1 | FPGA Development hardware circuit., On board, 2 Crystal 8MHz and 1 No
kit 25MHz. JTAG Interface (Boundary Scan),PROM '
Interface (XCF02S),40 pin, 4 header connector for
external I/O's
Personal computer with latest configuration.
2 | Desktop PC Loaded with open-source IDE, simulation and 1 No.
program downloading software, UPS and
Antivirus.
CPLD Development Board (e.g., Xilinx XC9500, Altera
3 |CPLD MAX7000, , Power Supply (5V / 3.3V), Connecting
Wires / Jumpers
IX Precautions to be followed
1. Do not power up the development board when identifying the components on the board.
2. Refer data sheets for the given development board.
X Procedure
e Place the kit on the ESD mat and connect nothing to it. Inspect the board visually.
e Locate and note labels printed on PCB: device part number, JTAG header, VCC/VCCIO pins,
GND, CLK, LED groups, switches. Photocopy or take a photo of the board labels for the
record.
e Find the board’s pinout silkscreen and compare with the device datasheet and board user
manual. Note any discrepancies.
e With power off, use the multimeter in continuity mode to confirm ground plane: probe board
GND silkscreen and other GND points (e.g., connector shell). Record locations.
. Identify VCC, VCCIO, VCCINT pins from datasheet / silkscreen. With power off, do not
apply any voltage checks beyond continuity. Document the supply voltages required (e.g.,
3.3V, 2.5V).
Xl Resources
Table 1.2 Resources
ﬁg Name of Resource Specifications Quantity
1
2
3

Maharashtra State Board Of Technical Education
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X1l Actual Procedure

XIIl  Observation Table
Observe the pin out diagram for FPGA and give the functions of following pins:

Table 1.3 Functions of FPGA Trainer Kit pins

Sr No Pins Functions
1. JTAG
2. DCI
3. DUAL
4. VCCO
5. GCLK

Table 1:4 Functions of CPLD Trainer Kit pins

Pins Functions

VCC
GND
1/0 Pins
CLK
RESET
JTAG
OE (Output Enable)

TDI/TDO/TMS / TCK

VCCINT /VCCIO
GCLK

Blo| o \lcncnpooml—\_g;n
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XIV Result:

XV  Interpretation of results:

XVI Conclusion and recommendation:

XVII Practical related questions
Note: Below given are few sample questions for reference. Teacher must design more
such questions so as to ensure the achievement of identified CO.
1. Explain the process of assigning input and output pins in CPLD/FPGA devices.
2. Describe the procedure used to test the functionality of various pins of FPGA/CPLD.
3. Give one real-life example where FPGA/CPLD is used.

[Space for Answers] (If required attach separate page)

Maharashtra State Board Of Technical Education 6
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XVI1I References/Suggestions for further reading
Table 1:5 References

Sr. . L
NoO Link / Portal Description
https://www.youtube.com/watch?v=gCAYYOfHPg4andt=329 | NPTEL IT Kharagpur Lecture
1 S 60: PAL, PLA, CPLD, FPGA
CPLD Datasheet Xilinx DS054 XC9500XL High-Performance XC9500XL High-Performance
2 CPLD Family Data Sheet, Data Sheet CPLD
Family Data Sheet
FPGA Datasheet Agilex™ 3 FPGAs and SoCs C-Series Agilex™ 3 FPGAs and SoCs C-
3 Product Table Series Product Table

XIX Assessment Scheme

Performance Indicators Weightage
Process Related : 15 Marks 60 %
1 | Handling of the components 10%
2 | ldentification of components 20%
3 | Connections between the components 20%
4 | working in teams 10%
Product Related: 10 Marks 40%
5 | Interpretation of result 10%
6 | Conclusion 10%
7 | Practical related questions 15%
8 | Submitting the journal in time 5%
Total (25 Marks) 100 %
Marks Obtained Dated signature of Teacher
Process Related Product Related Total
(15) (10) (25)

Maharashtra State Board Of Technical Education
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Practical No.2: *Installation of EDA tool and the relevant libraries for VLSI code

Vi

Vil

development

Practical Significance

The Electronic Design Automation (EDA) industry develops software to support engineers in
the creation of new integrated-circuit (IC) designs. Due to the high complexity of modern
designs, EDA facilitates almost every aspect of the IC design flow, from high-level system
design to fabrication. EDA addresses designers’ needs at multiple levels of electronic system
hierarchy, including integrated circuits (ICs), multi-chip modules (MCMs), and printed circuit
boards (PCBs). This practical develop skill for EDA software tools installation

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome
through various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Develop digital circuits on CPLD and FPGA devices.

Laboratory Learning Outcomes

e LLO 2.1 Install relevant EDA (such as Xilinx software) tool for VHDL.
e LLO 2.2 Check the VHDL libraries installed in VHDL environment.

Relevant Affective Domain related outcomes
e Maintain accuracy and attention to detail while checking VHDL libraries.
e Exhibit willingness and curiosity to explore new EDA tools and VHDL environments.

e Follows good lab practices, respects licensing terms, and promotes responsible software
handling.

Relevant Theoretical Background

Xilinx ISE (Integrated Synthesis Environment) is a software tool produced by Xilinx for
synthesis and analysis of HDL designs, enabling the developer to synthesize (“compile™) their
designs, perform timing analysis, examine RTL diagrams, simulate a design's reaction to
different stimuli, and configure the target device with the programmer.

Xilinx ISE is a design environment for FPGA products from Xilinx, and is tightly-coupled
to the architecture of such chips, and cannot be used with FPGA products from other vendors.
The Xilinx ISE is primarily used for circuit synthesis and design, while ISIM or the Model
Sim logic simulator is used for system-level testing. Other components shipped with the
Xilinx ISE include the Embedded Development Kit (EDK), a Software Development Kit
(SDK) and Chip Scope Pro.

Suggested block diagram: ------- NA -------

Maharashtra State Board Of Technical Education 8
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VIl Required Resources/apparatus/equipment with specifications
Table 2.1 Required Resources

Instrument/ e .
No Components Specification Quantity
1 Desktop PC Pgrsonal computer with _Iatest qonflguratlon. Loaded 01
with open-source IDE, simulation and program
downloading software, UPS and Antivirus.

IX Precautions to be followed

Follow steps in sequence to execute system properly.

X Procedure
Steps for installing Xilinx Software (EDA Tool)
1. Click on the setup file to install Xilinx GUI icon

(e

® Welcome
’ t:__'“ | We are glad you've chosen Xilinx as your platform development partner. This program will install ISE
\ . H"‘I, | design environment, Software development kit or Lab tools.

You will need to have administrator privileges in order to install this software on Windows operating
systems.

For the product you select to install, we recommend that you identify a directory that does not
contain an older installation of the same product version.

Note - To reduce installation time, we recommend that you disable any anti-virus software before
continuing.

ISE 14.7 Installer

-> Welcome
Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory
Installation

Copyright (c) 19952013 Xilirs, Inc. All rights
reserved.

XILINK, the iinx logo and other designated
brands inchaded hersin are trademarks of Xilink,
Inc. All other pademarks are the property of
their respective owners.

MNext > | Cancel

Fig. no. 2.1: Xilinx Installer Welcome Screen.

2. Click next on the Xilinx Agreement window.

Maharashtra State Board Of Technical Education
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Accept License Agreements (1 of 2)

Please read the following terms and conditions and click the checkbox below it to indicate that you
accept and agree.

XILINX, INC. ﬂ
END USER LICENSE AGREEMENT

CAREFULLY READ THIS END USER LICENSE AGREEMENT ("AGREEMENT"). BY CLICKING THE
"ACCEPT" OR "AGREE" BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING, INSTALLING OR
USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY THIS
AGREEMENT.

ISE 14.7 Installer IF LICENSEE DOES NOT AGREE TOALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT,
DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON OR ACCESS, DOWNLOAD, INSTALL OR USE
Welcome THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROMAN

.y L Ag AUTHORIZED SOURCE, PROMPTLY RETURN IT FOR A REFUND.

Select Products to Install 1. Definitions
Select Installation Options
Select Destination Directory “Authorization Codes” means any FLEXIm li key, li file, li manager, dongle or other
Installation key, code or information issued by (or on behalf of) Xilinx that is necessary to download, install, operate
and/or regulate User access to the applicable Software.

=l
¥ Iaccept and agree to the terms and conditions above

¥ 1also accept and agree to the following terms and conditions

1 also confirm that I have read Section 13 of the terms and conditions above concerning WebTalk and have been afforded
Gonyriht (c) 1585-2013 . Inc. AN rights the oppartunity to read the WebTalk FAQ posted at http: //www.xdlinx.com/ise fivebtalk/. Tunderstand that I am able to
xmux. the Y logo and cther designated disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by
beands inchoded harein are wademacks of iine, UNINstaling the Software or using the Software on a machine not connected to the internet. IfI fail to satisfy the
Irc. All other rademarks are the propenty of applicable criteria or if I fail to take the applicable steps to prevent such transmission of information, I agree to allow Xilinx
their respactive owners. to collect the information described in Section 13(a) for the purposes described in Section 13(b).

<sak || net> | cance

Fig. no. 2.2 a: Xilinx License Agreement window

@ Accept License Agreements (2 of 2)

Flease read the following terms and conditions and click the checkbox below it to indicate that you
accept and agree.

CAREFULLY READ THIS COLLECTION OF INFORMATION AND LICENSE AGREEMENTS. BY
CLICKING THE "ACCEPT™ OR "AGREE™ BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING,
INSTALLING OR USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICEMSEE TO BE BOUND BY
THIS INFORMATION AND LICENSE AGREEMENTS (TO THE EXTENT APPLICABLE TO THE SPECIFIC
SOFTWARE YOU OBTAIN AND THE SPECIFIC MANMER IN WHICH YOU USE SUCH SOFTWARE).

SUITE

IF LICENSEE DOES NOTAGREE TOALL OF THE INFORMATION AND LICENSE AGREEMENTS
BELOW, DO NOT CLICK THE "ACCEPT  OR "AGREE"™ BUTTOM OR ACCESS, DOWNLOAD, INSTALL
OR USE THE SOFTWARE; AND IF LICENSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN
AUTHORIZED SOURCE, PROMPTLY RETURN IT FOR A REFUND

Welcome ) )
. U s Part One: Overview
e The following information applies to certain items of third-party technology that are included along with
Select Installation Options certain Xilinx software tools.
Select Destination Directory
Installation The Xilinx Embedded Development Kit (EDK) is a suite of software and other technology that enables

Licensee to design a complete embedded processor system for use in a Xilinx Device. EDK includes,
among other components, (a) the Xilinx Platform Studio (XPS), which is the development environment,
or GUI, used for designing the hardware portion of an embedded processor system; and (b) the Xilinx
Software Development Kit (SDK), which is an integrated development environment, complementary to
KPS, thatis used to create and verify C/C++ embedded software applications. SDK is also made
available separately from EDK.

m’,;dg X () 19952013 fre. All ig Licensee's use ofthe GNU compilers (including associated libraries and utilities) that are supplied
XILINX, the Xiinx logo and other designated | With SDK may cause Licensee’s software application (or board-support package) to be governed by Ll
brands incluided herein are trademarks of Xilin:, s me e . - . o . s e s .- ..

Inc, All other trademarks are the property of
thair nespective owners,

¥ I accept and agree to the terms and conditions above

Fig. no. 2.2b: Xilinx License Agreement window contd...
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3. Select the products to install.

Select Products to Install

' = Edition List
‘ T ISE WebPACK

DESIGN SUITE © ISE Design Suite Logic Edition
" ISE Design Suite Embedded Edition
" ISE Design Suite DSP Edition

f* |SE Design S m Ec N
" Lab Tools - Standalone Installation

ISE 14.7 Installer

Welcome
Accept License Agreements
-> Select Preducts to Install

Disk Space Required : 20439 MB

Select Installation Options — Description of ISE Design Suite System Edition
Sel N

Installation This installation contains everything you need to do a complete system design. It includes ISE
Design Suite Logic Edition, the Embedded Development Kit (EDK) and System Generator for DSF.

Copyright (c} 19952013 Xinx, Inc. All rights
reserved.

XILINX, the Xiinx logo and other designated
brands inchuded herein are wrademarks of X,
Inc. Al other wademarks are the property of
their respective owners.

Figo. 2.3: Select products to install.

4. Select the Installations options.

Select Installation Options

Select the desired installation options below. Selection of these options may result in additional
programs being run at the conclusion of the installation process.

¥ Use multiple CPU cores for faster installation

| quire or Manage a Licens:

B4 Install WinPCap for Ethernet Hardware Co-simulation

[ Install Cable Drivers

] Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for We

Welcome

Select Products to Install

-> Select Installation Options Select/Deselect All I
Select Destination Directory

— Description of Acquire or Manage a License Key

Installation

Most Xilinx applications now require a license key file in order to run. If this selection is enabled,
the Xilinx License Configuration Manager will be opened in order to assist you either in acquiring
a new license file or in managing an existing license file. If this is your first time using Xilinx ISE
Design Suite 14.7, it is highly recommended that you use this application to acquire or install
your license file.

Copyright (c) 1995-2013 Xiree, Inc. All rights
reserved,

XILINX, the Xiinx logo and other designated
brands incladad harsin on wadumars: of Y,

Fig. no. 2.4: Installations options
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5. Select the destination path.

CISE

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options
-> Select Destination Directory

Installation

Copyright (<) 1995-2013 Xilinx, Inc. All rights
reserved.
XILINX, the Xiinx logo and other designated
brands included herein are trademarks of Xilinx,
Inc. All other trademarks are the property of
their respective owners.

Select Destination Directory

Select the directory where you want the software installed.

IE:

Install location(s) :
E:14.7\ISE_DS

Disk Space Required : 20439 MB

Disk Space Available : 187132 MB

¥ Create Start Menu and Desktop Icons

Select a Program Folder

This name will appear in the Start Menu > Programs list.

| Xilinx Design Tools :]

¥ Tool preferences and file association
Import tool preferences from previous version and change project file association to ISE Design Suite System Edition 14.7

Fig. no. 2.5: Select Destination path

6. Click Install on the Installation Summary window to start the installation.

Installation

Options Summary

VISE

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options

Select Destination Directory
-> Installation

Copyright () 1995-2013 Xiinx, Inc. AN rights
reserved.

XILINX, the Xilinx logo and other designated
brands inchuded herein are ademarks of Xilinx,
Inc, All other wrademarks are the propenty of

Install Location(s):

E:14.N\ISE_DS

Edition : ISE Design Suite System Edition
Program Group: Xilinx Design Tools
Option: Acquire or Manage a License Key

ISE DS Common

Install Location: E:14.7\ISE_DS\common

Module: ISE DS Common

Option: Script to install VC++ runtime libranes for 32bt OS
Option: Script to install VC++ runtime libraries for 64-bt 0S

EDK

Install Location: E:14.7\ISE_DS\EDK
Module: EDK

Option: MB Linux Toolchain post-install

PlanAhead Analysis Tool

Install Location: E:14. 7\ISE_DS\PlanAhead
Module: PlanAhead Common Files

Option: setupEnv bat

ISE

Install Location: E:14.7\ISE_DS\ISE

Module: Environment Tools

Module: WebPACK Devices

Module: Edition Devices

Option: Install WinPCap for Ethemet Hardware Co-simulation
Option: Install Windows System Generator Info XML

Option: install MSVC 2005 Redistributable Files

Option: Install Cable Drivers

therr respective owness.

Ointinn: Canfim s Wah Talle

Fig. no. 2.6: Installation Summary options.
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7. Installation of the software continues.

ISE 14.7 Installer

Welcome

Accept License Agreements

Select Products to Install

Select Installation Options

Select Destination Directory
-> Installation

Copyright (<) 19952013 Xiinx, Inc. Al rights
reserved,

XILINX, the Xilinx logo and other designated
brands included herein are trademarks of Xilinx,
Inc, All other trademarks are the property of
ther respective owners.,

ISE
Extracting: ise_0002.zip.xz, dsp_tools_0001.zip.xz, ise_0008.zip.xz, ise_...

Zynq" - 7000 All Programmable SoC, Enabling New
Product Innovations Across Markets

> Xilinx All Programmable SoCs are processor-centric platforms that
offer software, hardware and I/O programmability in a single chip.
The multicore processor and industry-leading programmable logic
enable better processing systems with fewer devices, faster

www.xilinx.com/Zynq

In:

40%

XILINX

PROGRAMMABLE.

stall | Cancel I

Fig. no. 2.7: Installation Window

8. Click Finish on the Install Complete window.

® Install Completed

ISE 14.7 Installer

Welcome

Accept License Agresments

Select Products to Install

Select Installation Options

Select Destination Directory
-= Installation

Copyright () 1995-2013 Xilin, Inc, All rights
reserved,

XILINX, the Xl logo and other desgrated
brands included harein are wademarks of Xilin,
Inc. All other wademarks are the property of
thiir FESPRCTIVE OWNETS,

Fig. no. 2.8: Install complete window

The environment variables are written to the settings[32|64].bat file at "E:14.7USE_DS". In order to setthe
variables in your environment, you must run the settings[32|64].bat file.

’ I S E Congratulations! You have successfully installed Xilinx ISE Design Suite System Edition.

Maharashtra State Board Of Technical Education
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9. Click Next on the License Configuration window.

Acquire a icense | Manage Licenses | Borrow/Restore Licenses | Retum Licenses | IntermetSettings |

~Select one of the fol

" Start Now! - 30 Day Trial {No Bitstream)
" GetFree Vivado/ISE WebPack License
" Start 30 Day Evaluation

" GetMy Purchased License(s)

" Locate Existing License(s)

~Destription of the above selected opti

Getall purchased licenses and start using your Xilin software, You will be taken to the Xiinx website where you can generate a license for all Xiinx software and IP you have purchased, Once your license fil is generated, the Manage Xiinx Licenses” tab wil open to
enable you to configure your system to Use the lcense.

About.., Close

Fig. no. 2.9: License Configuration Window

10. After the license is accepted the Xilinx Project navigator icon is created on Desktop. Click
on the icon to run the Xilinx EDA Tool.

o~

Project Navigator

Ralnane Verson:. 147
ApphCatan Vermon: F2011141)

Capwgt © 142810 Wivw, I
Aoy -t

& XILINX

Fig. no. 2.10: Xilinx Initialize Window

Xl Resources
Table 2.2 Resources

Sr.

No Name of Resource Specifications Quantity
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X1l Actual Procedure

X1l  Observation Table : ------- NA-------
XIV  Result: ------- NA-------
XV  Interpretation of results: ------- NA-------

XVI Conclusion and recommendation

XVII Practical related questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.
1. Is it important to install compatible libraries with EDA tools Explain shortly.
2. List the main stages of VLSI design supported by EDA tools.
3. List common installation errors occur, with its solution.

[Space for Answers] (If required attach separate page)

Maharashtra State Board Of Technical Education
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XVIII References/Suggestions for further reading
Table 2.3 References

Sr. No Link / Portal Description
1 https://en.wikipedia.org/wiki/Xilinx_ISE Xilinx ISE information
) http://allpcworld.com/xilinx-ise-design-suite-14- | Xilinx ISE Design Suite 14.7 Free
7-free-download/ Download

https://docs.amd.com/r/en-US/ug908-vivado-
programming-debugqging/Launching-the-Vivado-
3 Lab-Edition-from-the-Command-Line-on-

Launching the Vivado Lab Edition
from the Command Line on Windows

Windows-or-Linux or Linux
XIX Assessment Scheme
Performance Indicators Weightage
Process Related : 15 Marks 60 %
1 | Handling of the components 10%
2 | ldentifying the features of IDE 20%
3 | Follow ethical practices. 20%
4 | working in teams 10%
Product Related: 10 Marks 40%
5 | Correct procedure followed 10%
6 | Conclusion 10%
7 | Installation related questions 15%
8 | Submitting the journal in time 5%
Total (25 Marks) 100 %
Marks Obtained Dated signature of Teacher
Process Product Tota
Related Related |
(15) (10) (25)
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Practical No.3: *Develop VHDL code for basic and universal gate for data flow

Vi

model

Practical Significance

Teaches the fundamentals of digital logic implementation in VHDL using dataflow modeling
(concurrent signal assignments).Reinforces mapping between Boolean algebra and hardware
(how gates become synthesized logic). Builds skills required for FPGA/CPLD design flow:
write — simulate — synthesize — program — test.Forms the basis for designing more
complex combinational and sequential circuits.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome
through various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcomes

e LLO 3.1 Test the functionality of basic logic gates using VHDL Data flow model.
e LLO 3.2 Test the functionality of universal logic gates using VHDL Data flow model..

Relevant Affective Domain related outcomes

Follow good coding and documentation practices for reproducible lab results.
Explore variations with different inputs and gate chaining.

Debug simulation/synthesis issues methodically.

Work in pairs to cross-check test vectors and board results.

Relevant Theoretical Background

VHDL modeling styles: structural (instantiating components), behavioral (processes /
variables), and dataflow (concurrent signal assignments using Boolean operators).
Dataflow model: uses concurrent assignments like Yy <= A and B; to express combinational
logic directly, each assignment represents a continuous mapping from signals to outputs.

Synthesis mapping: synthesizer turns Boolean expressions into LUTs/gates on an FPGA or
into logic on CPLD; NOT, AND, OR, NAND, NOR, XOR are basic primitives.

Timing and hazards: purely combinational dataflow has no clock; consider propagation
delay and possible static/dynamic hazards when combining gates.
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VIl Circuit Diagram
a) Suggested Circuit diagram:
10-pin Female Connector
(Connects to target printed ( B\
arcuit board 10-pin male header.) )

LED Color Description

Off Not connected or suspended =
Blue Connected at 12MHz (USB full speed)

Teal Connected at 480MHz (USB high speed)

Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

1)

Fig. no. 3.1 Practical Setup with JTAG CABLE

b) Actual block diagram used in laboratory with related equipment rating.
CPLD Development board:

Maharastra State Board Of Technical Education
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VIl Required Resources/apparatus/equipment with specifications
Table 3.1 Required Resources
Instrument/ I i
NoO Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
1 FPGA Development hardware circuit., On board, 2 Crystal 8MHz and 1 No
| kit 25MHz. JTAG Interface (Boundary Scan),PROM ‘
Interface (XCF02S),40 pin, 4 header connector for
external 1/0O's Or any other kit with equivalent
specifications
2.| Desktop PC Loaded with open source IDE, simulation and 1 No.

program downloading software, UPS and Antivirus.

IX

X

Precautions to be followed

1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.

Procedure

1. Create the Xilinx ISE project for your top-level FPGA design, by doing the following in

ISE:

2. Inthe ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

3. Select HDL or Schematic as the Top-level source type, and click Next

I PSRN S TERBEEETI 5] - Doriorsie - Design Summany] @E =
b4 2 x
) X[ o] » N P B R T e A,
Design ©08 x| | & Desi )
{8} Implementation ©) [ Simulati -
View: Implementation  Simulation
L] 3 No Err
Behavioral @ & New Project Wizard (RIS Errors: (0 Errors
& o - fon State: New
(7% | Hierarchy {
e — ; Errors:
—| & or (%) Create New Project -
o | @ €1 xa3s400-4pqg208 Warnings:
— Specify project location and type. Routing Results:
e EE| Enter a name, locations, and comment for the project Timing Constraints:
a 84 T and] Final Timing Score:
= Location: D:land &
Working Directory: |D:\and D I o
lfrrors Warnings Infos
Description:
P | T NoPro E
B ailgl| -
£ | No single design module is selected. g
9|2 %  Design Utilities E
— ) Update All Schematic Files Design Prd)|
{| @8  Compile HDL Simulation Libr... En)
= %] Regenerate All Cores Optional | 3
% CheckAll Core Versions Sh
s
S
Sh Select the type of top-evel source for the project
Top-level source type: =1
| — HDL [~] ommantn | b=
& Start | 3 Desgn |I[) Fies |[Q) Libraries| | &
Console ) 3 ©08 X
1) INFO:HDLCompiler: 1061 - Parsing VHDL file | | Morelnfo Next | [ concel |
) INFO:ProjectMomt - Parsing design hierarchyl

Launching Design Summary/Report Viewer...

/ i
|[El consoe [@ Erors [ A\ Warnings |18 FindinFies Results

Fig. no. 3.2: Create new project
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- 5E Projct Navig Sumevary) I e v i
L File Edit View Project e Tools  Window Help [=l=]x]
DREF LB X|wa| frz2 R ;
[Design »naxja £ Desig | &
[ |View: © 18} Implementation © [ Simulation 6 . INo Errors
iy ochoviord = P i _ Jmentation State: New
(g | Hierarchy ©9 E
—| @ or %) Project Settings
) Warni
oo | @ £ xa3st00-4pqg208 oS
= @ Specify device and project propertis. Routing Results:
& = Select the device and design flow for the project
ki) Timing Constraints:
E Property Name Value Final Timing Score:
@ == Evaluation Development Board None Specified
- Product Category Al =
m
Family ‘Automotive Spartan3 [ o
Device XA35400 Warnings Infos
| T NoProcesses Running Package PQG208
74| Nosingle design module is selected. Speed 4
9| =%  Design Utilties
—| &) Update All Schematic Files i Top-Level Source Type HDL
A T2 Compile HDL Simulatin Libr.. Synthesis Tool XST (VHDL/Verilog)
= Regenerate All Cores : - -
m Check All Core Versions Sipuiator S (VHDLNEslo)
Preferred Lanquage Verilog
Property Specification in Project File | Store all values W
Manual Compile Order (]
VHDL Source Analysis Standard |VHDL-93 I [5)
I P 1
‘ & Start ‘ B§ Design [@ Files ||D Libraries| | 3 Enahle Messane Filterinn. 7
Console o088 X
) INFO:HDLCompiler:1061 - Parsing VHDL file -
) INFO: ProjectMgmt - Parsing design hierarch; o
Launching Design Summary/Report Viewer... 3
< T p— »
Console | @ Erors | 1\ Warrings | 2§ Findin Fies Resuls |

Fig. no. 3.3: Project File Settings

fi 15 ProjectHovigalGT[BROISIONS) - Dioriesise - Design summeny] WU .. .. W

T File Edit View Project Source Process Tools Window Layout Help BED

DAEP L[ XDE X0 -

#

| Design unax\g £} Desigy |:
|’_‘ll View: ©) Implemamanon @ ﬁswmu\ahcn — L - Errors: No Errars
Behavioral 10 @ New Project Wizard

£ . — m fion State: Hew

o ° _—

—| & or ) Project Summary

o .

ot | @ £ x3sd00-4pgg208 o

E E Project Mavigator wil create a new project with the following specifications. Routing Results:

— HiEl Project: | |s Timing Constraints:

@ = Project Name: and —

;j M Project Path: D:iland S

= - Working Directory: D:\and

m Description: = E
Top Level Source Type: HDL =

rs Warnings Infos

» | B2 Mo Processes Running Device:

= Device Family: Automotive Spartan3

f; | Na single design module is selected. Pevice: xa33400 |

5|2 % Design Utiities Package: pag208 1

= ~~82  Update Al Schematic Files Speed: _a

A 72 Compile HOL Simulation Libr..

m P g Regenerate All Cores Top-Level Source Type: HDL

Check All Core Versions Synthesis Tool: XST (VHDL/Verilog)

Simulator: ISim (VHDL/Verilog) -
Preferred Language: Verilog
Property Specification in Project File: Store all values
Manual Compile Order: false 1
VHDL Source Analysis Standard: VHDL-93 o 152

| strt ] B8 vesgn [ Fies [ ) Lbreres] | £

Console <08 X

1) INFO:EDLCompiler:1061 - Parsing WHDL file
) INFO:ProjectMgmt - Parsing design hierarch:
Launching Design Summary/Report Viewer...

4 I 13
Corsole | @ rors | 1\ Warings | a6 Findin Fes Rests |

Fig. no. 3.4: Project Summary

4. Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.
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St Narget

File Edit View Project

Source Process Tools

Window Layout Help

DPEGL%bbXxwal frran 2RI

Design o068 X

View: © &} mplementation ) 58 Simulation

Hierarchy
] and
- £3 xa35400-4pqg208

Empty View

The view currently contains no files.
You can add files to the project
using the toolbar at left, commands
from the Project menu, and by
using the Design, Files, and
Libraries panels.

g0 B || e | =

Use;

-

Select Source Type

Select source type, file name and its location.
tJ IP (CORE Generator & Architecture Wizard)

=] User Document
[] Verilog Module

€ No Processes Running

i) Verilog Test Fixture
g VHDL Module
VHDL Library

No single design module is selected.
@ 9  Design Utilities

2R [HR|v

[¢] VHDL Package
| VHDL Test Bench
g% Embedded Processor

| start | @8 Desn |1 Fies | [ brares

Console

4
Consde | @ Ermors | A\ Warnings | 8 Fid nFies Resuls |

5. efine

ISE Project Navigat

=)

Module”. Enter the entity used in design and then click “Next”.

File Edit View Project Source Process Tools

Fig. no. 3.5: Selecting Source Type

Window Layout Help

DPEYL[%obXx[wal il 288 AR

n «08 X

View: © 1§} Implementation ) [ Simulation

Hierarchy

F E and

£ £3 xa3s400-4pqg208
Empty View

You can add files to the project
using the toolbar at left, commands
from the Project menu, and by
using the Design, Files, and
Libraries panels.

a0 @ || 5 R F

Use;

The view currently contains no files.

-

Define Module

Specify ports for module.
Entity name |and

Architecture name ‘Bdﬁvioral

¥ Port Name

Direction

) No Processes Running

No single design module is selected.

¥

Design Utilities

08|98 v

'
0oODEDDEooDEEoE

| strt| =8 pesign [} Fies [ [R) Lirries

Console

1

<
Consdle | @ Erors | 1) Wamings | g6 Fnd nFies Resuls |

Fig. no. 3.6: Define Entity
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IE roject Navg - - cete M )

File Edit View Project Source Process Tools Window Layout Help

DPEF L ¥ BB X0 o]
|Design ~0dx
EI View: @ {f} Implementation (7 ﬁ Simulation
z| | Hierarchy -
= and L
—| = £ xa3=d00-4pgg208 3
g
j£3] Empty View
£ Summary
= The view currenty contains no files.
:Z’:‘gm‘;“:ﬁ:;;: :::t,wc:];;tan ds Project Navigator wil create a new skeleton source with the following
P from the Project menu, and by Add to Project: Yes
== using the Design, Files, and Source Directory: D:\and
| Libraries panels. Source Type: VHOL Module
Source Name: and.vhd
Uset i
Entity name: and
) NoProcesses Running Architecture name: Behavioral

Port Definitions:
No single design module is selected. a

W Design Utilfies b
¥

SR

| Stort | B} Design | L] Fies | [ Liraries

Console

[l ——
Console ‘o Errors Lh Warnings |ﬁ Fﬂ!hﬁesﬁgslls‘

Fig. no.3.7 Entity Summary
6. Develop VHDL code for given problem and synthesize the .vhd file and view RTL schematic.

ISE Project 1013 d\an 3 . e N L |
[) File Edit View Project Source Process Tools Window Layout Help [=]=]x]
DBEMIL[X00x[wa|fALRR, R =02 LR P L]
[Deson 08X & 18 - R
[i] |View: © {5} implementation ©) & Smuation 19
Hi —| 20 library IEEE;
| Hierarchy | 21 use IEEE.STD 10GIC 1164.ALL;
| - and w | 22
—|a-a “35.‘00'4”9203 . = 23 -- Uncomment the following library declaration if using
unn n and - Behavioral (and.vhd) 24 -- arithmetic functions with Signed or Unsigned values
E 9. | 25 --use IEEE.NUMERIC STD.ALL;
ol ] 26
A 27 -- Uncomment the following library declaration if instantiating
% 28 ~-- any Xilinx primitives in this code. L.
E 29 --library UNISIM;
- 2| 30 --use UNISIM.VComponents.all:
%| 31
= 32 entity andl is
@ 33 Port ( a : in STD_LOGIC;
| Q2 NoProcesses Ruming o s b : in STD_LOGIC:
?t Processes: and - Behavioral — :: - y : out STD_LOGIC):
end andl; E
X -E Design Summary/Reports 27 £
| ® DesngnUtllm_es 38 architecture Behavioral of andl is
Xl User Constraints 20
= | @ 8)  Synthesize - XST
m ¥ 40 begin
| @ 8)  Implement Design a ¥
€)  Generate Programming File 42 ycm a and by
[} @ Configure Target Device 43 end Behavioral:
€4 Analyze Design Using ChipScope 44
45 -
« (0] )
[’ SM]"QD::@J@ ﬂu[mjwm@ and.vhd*™ ﬂ[z Design Summary =]
Console 08X
-
Started : "Launching ISE Text Editor to edit and.vhd".
Launching Design Summary/Report Viewer... 3
« »
5] console |@ Emors | 2\ Wamings [ 2§ Findin Fies Resuts |

Fig. no. 3.8: VHDL Coding
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R
L ISE Project Navigator|
@ File Edit View Project Source Process Tools Window Layout Help

DAEGL %00 X|nd| 28R 2R RE0sRiPELLR

[Design 08X J AR -~ a
View: © {8} Implementation ©) Ff Smulation & 19
& [ Hi b — 20 library IEEE;
& | Hierarchy 21 use IEEE.STD LOGIC 1164.ALL;
| & and o [ 22
—|=-a xa35:00»4pqg203 . 23 U . library declaration if using
oh [ and1 - Behavioral (and.vhd) 24 Signed or Unsigned values
= “ 25
& —| 26
A 2% ng library declaration if instantiating
[}] % 28 Az ves in this code. o
o & 29 --library UNIS
- b 30 --use UNISIM.VComponents.all;
7t % 31
= 32 entity andl is
Y O 33 Port ( a : in STD_LOGIC;
» | B NoProcesses Running | = b : in STD LOG
7{. | Processes: andl - Behavioral —| 35 ¥ &'aut (STD LOGIC)?

& 36 end andl; E
= % Design Summary/Reports pos £
X Z slbdpdlih

e Design Utithes 38 architecture Behavioral of andl is
E’-/t % User Constraints 39
e} & Synthesize - XST 0 begin
- ¥2  Implement Design a
¥  Generate Programming File 42 y¢= a and b;
@ Configure Target Device 43 Vend Behavxo;al'
€+ Analyze Design Using ChipScope P *
45 -
< I | »
[ start| @8 esign [[1 Fies [ thraries| | B and.vhd BlE Design Summary (Synthesized) [X]

Console

Process "Synthesize - XST" completed successfully

< [

Consdle | @ Erors | 1\ Wamings | @ FrdiFies Resuls |

Fig. no. 3.9: Synthesize the .vhd file

7. Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as simple
as a file with clock and input data or a more complicated file that includes error checking, file

input and output, and conditional testing.

8. Go to implementation to simulation tab, right click on main source file and create Test Bench

file for simulation.

[ File Edit View Project Source Process Tools Window Layout Help

- &) %
D2 H@| XDEX|wa| » 2R AR BEDLRIPELQ
|Design 08X | 18— =
[ | View: © £} implementation © [l Smuation 19
Behavioral = = 20 library IEEE;
@ 21 use IEEE.STD_LOGIC_1164.ALL;
(g | Hierarchy & 22
= | € and 23
do | & €1 x3s00-4pqg208 24
= [ and1 - Behavioral (and.vhd) Q. 25
&l —| 26
A 27 ary declaration if instantiating
N % | 28 i s code.
Ll 29
= 2| 30
= | =
—| 32 entity andl is
Q| ss Port ( a : in STD_LOG
P> 82 Nofracesses Rumning. O =4 b : in STD_)
7£ | No single design module is selected. —| 35 ¥ froue (ST
- e 36 end andl:; 4
Pt | @ 3P Design Utilities a7 £
e 38 architecture Behavioral of andl is
A 39
o 40 begin
. 41
42 y<= a and b;
43 end Behavioral:
44 4
45 -
Gl il B
[ stert| @ vesgn [ Fies [ toreries| | D) and.vhd 8= Design Summary (Synthesized) [x]
[Console =R
Process "Synthesize - XSI" completed successfully .
1) INFO:HDLCompiler:1061 - Parsing VHDL file "D:/and/and.vhd" into library work
1) INFO:ProjectMgmt - Parsing design hierarchy completed successfully. |
4 i »

1] consoe |© av;s [\ Warnings a6 Findin Fies Results |

Fig. no. 3.10 Select Simulation tab to create test bench file
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DREYL[soEXva| A28 2R RE0c]sR)Peliv
[Desn 08X & 15 -- %
] |View: ® @Weﬂnmtaﬁm O] E&Mahm = 19
Behavioral 2] — 20 library IEEE;
(@ 21 wuse IEEE.STD LOGIC_1164.ALL;
@ Hierarchy & 22
—| 8 and 235 = the following library declaration if using
ﬂnu = xa3s400-4pqg208 - 24 -- arithmetic functions with Signed or Unsigned values
é » L --use IEEE.NUMERIC STD.ALL;
&) Add Source 97 =T the following library declaration if instantiating
X 28 -- any Xilinx primitives in this code. L
o) o] Add Copy of Source... 29 --library UNISIM;
30 --use UNISIM.VComponents.all;
o Open 3
& Remove 32 entity andl is
5 7 33 Port ( a : in STD_LOGIC;
: ) NoProcesses:  Manual Compile Order 34 b : in STD_LOGIC;
7t | rocesses: andl | &% Setas Top Module 35 y : out SID _LOGIC);
- SmantGuide.: 36 end andl; L
g ¥ ims o
% File/Path Display » | 38 architecture Behavioral of andl is
A 39
m Expand All 40 Dbegin
Collapse All 41
42 y<= a and b;
(4 Find... Ctl+F | 43 end Behavioral;
44 L
4 Design Properties... -
& Design Properti 45
4] Source Properti W | 12
| start | =g Design™ LT oranes] 1= and.vhd BlE Design Summary ]|
Console +08 X
Process "Synthesize - XST" completed successfully -
J) INFO:HDLCompiler:1061 - Parsing VHDL file "D:/and/and.vhd" into library work
J) INFO:ProjectMgmt - Parsing design hierarchy completed successfully. =

<
Console | @ Errors | 1) Warmings | g4 FindinFes Resuls |

@ File Edit View Project Source Process Tools Window Layout Help

DAEPIL[X0DX|0a| /228828

[Desion 18 - B
[ij |Vew: © {8} inplementation © 19 =
K| Behavioral o = 20 i . i

21 uslh
Al Hierarchy & 22
d
= & and 233 N%SD'“MW El
% | & €3 xe35400-4pqg208 = [ zas—3 g
El E andL - Behavioral (and.vhd) “_ ;: - Select Source Type
Al 21 - Select source type, file name and s location.
B A 2 | (R eMMFie e
— % = €* ChipScope Definition and Connection File
m ey [ Implementation Constraints File

1 3 \{ IP (CORE Generator & Architecture Wizard)
0 g; el | /&) MEMFile
| £) NoProcesses Rumning 19] Schematic ;
— O % |z] User Document Fienane:
[?t Processes: and] - Behavioral i :: o Verilog Module 1and_!b
% Isim Simulator (V] Verilog Test Firture . 3

3 37 Fia VHDL Module ki
% gg a VHDL Library in:\and | E]
= X [¢] VHDL Package
m = {R) VHDL Test Bench

:; g Embedded Processor

43

44 L

45 -

- Add to project N

[ stt] 9 oeson [ s [0 tornes] 2

Console

Process "Synthesize - XST" completed successfu
) INFO:HDLCompiler:1061 - Parsing VHDL file "D:/and/and.vhd" into library work
J) INFO: ProjectMgmt - Parsing design hierarchy completed successfully.

Conse | @) Erors | 1) Wamings | FrdinFiesReuts |

Fig. no. 3.11(b): Creating test bench contd..
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- ISE Project Navig A
[B) File Edit View Project Source Process Tools Window Layout Help [=]&]x]
DAEdL[sobBX|wal -
|Design ©08Xx| %
[{f [ View: © {8} implementaton © B Smuiaton =
ehaviord  [¢] —| 20 21i88
% Hierarchy & 22 @ .
IS | e S ——
0 | & (1 xa3400-4pqg208 24 - - —
g andl - Behavioral (and.vhd) o, 25 —3 Associate Source
== —| 26
4 250 Select a source with which to assodiate the new source.
B A0 g L
et 29
- 2| 30 -3
% a2 II
No Processes Running
Q [5)

Processes: andl - Behavioral
% 1Sim Simulator

[

a2 E| v

[ strt| 58 pesn [() Fles | 0 Lbraries| | B

Console 08 X
Process "Synthesize - XST" completed successfully -

) INFO:HDLCompiler:1061 - Parsing VHDL file "D:/and/and.vhd" into library work

) INFO:ProjectMgmt - Parsing design hierarchy completed successfully. =

< m >

Console |@ Erors | 1\ Wamings | Fnd nFles Resuls |

Fig. no. 3.11§c=: Creating test bench contd..
I 5¢ProgectNevig - Dandlandse - ond - ~udie- W W W a8 3]

@ File Edit View Project Source Process Tools Layout Help E@
NEFEETEEETEIE EEEEI T IT

‘De n HDEIX| = 18 - A
[if |Vew: © {6} tmplementation @ E Si H R -
4 Behaviaral o —| 20 S e
21 ugll ”
| Hierarchy " 22 G
= 1 New Source Wi
| e 20 | S TR —— - —
| B 3 xa3sd00-4pqg208 24 - — -
E m andl - Behavioral (and.vhd) b 7 = Summary
= —| 26
A a7 - Project Navigator wil create a new skeleton source with the following
B A z: "I | Add to project: Yes =
= % Source Directory: D:\and
m 30 || | Source Type: VHDL Test Bench
| Source Name: and_th.vhd
—| 32 ed
@ 33 Assodiation: and1
€2 No Processes Running @ 24
Processes: and] - Behavioral B

B-% ISim Simulstor

mn

ERFEE AR

L sat| = peson |1 Hes|®1.txaﬁes@

Cansole «08x
Process "Synthesize - XST" completed successfu e
Iy INFO:HDLCompiler: 1061 - Parsing VHDL file "D:/and/and.vhd" into library work
4} INFQ:ProjectMamt - Parsing design hierarchy completed succesafully. =
-
T v

consoe | @ — | 2 warnings [ g6 FndinFies resuls |

Fig. no. 3.12 Created Test Bench
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,ﬁ”p,w avigator 1013 d | d =l X I
@ File Edit View Project Source Process Tools Window Layout Help [L“Li'\ l‘
DAEFIL 4 00X|wa| - 228R 2 RIA 2B 4R PP
[Design ~08x < 52 signal a : std logic := '0'; -
[ o e 53 signal b : std logic := '0';
— 54
& - ~ 55 --Outputs
[fz] | Hierarchy “ 56 signal y : std logic;
T B and = 57 -- No clocks detected in port list. Replace <clock> below with
ao | & €3 xa3s400-4pqg208 58 -- appropriate port name
& & m and_tb - behavior (and_tb.vhd) 2 59
o) T 60 --constant <clock> period : time := 10 ns;
Al e
2 % :j BEGIN
- A 6 -- Instantiate the Unit Under Test (UUT)
= %| 85 uut: andl PORT MAP ( I
= 66 a=>a,
“ @ 87 b =>Db,
: €2 NoProcesses Running ® P vy 1
4 | No single design module is selected. Tl 32 )i 1
S| @ P Design Utiities 71 -- Clock process definitions
% 72 --<clock>_process :process —
S 73 --begin
m 74 -=<clock> <= '0';
75 --wait for <clock> period/2:
76 -=<clock> <= '1';
77 --wait for <clock> period/2:
78 --end process;
79 -
« i ] »
[ Strt| O3 Desgn [ L] Fes | () Liranes | [2) andihd L[ 2 Deson summary OB and_th.hd* -]
QERROR:ProjectMgmt - 4 error(s) found while parsing design hierarchy. -
Started : "Launching ISE Text Editor to edit and_tb.vhd". =
[ — 4‘ »

<
[i] Consoe | @ Erors | 1) Wamings |86 FndinFlesReauts |

parameters [as

g. no. 3.13: Disable clock

L ISE Project Navigator, 31013) - D:\and\and.xise - [and

[2) File Edit View Project Source Process Tools Window Layout Help

‘DAL s0bX[wa| 2288 2RI

Baciswirce)9

[Desin #08X E[ 78 --end process; -
[if | Vew: © {6} implementation © fff smuaton §=| 79
& Behavioral = li=s g0
7 = 81 -- Stimulus process
& Hierarchy o 82 stim proc: process
—| & and = 83 begin
do | & £2 xa3s400-4pqg208 84 -- hold reset state for 100 ns.
,_] @ [ and_tb - behavior (and_tbvhd) | 2 85 a<="0";
- —| 86 be=10';
Al e wait for 100 ns;
x 88 a<='0";
el > 89 bemrar;
- » 90 wait for 100 ns;
= » 91 ac='1"';
== 92 b<='0"';
@ 93 wait for 100 ns;
P | €2 NoProcesses Running O = ac=111;
71| No single design module is selected. —| be=tqr;
" 96 wait for 100 ns;
D¢ |® P Design Utiities a7
% 98 F
S EL) -- insert stimulus here
m 100
101 wait; E
102 end process;
103
104 END; 4
108 -
C Pe—— )
=
l’ SM‘WGWW} Hesl[blhaﬂs\@ and.vhd OIE Design Summary (Synthesized) O!@ and_th.vhd* gj
QERROR:ProjectMgmt - 4 error(s) found while parsing design hierarchy. -
Started : "Launching ISE Text Editor to edit and_tb.vhd". |
<[ (T— )

[i] Consoe | @ Erors | &) Wamings | g4 FdinFies Resuts |

Fig. no. 3.14: Initialize Input values

9. In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure that
you didn’t make any syntax errors while making changes.
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[ File Edit View Project Sou [=[=x]
DRE@ L %obx|va| L3R 2R mEO[LR[(PELQ
[Design 78 ——end process; =
| view, 78
St ] 80
\SEJ Be.haworal 81 —- Stimulus process
(5] | Hierarchy - 82 stim proc: process
] and 83 begin
= £3 xa3s400-4pqg208 g4 hold reset state for 10

& %) and_tb - behavior (and_tb.vhd)

| €2 NoProcesses Running

OO ¥ ¥ ¥ > [1®

Processes: and_tb - behavior

96
94| = & ISim Simulator
1 Behavioral Check Syntax

wait for 100 ns;

% 8  Simulate Behavioral Model 55 —- insert stimulus here

101 wait;
102 end process;

n

104 END;

fi——

& Strt| B8 Design | Fies | ) Libraries] | 2 and.vhd L[ & vesion sunmary (synthes: <JE] and_th.vhd o]

Console ~08x
Parsing VHDL file "D:/and/and_tb.vhd" into library isim_temp

Process "Behavioral Check Syntax" completed successfully

<l

T

< *‘
Console |@ Erors | 1\ Warnings | 124 Findin Fies Results |

1nQS Cal12 VHDI

Fig. no. 3.15: Behavioural Check Syntax

10. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the ISim
software with your test bench loaded. (refer Fig. no. 4.16)

[ File Edit View Project Source Process Tools Window Layout Help

DPEFLsobx|val 2R 2R mencse)recelQ

[Desgn 78 —-end process; =
[ |View: © {8} Implementation © 79
] [pehavioral ap
¢ - 81 -- Stimulus process
(g | Hierarchy “ 82 stim proc: process
2| 8 and 83 begin
w4 | B 1 xa3s400-4pgg208 84 -- nold reset state for 100 ns.
é @ [4) and_tb - behavior (and_tb.vhd) 9 85 a<='0";
Cal —| =e6 b<='0";
A 87 wai\,:ofor 100 ns;
o 88 a<="0";
a 2 es be='1";
— » 20 wait for 100 ns;
S » 91 a<="1";
—| 92 b<='0";
| Q| o wait for 100 ns;
P | 82 NoProcesses Running o os ac=r11;
P! | Processes: and_tb - behavior = if-i b<=;1;; 100
wai or ns;
9|2 % I5im Simulator =
o 2@ Behavioral Check Syntax o _
% SimilaleBeliotatMadel 99 -- insert stimulus here
m 100
101 wait; =
102 end process;
103
104 END; R
105 -
« il ] B
[= start | = pesign [ Fies [ tiraries| [ and.vhd L2 oesonsummary (yntheszed) )| B and_tb.vhd al
— I 2 e L T T s e e T e e e = i
Parsing VEDL file "D:/and/and tb.vhd" into library isim temp -
Process "Behavioral Check Syntax" completed successfully =
2l i ] ,

Console | @ Errors | 1\ Warings | 128 Find n Fies Resuts |

Fig. no. 3.16: Simulation Check window

11. ISim simulator window will open with your simulation executed, as shown in Fig.. where one
can simulate designs and check errors if any. (Fig. no. 4.17)
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ks 5 p 0013 - P . R

o o e S

[E] File Edit View Simulation Window Layout Help

02 d| % B ®|o o |5 [a =
Instances and Processes 0 & x||Objects o088 x| #
Simulation Objects for and_tb

~ I
IR « A |
a 0

Instance and Process Name D

§ and o | Object Name Value
std_logic_1164 st $a 1
$b 1
o 1

X1: 72.347 ns

Defautwefg

3

i
S Instanc... | [y Memory | /=) Source

Console

Xiinx License Configuration Manager to check out a full ISim license.
Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version.

Simulator is doing circuit initiaization process.
Finished circuit nitialization process.
1Sim>

II |[£9Redaunch

«+08x

@ console |[-] CompilationLog ‘ @ Ereakpoints ‘ 2 FindinFiles Results | gy Search Results

Fig. no. 3.17: Simulation Output

Sim Time: 1,000,000 ps

Sample VHDL code for basic and universal gate for data flow model:

1) AND gate
library ieee;
use ieee.std logic_1164.all;

entity and_gate is
port (
A :in std_logic;
B :in std_logic;
Y :outstd_logic );
end and_gate;

architecture dataflow of and_gate is
begin

-- concurrent dataflow assignment
Y <= A and B;
end dataflow;

2) NAND gate (universal)
library ieee;
use ieee.std_logic_1164.all;

entity nand_gate is
port (
A :in std_logic;
B :in std _logic;
Y :outstd_logic );
end nand_gate;
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architecture dataflow of nand_gate is
begin

Y <=not (A and B);
end dataflow;

3) Program Statement for Student: Implement NOT, OR, NOR, XOR

Xl Resources
Table 3.2 Resources
Sr. Name of Resource Specifications Quantity
No.
1 --
2
3
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X1l Actual Procedure

X1l  Observation Table (use blank sheet provided if space not sufficient)

Observations for NOT, AND, OR, NAND, NOR, XOR or Problem Statement given to

Student.
Table 3.3 Observation table
Input Output
A B NOT AND OR NAND NOR XOR
0 0
0 1
1 0
1 1
XIV  Result

XV  Interpretation of result
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XVI Conclusion and recommendation

XVII Practical related questions
Note: Below given are few sample questions for reference. Teacher must design

more such questions so as to ensure the achievement of identified CO.

1. Give the syntax of Entity and Architecture with example?
2. Explain the Process statement with an example
3. Explain any hazard observed in gate combinations and propose mitigation (e.g., adding small
inertial delays in simulation for demonstration).
[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading
Table 3.4 Reference

Sr. No Link / Portal

Description

1 https://startingelectronics.org/software/\VVHDL -
CPLD-course/tut2-AND-and-OR-gates/

AND Gates, OR Gates and Signals
in VHDL

2 https://www.tutorialspoint.com/vlsi design/vlsi des
ign vhdl introduction.htm

VLSI Design - VHDL
Introduction, VLSI Design Useful
Resources

3 https://buzztech.in/vhdl-modelling-styles-
behavioral-dataflow-structural/

VHDL Modelling Styles:
Behavioral, Dataflow, Structural

4 https://de-iitr.vlabs.ac.in/exp/realization-of-logic-
functions/theory.html

Realization of logic functions with
the help of universal gates NAND
and NOR Gate

XIX Assessment Scheme

Performance Weightage
Indicators

Process Related : 15 60 %

Marks
1 | Coding ability 30%
2 | Debugging ability 10%
3 | Follow ethical practices. 20%
Product Related: 10 40%

Marks
5 | Correct connections to FPGA Board 20%
6 | Answer to sample questions. 15%
7 | Timely Submission of report Answer to sample questions. 05%

Total (25 Marks) 100 %

Marks Dated signature of Teacher
Obtained
Process Product Total
Related(15) Related(10) (25)
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Practical No.4: Develop VHDL code for basic and universal gate for behavioral

VI

Vil

model

Practical Significance

Behavioral modelling is used to describe functional behaviour of circuits without specifying
gate-level implementation, good for early design, verification, and testbench creation. Helps
to quickly describe logic functionality and test it via simulation before committing to
structural/synthesizable implementations. Reinforces concepts of concurrency vs sequential
processes, signal vs variable assignments, and sensitivity lists.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome
through various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcomes
o LLO 4.1 Test the functionality of basic logic gates using VHDL behavioral model.
o LLO 4.2 Test the functionality of universal logic gate using VHDL behavioral model.

Relevant Affective Domain related outcomes
o Follow safe practices.

* Maintain tools and equipment.
o Follow ethical practices.

Relevant Theoretical Background

«VVHDL models: Dataflow (concurrent signal assignment), Behavioral (process-based
descriptions, sequential statements), and Structural (component instantiation and
interconnection).

eBehavioral model: Uses process blocks and sequential statements (if, case, variable
assignments, wait) to describe the behavior. Processes may be sensitive to signals and execute
when those signals change.

«Signals vs Variables: Signals represent wires/registers visible outside the process. Variables
are local to a process and update immediately within the process (but their values only appear
outside when assigned to a signal).

« Synthesis considerations: Not all behavioral constructs are synthesizable. Keep processes
combinational (if with complete sensitivity list or process(all)) and avoid infinite wait loops
or non-synthesizable file 1/0 for synthesizable code.

Circuit diagram
a) Suggested Practical Setup:
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10-pin Female Connector
(Connects to target printed /(’\
arcuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended =
Blue Connected at 12MHz (USB full speed) Kl

Teal Connected at 480MHz (USB high speed) Z

Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

1)

Fig. no. 4.1 Practical Setup with JTAG CABLE

b) Actual Practical Setup used in laboratory with related equipment rating:
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VIl Required Resources/apparatus/equipment with specifications
Table 4.1 Required Resources
Sr. Instrument/ e - .
No Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
1 FPGA Development hardware circuit., On board, 2 Crystal 8MHz and 1 No
kit 25MHz. JTAG Interface (Boundary Scan),PROM '
Interface (XCF02S),40 pin, 4 header connector for
external 1/O's
Personal computer with latest configuration. Loaded
2| Desktop PC with open-source IDE, simulation and program 1 No.
downloading software, UPS and Antivirus.
IX Precautions to be followed
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X Procedure

1.Create the Xilinx ISE project for your top-level FPGA design, by doing the following in
ISE:

2.In the ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

3.Select HDL or Schematic as the Top-level source type, and click Next

4.Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.

5.Define Module”. Enter the entity used in design and then click “Next”.

6. Develop VHDL code for given problemand Synthesize the .vhd file and view RTL schematic.

7.Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

8.Go to implementation to simulation tab, right click on main source file and create Test Bench
file for simulation.

9.In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure
that you didn’t make any syntax errors while making changes.Double click on “Simulate
Behavioral Model” in the “Process Pane”, which will open the ISim software with your test
bench loaded.

10.  ISim simulator window will open with your simulation executed, where one can simulate
designs and check errors if any.
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e Sample VHDL code for basic and universal gate for data flow model:
1) AND gate
library ieee;
use ieee.std_logic_1164.all;

entity and2_beh is
port (
a:instd_logic;

b :instd_logic;

y :outstd_logic);
end entity;

architecture behavioral of and2_beh is
begin

-- combinational process (behavioral)
comb_proc: process(a,b)

begin

if @="1"and b ="1") then
y <: Ill;

else

y <: IOI;

end if;
end process comb_proc;
end architecture behavioral;

2) NAND gate (universal gate)
library ieee;
use ieee.std_logic_1164.all;

entity nand_beh is
port (a,b: instd_logic; y: out std_logic);
end nand_beh;

architecture behavioral of nand_beh is
begin

proc: process(a,b)

begin

if @="1"and b ="1") then
y <='0%

else

y<=1;

end if;

end process;

end behavioral,
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3) NOR gate (universal)
library ieee;
use ieee.std_logic_1164.all;

entity nor_beh is
port (a,b: instd_logic; y: out std_logic);
end nor_beh;

architecture behavioral of nor_beh is
begin

proc: process(a,b)

begin

if (@="0"and b ='0") then
y<='1;

else

y <=0y

end if;

end process;

end behavioral;

4) Program Statement for Student: Implement NOT, OR, XOR using dataflow model
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Xl Resources
Table 4.2 Resources
Ii(r)' Name of Resource Specifications Quantity
1
2
3
X1l Actual Procedure
X1l Observation Table (use blank sheet provided if space not sufficient)
Observations for NOT, AND, OR, NAND, NOR, XOR gates
Table 4.3 References
Input Output
A B NOT AND OR NAND NOR XOR
0 0
0 1
1 0
1 1
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X1V Result

XV  Interpretation of result

XVI Conclusion and recommendation

XVII Practical related questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.
1. State the purpose of a sensitivity list in a process block
2. Modify the AND gate to create a 3-input AND using behavioral modeling.
3. Listerrors might occur during compilation of VHDL code. Give examples.

[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading

Table 4.4 References

Sr. No Link / Portal

Description

https://startingelectronics.org/software/\VVHDL -

AND Gates, OR Gates and

behavioral-dataflow-structural/

1 CPLD-course/tut2-AND-and-OR-gates/ Signals in VHDL
https://www.tutorialspoint.com/visi_design/vlsi_des VLSI Design - VHDL
2 ign_vhdl_introduction.htm Introduction, VLSI Design
Useful Resources
3 https://buzztech.in/vhdl-modelling-styles- VHDL Modelling Styles:

Behavioral, Dataflow,
Structural

https://de-iitr.vlabs.ac.in/exp/realization-of-logic-
4 functions/theory.html

Realization ~ of  logic
functions with the help of
universal gates NAND and
NOR Gate

XIX Assessment Scheme

Performance Indicators Weightage
Process Related : 15 Marks 60 %
1| Coding ability 30%
2| Debugging ability 10%
3| Follow ethical practices. 20%
Product Related: 10 Marks 40%
4| Correct connections to FPGA Board 20%
5| Answer to sample questions. 15%
6 g¢r$s$:gn§9bm|55|on , Answer to sample 05%
Total (25 Marks) 100 %
Marks Obtained Dated signature of Teacher
Process Related | Product Related Total
(15) (10) (25)
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VI

Practical No.5: *Realize the half and full Adder on FPGA board

Practical Significance

Field Programmable Gate Arrays (FPGAS) are semiconductor devices that are based around
a matrix of configurable logic blocks (CLBs) connected via programmable interconnects.
FPGAs can be reprogrammed to desired application or functionality requirements after
manufacturing. This practical will help the students to implement the various combinational
circuits like Half or Full adder/ subs tractor using FPGA.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome through
various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcomes

e LLO 5.1 Test the functionality of half and full adder using VHDL code.
e LLO 5.2 Test the simulated Test bench waveform.

Relevant Affective Domain related outcomes
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.

Relevant Theoretical Background
Half Adder: A Logic circuit used for the addition of two one bit numbers is known as Half
adders. It has two inputs A and B and two outputs Sum (S) and Carry (C).

Table 5.1: Truth Table for Half adder

A B Sum Carry
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1

From the truth table the output equations are: S = AB+ AB
Carry (C)=AB

s ' D—)SumS=AeB=ZB+AB‘
D——CarryC:AoB

Fig. no. 5.1: Half Adder
Full Adder: In Half adder there is no provision to add the carry generated by lower bits while
adding present inputs that is when multibit addition is performed. Hence a third input is added
and this circuit is used to add A, Band Cin where A , B are present state inputs and
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Cin is the last state output that is previous carry. This circuit is known as Full Adder.

Table No 5.2: Truth table for Full Adder
Cin Sum (S) Carry (C)
0 0 0

PRl Rk ololol o>
Rl RrlololrlRrlololm
Rl ol okl ok
Rl o|lo|lr| ol k|
=l E=1E=)

3)_f\ S=(A®B)®C,

ow>

in

AB

AGC,,

C, =AB+AC;, +BCj,

Cin
Fig. no. 5.2: Full Adder

VIl  a) Suggested Practical Sample:

10-pin Female Connector

(Connects to target printed ( B
arcuit board 10-pin male header.) ~ -
P @
LED Color Description
Off Not connected or suspended / | =
Blue Connected at 12MHz (USB full speed) "" Nl
Teal Connected at 480MHz (USB high speed) . 2
Green JTAG port open, idle '

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable "

Fig. no. 5.3 Practical Setup with JTAG CABLE
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b) Actual Practical Setup used in laboratory with related equipment rating:
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VI

Required Resources/apparatus/equipment with specifications

Table no.5.3 Required Resources

No

Instrument/

Components Specification Quantity

FPGA Development hardware circuit.,, On board, 2 Crystal 8MHz and

kit

Device: Xilinx FPGA (XC3S400 PQZ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
25MHz. JTAG Interface (Boundary Scan),PROM 1 No.
Interface (XCF02S),40 pin, 4 header connector for
external 1/O's

.| Desktop PC

Loaded with open source IDE, simulation and

program downloading software, UPS and Antivirus. 1 No.

IX

Precautions to be followed

1.
2.

Check the syntax / rules of VHDL Programming.
Do not power up the board before completing connections.

Procedure

1.

2.

o Ol

Create the Xilinx ISE project for your top-level FPGA design, by doing the following in
ISE:

In the ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

Select HDL or Schematic as the Top-level source type, and click Next

Create New Source file. Select Source Type” select the Source type and give the name to
the source then click “Next”.

. Define Module”. Enter the entity used in design and then click “Next”.
. Develop VHDL code for given problem and synthesize the .vhd file and view RTL

schematic.

. Create Test Bench file- A test bench is HDL code that allows you to provide a documented,

repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

. Go to implementation to simulation tab, right click on main source file and create Test

Bench file for simulation.

. In order to view test files, select the box of “Simulation” in the “View Panel” of the

“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes.Double click on
“Simulate Behavioral Model” in the “Process Pane”, which will open the ISim software
with your test bench loaded.

10. ISim simulator window will open with your simulation executed, where one can

simulate designs and check errors if any.
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a) Create HA .vhd file:

@ File Edit View Project Source Process Tools Window Layout Help

DREdLobxvwal 2R meac]sipc L)@
[Design ©88x] & 19 B
view: © {f Implementation ©) B Simuiaton 3= | 20 library IEEE;
=1 —| 21 wuse IEEE.STD_LOGIC 1164.ALL;
=| | Hierarchy 22 e =
| & HA - 23 -- Uncomment the following library declaration if using
—|& WS:W-“NQZUS_ 24 -- arithmetic functions with Signed or Unsigned values
dh o HA - Behavioral (HA.vhd) 25 --use IEEE.NUMERIC STD.ALL;
a 3 =
= —| 27 -- Uncomment the following library declaration if instantiating
A 28 -- any Xil primitives in this code.
2 op| 29 --library UNISIM; |
30 --use UNISIM.VComponents.all;
= Gl
s % 32 entity HA is
=il =5 Port ( a : in STD LOGIC;
‘ O 34 b : in STD LOGIC;
P [ 8 NoProcessesRuming o] s s : out STD LOGIC:
74 | Processes: HA - Behavioral 36 S Flout SI0-LOCIC).;
5 37 end HA; =
% X Design Summary/Reports 38 iV
= Design UAil .s 39 architecture Behavioral of HA is
% User Constraints 20
: 41 begin
) Implement Design o a0l isc=a xor b
(] Gene.ratergrammlpg File 33 Blcc= a and 'b;
%  Configure Target Device P
@+ Analyze Design Using ChipScope 4 lerid Behavioral: L4
46 hd
< . | »
|# stat| =8 peson [ Fies [ Liraries @ HA.vhd <1E3 Design Summary (Synthesized) x]|

Console

Process "Synthesize - XST" completed successfully

<[ [

Console ]_6 Emors | 1\ Wamings | (g8 Findin Fies Results

Fig. no. 5.4: HA .vhd file

b) Create HA test bench file:

Ind2Cal12 VHNI
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L I5E Project Navigator (P20I31013) - DAHA\HAxise - A tbha’) - - " o e
File Edit View Project Sowrce Process Tools Window Layeut Help
D2Ea : 1o BAR
Design w08 x 2
view: ©) 3} Inplementation @ [ Simulation 2
< [Behaviora 2

1
W

BEos| AR pEe

8 LIBRARY iese;
9 USE iese.std_logic_1164.ALL;

[ | Hierarchy 31
= & Ha 32
B £ xa3s400-4pqg208 33
@ iy HA_th - behavior (HA_tb.vhd) 3¢
35 ENTITY HA tb IS

A 36 END HR tb:

38 ARCHITECTURE behavior OF HA tb IS

Q| « COMPONENT Ha
P | €2 Mo Processes Runring s BORT (

£ | No single design module is selected.
| & Design Utities oG

¢ -

m 49

& Start | &3 pesgn | Fies | [T Libraries HA.vhd b Design Summary (Synthesized) HA_th.vhd* a

Console +08 %

@ ERROR:FrojectMgme - 4 error(s) found while parsing design hierarchy. -
Started : "Launching ISE Text Editor to edit HA tb.vhd".

. 1 b

12 console |@ Erors | 1\ warnings | @4 Findin Fies Resuits

Fig. no. 5.5: HA Test Bench file
c) HA test bench Simulation waveforms:

b 5m (20131013 - et AN 0 N . . 1 Sl

[ File Edt View Simulstion Window Layout Help

DVH LY B ®o oK ) B Mo
Instances and Processes 0 @ X||Objects =L F
Simulation Objects for ha_th 2

-EDENED: g

T @ r & ous3] 6z || |[@Redunch]

Instance and Process Name

& nat 1| Object Name Value /
J std_logic 1164 st lga 1 A
e ? ©
@0 i =
g s [ 2
e 1 “w
2r
4
L]
i
0
‘ m ' 1
& tnstenc.. | By Memory ||E]source || = NI Default wef [x]
Consale o0/ X
VIARNING: A WEBPACK ficense was found. E

WARNING: Please use Xiinx License Configuration Manager to check out a full 15m license,

WUARNING: ISim will run in Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version,

This is a Lite version of ISim.

Time resolutionis 1ps r
Simulator is doing circvit iniislization process,

Finished circvit initialization process.

1Sim> -

B Console ||| Compiatinlog | @ Breakponts | (24 FindinFlesResults |y Search Results

Fig. no. 5.6 HA Simulation output

e Sample VHDL code to implement Half Adder and Full Adder:
1) Half Adder:
library IEEE;
use IEEE.STD_LOGIC_1164.ALL;
use IEEE.STD_LOG IC_ARITH.ALL,;
use IEEE.STD_LOGIC_UNSIGNED.ALL;
entity HA is
Port (A, B : in std_logic;
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2)

3)

S, C:outstd_logic);

end HA;

architecture dataflow of HA is
begin

S<= A xor B;

C<=Aand B;

end dataflow;

Full Adder:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOG IC_ARITH.ALL,;
uselEEE.STD_LOGIC_UNSIGNED.ALL;
entity full_adder is

port(A, B, Cin :in bit;

S, C:out bit);

end full_adder;

architecture data of full_adder is

begin

S<= A xor B xor Cin;

C <= ((A and B) or (B and Cin) or (A and Cin));
end data;

Program Statement for Student: Implement Half subtractor and Full subctractor using
behavioral model
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Xl Resources

Table 5.4 Required Resources

Sr. | Name of Resource Specifications Quantity
No.

1 -

2

3

X1l Actual Procedure
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X1 Observation Table (use blank sheet provided if space not sufficient)
a) Observations for Half Subtractor for Problem Statement given to Student.
Table 5.5 Observation table

Input Output
A B Difference borrow
0 0
0 1
1 0
1 1

b) Observations for Full Subtractor for Problem Statement given to Student.

Table 5.6 Observation table

Input Output
A B Bin Difference | borrow
0 0 0
0 0 1
0 1 0
0 1 1
1 0 0
1 0 1
1 1 0
1 1 1

X1V  Result

XV  Interpretation of result
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XVI Conclusion and recommendation

XVII Practical related questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.

1. Write the VHDL code for half adder using Behavior Modelling.

2. Write the VHDL code for full subtractor using if-then-else statement.

3. Write VHDL code for full adder using mixed style of modelling.
[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading
Table 5.7 References

Sr. No Link / Portal Description
1 https://de-iitr.vlabs.ac.in/exp/half-full-subtractor/ To Study and Verify Half and Full
Subtractor through Virtual lab
2 https://startingelectronics.org/software/\VVHDL - AND Gates, OR Gates and Signals
CPLD-course/tut2-AND-and-OR-gates/ in VHDL
3 https://www.tutorialspoint.com/visi_design/vlsi_des VLSI Design - VHDL
ign_vhdl_introduction.htm Introduction, VLSI Design Useful
Resources

XIX Assessment Scheme

Performance Weightage
Indicators
Process Related : 15 60 %
Marks
1 | Coding ability 30%
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product Related: 10 40%
Marks
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission, Answer to sample questions. 05%
Total (25 Marks) 100 %
Marks Dated signature of Teacher
Obtained
Process Process Total
Related (15) Related (10) (25)
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VI

Practical No.6: *Realize the Multiplexer on FPGA board

Practical Significance

Multiplexers are fundamental combinational building blocks used in communication, processor
data paths, ALUs, memory selection, and digital control circuits. Implementing MUX on FPGA
shown mapping behavioral logic to physical hardware. Enhances understanding of FPGA pin
mapping, constraints file usage, HDL coding styles, and verification methods. Helps students

correlate simulation results with actual hardware behaviour.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome through
various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcome
LLO 6.1 Test the functionality of 4:1 multiplexer using VHDL code

Relevant Affective Domain related outcomes
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.

Relevant Theoretical Background

A multiplexer (MUX) is a combinational circuit that selects one input out of multiple data
inputs and forwards it to the output based on select-line values.

4:1 Multiplexer Structure:

. 4 data inputs: DO, D1, D2, D3

. 2 select inputs: S1, SO

. 1 output: Y

Sll Sl
Dy _Joo
Dl — 01
Out
D, 10

Fig. no. 6.1 Block Diagram of 4:1 Multiplexer
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e Truth Table of 4:1 MUX
Table 6.1: Truth Table of 1:4 Multiplexer

S1 SO Output Y
0 0 DO
0 1 D1
1 0 D2
1 1 D3

VIl  a) Suggested Practical Sample:

10-pin Female Connector

(Connects to target printed N
arcuit board 10-pin male header.) ~ & Y
LED Color Description
Off Not connected or suspended f =
Blue Connected at 12MHz (USB full speed) Neeid
Teal Connected at 480MHz (USB high speed) =
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

(1)

Fig. no. 6.2 Practical Setup with JTAG CABLE

b) Actual Practical Setup used in laboratory with related equipment rating:
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VIl Required Resources/apparatus/equipment with specifications
Table 6.2 Required Resources
Sr.No Instrument / Specification Quantity
' Components P
Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
1 FPGA hardware circuit.,, On board, 2 Crystal 8MHz and 1 No
' Development kit 25MHz. JTAG Interface (Boundary Scan),PROM '
Interface (XCFO02S),40 pin, 4 header connector for
external 1/0's
Loaded with open source IDE, simulation and
2 Desktop PC program downloading software, UPS and Antivirus. 1 No.
IX Precautions to be followed
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X Procedure

1. Create the Xilinx ISE project for your top-level FPGA design, by doing the following in
ISE:

2. In the ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

3. Select HDL or Schematic as the Top-level source type, and click Next

4. Create New Source file. Select Source Type” select the Source type and give the name to
the source then click “Next”.

5. Define Module”. Enter the entity used in design and then click “Next”.

6. Develop VHDL code for given problem and synthesize the .vhd file and view RTL
schematic.

7. Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

8. Go to implementation to simulation tab, right click on main source file and create Test
Bench file for simulation.

9. In order to view test files, select the box of “Simulation” in the “View Panel” of the
“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes.Double click on
“Simulate Behavioral Model” in the “Process Pane”, which will open the ISim software
with your test bench loaded.

10. ISim simulator window will open with your simulation executed, where one can simulate
designs and check errors if any.
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a) Create 4:1 multiplexer .vhd file:

3
[ File Edt View Project Source Process Tools Window Layout Help BOH
DBEHALEDEX|0d| 2 LRRARF ZE DD LRPEL:Q
Des 08 x| R
en o8 “ S ibrayieee;
[ (Ve © Tpirpenenaton O giSmioton | 27 use iece.std_logic_1164.alL
Li| | Hierarchy 29
f & Mux “ 30 entity mux4to] is
| E O a3sk0-dpagé 31 port(
do| o MUK-Behavionsl MUXvhd) 32 d:instd_logic_vector(3 downto 0); -- DO to D3
2 33 s zin std_logic_vector(1 downto 0); -- Select lines
&l
- ol 134 y - out std_logic );
Al ss end muxdtol;
% 36
It} 3 : : ;
= %| 38 architecture behavioral of mux4to] is
A %| 39 begin i
—| 40 process(d. s)
) Q| a begin
: €2 NoProcesses Running 9| « caesh
74 | Processes: MUX - Behavioral = :i when "00" =>y <= d(0);
: hen "01" => y <= d(1);
£ Design Summary/Reports w ¥
3l | Desgn Utities o when'l0"=>y<=dQ) 5
2 User Constraints = when "11" => y <= d(3);
—|® s when others =>y <="0";
“|@ &)  Implement Design S end case;
€)  Generate Programming File 50 end process;
@ @  Configure Trget Device 51 end behavioral:
€ Analyze Design Using ChipScope 52
53 -
<y L} d »
| Strt | 33 pesn | ) Fies | Q) trenes| D MUXvhd Bz ¥ (S x]|
Console #08 X
Process "Synthesize - XST" completed successfully A
<lg [ »
[i] Consoe @ Eros | 1L Wamings | 8 FrdnFesResits |

b) Create 4:1 multiplexer test bench file:

@ File Edt View Project Source Process Tools Window Layout Help

NEE
DAEF.[s00x[va|[£-BR 2RI =S 02[LRPEL[Q

|Desgn «08X% & s -

(i |vew: © fff inglementaton © Efsmiaton = | €1 -- Stimufus Process
e ohaviora == ez " 7

&l 23 stim_proc: process

[y | Hierarchy ° 84 begin

&ls ggm 9208 :: -- Test Case 1

oo |8 P — " — A" P &

E ® R muxth- behavor (mis thihe) ,\_ :; ii_f[\;s?g:e:zs <="00"; wait for 10 ns;

E Al e d<="0010"; s <="01"; wait for 10 ns;

@ » :: -- Test Case 3

== A e d<="0100"; s <="10"; wait for 10 ns;

i | 93 -- Test Case 4
0| & d<="1000" s <="11" wait for 10 ns;

P | 4 NoProcesses Ruming | s -- Additional Tests

P4} | Processes: mux_tb - behavior =il S d<="1100"; s <="00"; wait for 10 ns;

%[= P ismsmubtor - d<="1100"; s <="01"; wait for 10 ns; -

gc 9 ’d 100 d<="1100"; s <="10"; wait for 10 ns;

= EE— 101 d<="1100"; s <= "11"; wait for 10 ns; s

= 102 5

" 103 wail,
104 end process: p
108 end architecture sim;
106
107 ¢
il | —7 J »
|2 st 23 Desgn [ Fes [ Q) Lorares| | B maxvhd oJE R mx_tb.vhd <]

(Conscle »08Xx
ISim simulation engine GUI launched successfully -
Process "Simulate Behavi 1 Model®™ 1 d 11y o

K —T— » i

[E] Consdle |© Brors | ) Wamings | 28 FdinFlesResls
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e Sample VHDL Code to Implement 4:1 MUX

Behavioral Model:
library ieee;
use ieee.std_logic_1164.all;

entity mux4tol is

port(

d:instd_logic_vector(3 downto 0); -- DO to D3
s:instd_logic_vector(1 downto 0); -- Select lines
y :out std_logic );

end mux4tol;

architecture behavioral of mux4tol is
begin

process(d, s)

begin

case s is

when "00" =>y <=d(0);
when "01" =>y <=d(1);
when "10" =>y <=d(2);
when "11" =>y <= d(3);
when others =>y <="0"
end case;

end process;

end behavioral;

2. Testbench for 4:1 Multiplexer
library ieee;
use ieee.std_logic_1164.all;

entity tb_mux4tol is
end entity;

architecture sim of tb_mux4tol is

signal d : std_logic_vector(3 downto 0) := (others =>'0";
signal s : std_logic_vector(1 downto 0) := (others =>"'0");
signal y : std_logic;

-- Component Declaration
component mux4tol

port(

d:instd_logic_vector(3 downto 0);
s :instd _logic_vector(1 downto 0);
y : out std_logic

)i

end component;
begin

-- Instantiate the Unit Under Test (UUT)
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UUT: mux4tol
port map(
d=>d,

s =>5,

y=>y

);

-- Stimulus Process
stim_proc: process
begin

-- Test Case 1
d <="0001"; s <="00"; wait for 10 ns;
-- Test Case 2
d <="0010"; s <="01"; wait for 10 ns;
-- Test Case 3
d <="0100"; s <="10"; wait for 10 ns;
-- Test Case 4
d <="1000"; s <="11"; wait for 10 ns;

-- Additional Tests

d <="1100"; s <="00"; wait for 10 ns;
d <="1100"; s <="01"; wait for 10 ns;
d <="1100"; s <="10"; wait for 10 ns;
d <="1100"; s <="11"; wait for 10 ns;

wait;
end process;
end architecture sim;

2. Program Statement for Student: Implement 4:1 MUX using Dataflow Model
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Xl1. Resources

Table 6.3 Resources

Sr. Name of Resource Specifications Quantity
No.
1
2
3
XIl.  Actual Procedure
XI1l. Observation Table (use blank sheet provided if space not sufficient)
Observations for 4:1 MUX for Problem Statement given to Student.
Table 6.4 Observation table
SO S1 Y
0 0
0 1
1 0
1 1
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XIV. Result

XVII.  Practical related questions
Note: Below given are few sample questions for reference. Teacher must design more
such questions so as to ensure the achievement of identified CO.

1.  Write VHDL behavioral code for a 8:1 MUX..
2.  State the role of synthesis in FPGA programming
3. Write VHDL code 4:1 MUX using 2:1 MUX components.

[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading

Table no.6.5 References

Sr.

No.

Links/ Portal

Description

https://www.tutorialspoint.com/vlsi_design/vhdl progra

demultiplexer/theory.html

1 mming for combinational circuits.htm VHDL Programming Combinational Circuits

o |https://buzztech.in/vhdl-modelling-styles-behavioral- VHDL Modelling Styles: Behavioral,
dataflow-structural/ Dataflow, Structural

3 https://de-iitr.vlabs.ac.in/exp/multiplexer- Implementation of 4x1 multiplexer and 1x4

demultiplexer using logic gates.

XIX Assessment Scheme

Performance Indicators Weightage
Process Related : 15 Marks 60 %
1 | Coding ability 30%
2 | Debugging ability 10%
3 | Follow ethical practices. 20%
Product Related: 10 Marks 40%
5 | Correct connections to FPGA Board 20%
6 | Answer to sample questions. 15%
7 | Timely Submission , Answer to sample questions. 05%
Total (25 Marks) 100 %
Marks Obtained Dated signature of Teacher
Process Related |Process Related Total
(15) (10) (25)
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Practical No.7: Realize the De-multiplexer on FPGA board |

Practical Significance

VI

De-multiplexers (DEMUX) are essential components in digital systems where a single data
input must be routed to multiple destinations based on select-line control. A 1:8 De-Multiplexer
(DEMUX) is widely used in digital systems to route a single data input to one of eight output
lines. By implementing the De-MUX in VHDL and downloading it onto an FPGA, students
gain exposure to synthesizable HDL coding, pin assignment, and timing verification.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted outcome through
various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcome
LLO 7.1 Test the functionality of 1:8 De multiplexer using VHDL code.

Relevant Affective Domain related outcomes
Follow good coding and documentation practices for reproducible lab results.

Maintain tools and equipment.
Follow ethical practices.
Work in pairs to cross-check test vectors and board results.

Relevant Theoretical Background

A DEMUX performs the reverse operation of a multiplexer. It takes one input (D) and sends
it to one active output among eight outputs, depending on the three select lines (S2, S1, S0).
1:8 De multiplexer

o Input (Din): Single data input

« Select Lines (S2, S1, S0): Choose which output receives the data

 Outputs (YO to Y8): One active at a time

D; ,——»>
n 1:8 —oYg

DEMUX . v Outputs

Sz S1 So
Select lines

Fig. no. 7.1: Block Diagram of 1:8 Demultiplexer
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o Truth Table of 1:8 DEMUX

Table 7.1: Truth Table of 1:8 Demultiplexer
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VIl Circuit diagram
a) Suggested Practical Setup:

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended
Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

Fig. no. 7.2 Practical Setup with JTAG CABLE

b) Actual Practical Setup used in laboratory with related equipment rating:
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VIl Required Resources/apparatus/equipment with specifications
Table no.7.2 Required Resources
Sr. Instrument/ S .
NoO Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
1 FPGA Development hardware circuit.,, On board, 2 Crystal 8MHz and 1 No
kit 25MHz. JTAG Interface (Boundary Scan),PROM '
Interface (XCF02S),40 pin, 4 header connector for
external 1/0's
2 | Desktop PC Pgrsonal computer with I_atest c_onflguratlon. Loaded 1 No.
with open-source IDE, simulation and program
downloading software, UPS and Antivirus.
IX Precautions to be followed
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X Procedure

1. Create the Xilinx ISE project for your top-level FPGA design, by doing the following in
ISE:

2. In the ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

3. Select HDL or Schematic as the Top-level source type, and click Next

4. Create New Source file. Select Source Type” select the Source type and give the name to
the source then click “Next”.

5. Define Module”. Enter the entity used in design and then click “Next”.

6. Develop VHDL code for given problem and synthesize the .vhd file and view RTL
schematic.

7. Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

8. Go to implementation to simulation tab, right click on main source file and create Test
Bench file for simulation.

9. In order to view test files, select the box of “Simulation” in the “View Panel” of the
“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes. Double click on
“Simulate Behavioral Model” in the “Process Pane”, which will open the ISim software
with your test bench loaded.

10. 1Sim simulator window will open with your simulation executed, where one can simulate
designs and check errors if any.
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a) Create 1:8 Demultiplexer .vhd file:

Window Layout Help WEOE

[2) File Edt View Project Source S Lk
DREAIL %00 X|vd| 2288 AR 2B 0 ,RiPEL?
[peson »08x & 2 ; -
= =S b library ieee:
ij Ve @ { inpenentaton ©) (i smuaton g; use ieee.std_logic_1164.all;
| | Hierarchy = =
) & Mux il | entity mux4to] is
—|ea n3$:°°4mm ) 31 port(
do o MUX - Behavioral (MUXvhd) 32 d:instd_logic_vector(3 downto 0); -- DO to D3
g 92 33 s -in std_logic_vector(1 downto 0); -- Select lines
= | 134 y - out std_logic )
A :: end mux4tol:
B b3
= %| 31 architecture behavioral of mmxdtol is
- %| 39 begin i
—| 40 process(d. s)
| Q| a begin
L €2 NoProcesses Running 9| = case sl
71| Processes: MUX - Behavioral = :i when "00" =>y <= d(0);
. hen "01" => y <= d(1);
£ Design Summary/Reports b .
;ﬁ_ ® Design Utities :: when "10" => y <= d(2); |
% User Constraints s when'll"=>y<=d0);
= s when others =>y <="0";
“|@ &)  Implement Design 49 end case;
€)  Generate Programming File 50 end process;
@ @  Configure Torget Device 51 end behavioral:
€4 Analyze Design Using ChipScope 52
53 -
LIy —] | 4
[ stt| 38 vesr [ Fles [ Q) toreres| B Mavhd L Desgn Summry (Synthesized) x]|
Consdle w08 X
Process ze - XST" leted fully L
! m »
Consde | @) Erors | 1) Wamngs | 96 FrdnFlesResls |

b) Create 1:8 Demultiplexer test bench file:

[ e wlmunie |
Z) File Edit View Project Source Process Tools Window Layout Help = (8] X
Bl
D2HALIEDEX|0a| i 22BRARIRA RS T LRIPELIQ
|Desgn w08x | g -
(i | Vew: © {8 implementaton © G smiaton = | 61 -- Stimulus Process
] [Behavioral = = :: stim_proc: process
[y | Herarchy o | 84 begin
=1} E:;"m . :: -~ Test Case 1
o B P ey d<="0001"; s <= "00"; wait for 10 ns;
® th - behavior (mux thvhd) | © | 87 : : g
Q @ B s e —| s8 -- Test Case 2
a Al e d <="0010"; s <="01"; wait for 10 ns;
2 » :2 -- Test Case 3
= A o d<="0100"; s <= "10"; wait for 10 ns;
i od -- Test Case 4
o] & d<="1000" s <="11"; wait for 10 ns;
» €2 MNoProcesses Running o o -- Additional Tests
F4; | Processes: mux_tb - behavior = [ 5 d<="1100"; s <= "00"; wait for 10 ns;
%o ismSmutto - d<="1100"; s <="01"; wait for 10 ns; 3
E J ’d 100 d<="1100"; s <= "10"; wait for 10 ns;
e = 101 d<="1100"; s <="11"; wait for 10 ns; =
- 102 5
" 103 wait;
104 end process: r
108 end architecture sim;
106
107 ¢
L P — 8
| strt] @8 Desgn [ Fies [ Lbraies| | B mox.vhd [ L Desnsumay(Syntheszed) L D mux_th.vhd ol
Consdle w08 x
ISim simulation engine GUI launched successfully -
Process "Simulate Behavi 1 Model"™ leted 11y =
< m »

—
(2] corsde [@ Erors | 1) Wamings | 28 FrdinFesResuts |
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e Sample VHDL Code to Implement 1:8 DEMUX

1. Behavioral Model:
library ieee;
use ieee.std_logic_1164.all;

entity demux1to8 is

port(

d:instd_logic;
s:instd_logic_vector(2 downto 0);

y :outstd logic_vector(7 downto 0) );
end demux1to8;

architecture behavioral of demux1to8 is
begin

process(d, s)

begin

y <= (others =>"'0"); -- default all zero
case s is

when "000" => y(0) <=d;

when "001" =>y(1) <=d,

when "010" => y(2) <=d;

when "011" =>y(3) <=d,

when "100" => y(4) <=d;

when "101" => y(5) <=d,

when "110" => y(6) <=d;

when others =>y(7) <=d,

end case;

end  process;

end behavioral;

2. Testbench for 1:8 Demultiplexer
library ieee;
use ieee.std_logic_1164.all;

entity tb_demux1to8 is
end tb_demux1to8;

architecture sim of tb_demux1to8 is

signal d : std_logic :='0;

signal s : std_logic_vector(2 downto 0) := (others =>'0");
signal y : std_logic_vector(7 downto 0);

component demux1to8

port(

d:instd_logic;
s:instd_logic_vector(2 downto 0);
y :out std_logic_vector(7 downto 0)
)i

end component;
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begin

UUT: demux1to8
port map(

d=>d,

s=>s5,

y=>y);

stim_proc: process
begin
d<="1,

s <="000"; wait for 10 ns;
s <="001"; wait for 10 ns;
s <="010"; wait for 10 ns;
s <="011"; wait for 10 ns;
s <="100"; wait for 10 ns;
s <="101"; wait for 10 ns;
s <="110"; wait for 10 ns;
s <="111"; wait for 10 ns;

d<="0,
s <= "010"; wait for 10 ns;
s <="111"; wait for 10 ns;

wait;
end process;
end sim;

2. Program Statement for Student: Implement 1:8 Demultiplexer using Dataflow Model
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XI. Resources
I?I:). Name of Resource Specifications Quantity

1

2

3

XI1. Actual Procedure
XIIl. Observation Table (use blank sheet provided if space not sufficient)
Observations for 1:8 Demultiplexer for Problem Statement given to Student.
Table 7.3 Observation table
Input Data Output
S2 | S1 | SO D Y7 Y6 Y5 Y4 Y3 Y2 Y1 YO0
0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 1
1 0 1 1
1 1 0 1
1 1 1 1
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X1V. Result

XV. Interpretation of result

XVI. Conclusion and recommendation

XVII. Practical related questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.

1. Modify the VHDL code to implement an active-high enable input
2. Explain the behavior of the circuit if the select lines take undefined values (X or Z).
3. Write the VHDL code for 1:4 demultiplexer using the ‘if else” statement.

[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading

Table 7.4 References

Sr. . .
NoO Link Description
Dataflow Style of Modelling,
1 https://buzztech.in/vhdl-modelling-styles- Behavioral Style of Modelling,
behavioral-dataflow-structural/ Structural Style of Modelling,
RTL Design:
5 https://www.tutorialspoint.com/visi_design/vhdl VHDL Programming
programming_for_combinational_circuits.htm Combinational Circuits
3 https://www.rfwireless-world.com/source- 1x8 Demultiplexer VHDL Source
code/VHDL/1X8-DEMU X-vhdl-code.html Code
4 http://vhdlbynaresh.blogspot.com/2013/07/design-of-1- Design of 1 : 8 Demultiplexer
8-demultiplexer-using-when.html Using When-Else (VHDL Code).
XIX  Assessment Scheme
Performance Indicators Weightage
Process Related : 15 Marks 60 %
1 | Coding ability 30%
Debugging ability 10%
3 | Follow ethical practices. 20%
Product Related: 10 Marks 40%
5 | Correct connections to FPGA Board 20%
Answer to sample questions. 15%
Timely Submission , Answer to sample 05%
questions.
Total (25 Marks) 100 %
Marks Obtained Dated signature of Teacher
Process Related |Process Related Total
(15) (10) (25)
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Vi

Practical No.8: Design 4:2 encoder on FPGA board

Practical Significance

A 4:2 encoder is a key combinational circuit widely used in digital systems to convert
one of several active inputs into a smaller set of binary outputs. They are mainly used in
logical circuits as well as data transfer circuits. This practical will help the students to
gain experience with FPGA synthesis, pin assignment, and testing, Develop skills for
implementing digital components used in processors, interrupt controllers, and
communication systems.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer excepted
outcome through various teaching learning experiences:

“Develop VLSI-based electronic circuit/component using VHDL.”

Course Level Learning Outcome
Use VHDL to develop and test digital circuits.

Laboratory Learning Outcome
LLO 8.1 Interpret the output of 4:2 encoder using VHDL code.

Relevant Affective Domain related outcomes

e Follow good coding and documentation practices for reproducible lab results.
e Maintain tools and equipment.

e Follow ethical practices.

e Work in pairs to cross-check test vectors and board results.

Relevant Theoretical Background

Encoders are crucial components in various digital electronics applications such as data
transmission, controlling and automation, communication, signal processing, etc.An
encoder consists of a certain number of input and output lines. Where, an encoder can
have maximum of "2™ input lines Whereas "n" output lines. Hence, an encoder encodes
information represented by "2™" input lines Witﬂ "n" bits.

A 4 to 2 Encoder is a type of encoder which has 4 (22) input lines and 2 output lines. It
produces an output code (i.e., convert input information in a 2-bit format) depending on
the combination of input lines. The block diagram of a 4 to 2 Encoder is shown in the
following figure.

lp ——

| 4:2 Yo

! Binary

|y ——— Y,
Encoder

Fig 8.1: Block diagram of 4:2 encoder
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e Truth Table for 4:2 Encoder
Table 8.1 Truth Table for 4:2 encoder

Input Output
13 12 11 10 Y1 YO0
0 0 0 1 0 0
0 0 1 0 0 1
0 1 0 0 1 0
1 0 0 0 1 1

VIl Circuit diagram
a) Suggested Practical Sample:

10-pin Female Connector

(Connects to target printed ( R
circuit board 10-pin male header.) - /
e O
LED Color Description
Off Not connected or suspended Al =
Blue Connected at 12MHz (USB full speed) : N
Teal Connected at 480MHz (USB high speed) ' Z

Green JTAG port open, idle
Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

i)

Fig. no. 8.2 Practical Setup with JTAG CABLE

b) Actual Practical Setup used in laboratory with related equipment rating:
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VIl R

equired Resources/apparatus/equipment with specifications
Table no.8.2 Required Resources

Sr.
No.

Instrument /

Components Specification Quantity

FPGA Development hardware circuit., On board, 2 Crystal 8MHz and

Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other

L kit 25MHz. JTAG Interface (Boundary Scan),PROM 1 No.
Interface (XCF02S),40 pin, 4 header connector for
external 1/0's
2.| Desktop PC P_ersonal computer with_latest _configuration. Loaded 1 No.
with open-source IDE, simulation and program
downloading software, UPS and Antivirus..
IX Precautions to be followed
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X Procedure

1. Create the Xilinx ISE project for your top-level FPGA design, by doing the following in
ISE:

2. In the ISE software, select File > New Project. In the Project name and Project location
fields, enter the project name and location, respectively.

3. Select HDL or Schematic as the Top-level source type, and click Next

4. Create New Source file. Select Source Type” select the Source type and give the name to
the source then click “Next”.

5. Define Module”. Enter the entity used in design and then click “Next”.

6. Develop VHDL code for given problem and synthesize the .vhd file and view RTL
schematic.

7. Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

8. Go to implementation to simulation tab, right click on main source file and create Test
Bench file for simulation.

9. In order to view test files, select the box of “Simulation” in the “View Panel” of the
“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes. Double click on
“Simulate Behavioral Model” in the “Process Pane”, which will open the ISim software
with your test bench loaded.

10. 1Sim simulator window will open with your simulation executed, where one can simulate

designs and check errors if any.
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a) 4:2encoder .vhd file diagram :-

& |SE Project Navigator (P.20131013) - F:\I SCHEME\VI SEM | SCHEME\DECODER2TO4\DECODER2TO4 xise - [DECODE2TO4.vhd] - a X

%) File Edit View Project Source Process Tools Window Layout Help &
b=/ Y| » B LR RIABRE IR L
Desgn 08X § . o ~
View: @ {5} implementation O gl Smulation 5 entity encoderdto2 is
] | Hierarchy 22 port(
i @ DECODER2TO4 = 55 i:instd logic_vector(3 downto 0);
- 0 xc35400-5pq208 = I g :
[, decoser! - bhv (DECODE2TOAN 23 y:out std_lognc;\ ector(1 downto 0) );
= 27 end encoderdto2;
o 28
@ A 2 . . ;
e : so  architecture behavioral of encoderdto? is
¢ 2 :
32 Dbegin
¢| 33 process(i)
|< > e :
O| 3 begin
P | T2 NoProcesses Running 36 caseiis
B¢ | Processes: decoder! - bhv A S when"0001" =>y <="00";
{ Vi RTL Sch i = " YL
| B Vo Teimons s 0 when 0010 =>y <="01"
€ CheckSyntax 31 when"0100"=>y<="10";
= #)  Generate Post-Synthesis S... 5 TR PR S AN
5 €3E) Implement Design 5 when "1000" => y <="11";
2 ",
£2() Generate Programming File 33 when others => y <="00"; -- default
@  Configure Target Device s ; =
%  Generate Target PROM/A... e end case;
%  Manage Configuration Pr... a: end process; o
@ Analyze Design Using ChipSc... < % 5
> St U3 Desgn L) Fles () Lbranies Design Summary (Programming File Generated) 3 DECODEZIO4vhd [ decoder1 (RTLY) #  decodert (Tech1) Y tb_decoder1.vhd
View by Category “0&Xx
Design Objects of Top Level Block Properties of Instance: decoderl
Instances Pins Signals Name Value A
4y decoder! 4 oy decoder i o decoder Type decoderl:1
OriginalSymbol decoder! G
| Console @ Errors 1\ Warninas A Find in Fles Resite Vs hu Catannry
# ISE Project Navigator (P.2 ) - FA\l SCHEME\V] SEM | SCHEME\DECODER2TO: DER2TOA.xis - 8 X
D) File Edt View Project Scurce Process Tools Window Layout Help -
12 00| » gA=E =R PEL
08X %
D) 3 inplementaton © & semdatin stim_proc: process
begin
i<="0001"; wait for 10 ns;
o 1<="0010"; wait for 10 ns;
% th_decoder! - behavior (th_decod ORGP ", . "
X - <= y
& [ wut - decoder! - bhv (DECODE! ! 0100"; wait for 10 ns:
S o s ;
11 <="1000"; wait for 10 ns;
2 e Wait;
- 3 end process:
< > .
P ) NoProcesses Running < 5
o | Pro oder! - behavior 44 end sim;
mulator 2
eck Sy 29
%
- e
50
53
54 v
< >
# St B3 Desen Fles L) Lbraries Design Summary (Programming Fie Generated) 5] DECODEZTOM4.vhd decoder 1 (RTLY) ¥ decoder] (Tech1) ) &_decodertvd 3
View by Category w08 X%
Design Objects of Top Level Block Properties of Instance: decoderl
Pins Name Value A
i gy decoder) i g decodert Type decoderl:)
OniginatSymbel decoder] i

| Consde @ Erees I\ wamings 9 FndinFlesResuts View by Category

Fig. no. 8.4. 4:2 encoder Test bench file

200n 400 ns

Fig. no. 8.5. 4:2 encoder Simulation waveforms
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e Sample VHDL Code to Implement 4 to 2 encoder

1. VHDL Code using if else statement (Behavioral Model).:
library ieee;
use ieee.std_logic_1164.all;

entity encoder4to2 is

port(

I - instd_logic_vector(3 downto 0);
y :out std_logic_vector(1 downto 0)
).

end encoder4to?2;

architecture behavioral of encoder4to? is
begin

process(i)

begin

case i is

when "0001" =>y <="00";

when "0010" =>y <="01";

when "0100" =>y <="10";

when "1000" =>y <="11";

when others =>y <="00"; -- default
end case;

end process;

end behavioral;

2. VHDL Testbench for 2 to 4 decoder:
library ieee;
use ieee.std_logic_1164.all;

entity tb_encoder4to?2 is
end tb_encoder4to2;

architecture sim of tb_encoder4to?2 is
signal i : std_logic_vector(3 downto 0) := (others =>'0");
signal y : std_logic_vector(1 downto 0);

component encoder4to2

port(

i - instd_logic_vector(3 downto 0);
y :out std_logic_vector(1 downto 0)
)i

end component;

begin

UUT : encoder4to?
port map(

i =>1,

y=>y)
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stim_proc: process

begin

i <="0001"; wait for 10 ns;
I <="0010"; wait for 10 ns;
i <="0100"; wait for 10 ns;
I <="1000"; wait for 10 ns;
wait;

end process;

end sim;

3. Program Statement for Student: Design VHDL Code for 8 to 3 encoder using if else
statement
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Xl. Resources
Table no.8.3 Resources

Sr.

No Name of Resource Specifications Quantity

XI1. Actual Procedure

XII1. Observation Table (use blank sheet provided if space not sufficient)
Observations for 8 to 3 encoder for Problem Statement given to Student.
Table 8.4 Observation table

INPUT OUTPUT
Al A2 B3 B2 Bl BO
0 0
0 1
1 0
1 1

XI1V. Result

XV. Interpretation of result
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XVI. Conclusion and recommendation

XVII. Practical related questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.

1. Design VHDL Code using FPGA board for 8 to 3 encoder using case statement.
2. Design VHDL Code using FPGA board for 16 to 4 encoder using if else statement.

3. Design VHDL Code using FPGA board for 16 to 4 encoder using case statement

[Space for Answers] (If required attach separate page)
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XVIII References/Suggestions for further reading

Table no.8.3 References

S Link / Portal Description
No
https://buzztech.in/vhdl- Dataflow Style of Modelling, Behavioral
1 | modelling-styles-behavioral- Style of Modelling, Structural Style of
dataflow-structural/ Modelling, RTL Design:
hitps:/fwww.tutorialspoint.com/vls VHDL Programming Combinational
2 i_design/vhdl_programming_for Circuit
combinational _circuits.htm IFCUILS
; C};‘?Sd/é Wjﬁ}"[}:ﬁ?pﬁ'%‘fﬁ”}’ VLSI Design - VHDL Introduction, VLSI
g 9 Design Useful Resources
ntroduction.htm
https://www.allaboutcircuits.com/t
4 | echnical-articles/sequential-vhdlI- Sequential VHDL.: If and Case Statements

if-and-case-statements/

XIX Assessment Scheme

Performance Indicators Weightage
Process Related : 15 Marks 60 %
1 | Coding ability 30%
2 | Debugging ability 10%
3 | Follow ethical practices. 20%
Product Related: 10 Marks 40%
5 | Correct connections to FPGA Board 20%
6 | Answer to sample questions. 15%
7 | Timely Submission , Answer to sample questions. 05%
Total (25 Marks) 100 %

Marks Obtained Dated signature of Teacher
Process Related | Process Related Total
(15) (10) (25)
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https://www.tutorialspoint.com/vlsi_design/vhdl_programming_for_combinational_circuits.htm
https://www.tutorialspoint.com/vlsi_design/vlsi_design_vhdl_introduction.htm
https://www.tutorialspoint.com/vlsi_design/vlsi_design_vhdl_introduction.htm
https://www.tutorialspoint.com/vlsi_design/vlsi_design_vhdl_introduction.htm
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
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Vi

Practical No. 09: Implement 3:8 Decoders on FPGA Board.

Practical Significance
In electronics, a decoder is a digital circuit that detects a specified combination of input bits (code)

generally binary inputs and converts that code in a specified output levels. A decoder has n input
lines and from one to 2" output lines to indicate the presence of one or more n bit combinations. This
practical will help the students to implement the 3:8 decoder using FPGA.

Industry/Employer Expected Outcome
The aim of this course is to attend following industry/employer expected outcome through

various teaching learning experiences-
“Develop VLSI-based electronic circuit/component using VHDL”.

Course Level Learning outcome
CO4- Develop VHDL program for given application.

Laboratory Learning Outcome
LLO 9.1 Interpret the output of 3:8 decoder using VHDL code.

Relevant Affective domain related Outcome(s)
o Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Relevant Theoretical Background

A Decoder is combinational logic circuit that converts n bit binary code into 2" output channels in
such way that only one output channel is activated for each one of the possible combinations of
inputs.

—
n Data =g
Inputs 5
: e
— H Possibl
Decoder | : Ay
Enable »
Inputs

Fig. no. 9.1: Symbol for N:2N Decoder

Here, the decoder has N input lines and M (2N) output lines. In a decoder, each of the N input lines
can be a 0 or a 1, hence the number of possible input combinations or codes be equal to (2N).For
each of these input combinations, only one of the M output lines will be active, and all other output
lines will remain inactive.
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3:8 Decoders: As shown in Fig. no..9.2, 3: 8 De-coder having three input lines and eight output
lines. It has no select lines like demultiplexer which are used as the control signals.

When this decoder is enabled with the help of enable input E, then it's one of the eight outputs will
be active for each combination of inputs. The operation of this 3-line to 8-line decoder can be
analyzed with the help of its truth table which is given below in truth table 9.1 of 3:8 decoder.

—> D0
—1> D1
——{>D2
——{>D3
a——S1  31o8Decoder —PDn
——>D5
——>D6
$—y> D7

E

T

Fig. no. 9.2: 3:8 Decoder

Table 9.1: Truth Table of 3:8 Decoder
DO D1 D2 D3 D4

w0
o
wn
H
wn
R
)
o1
)
o)
)
\‘

Rk R R ol ol ol o X
Rl ol o R~ ol o X
ROl k| ok okl ol X
e I E=1
Rlolololol ol olo o
ol olol ol oo oo
o|lo|lr|l ool oo oo
o|lo|lo|lr ol oo oo
o|lo|lo|lo|lr oo oo
o|lo|lo|lolol o oo
o|lo|o|lolol ol oo
o|lo|lo|lololololrlo

VIl  Circuit Diagram used in Laboratory with related equipment rating:
a) Suggested Practical JTAG cable setup:-
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10-pin Female Connector

(Connects to target printed Q
areuit board 10-pin male header.)
e
-+
EJ

LED Color Description

Off Not connected or suspended ‘|||
Blue Connected at 12MHz (USB full speed) \ < :
Teal Connected at 480MHz (USB high speed) . L

Green JTAG port open, idle
Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

(U]

Fig. no. 9.3 a: Practical Setup with JTAG CABLE

=

®F Scientech 102A

Push Sutton Switch

‘oF =]
&

R

Fig. no.. 9.3.b: Lab Practical Setup
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b) Create Decoder .vhd file:

lesign 08X
View: @ {8} implementation O il Smulation 5
Sl Heardy | EEIRER e
® decoder
£ xc35250e-5ft256
Wah decoder3X8 - deco38 (dec74138

¥l
a A
. N f decoder3xs
W
RS
B W
‘,“:':_ )
< >
€ i not g2b_1)='1'then
P £) NoProcesses Running ) e
y v 0 36 elsif =
c Processes: decoder3X8 - deco3d 2 o0 “03%’8
¢ & 37 19if a <=
¢ ' £ & Rep
{ L Design Summary/Reports 38 i a oa
w3  Design Utilities 52 e
f - 39 elsif a <=
k| & User Constraints 4 &
) 40 elgif a ¢=
o |2 8)  Synthesize - XST 4 ilE s o
View RTL Schematic x S
Q2 19if a ¢=

%  View Technology Schematic RS
f)  Check Syntax =

f)  Generate Post-Synthesis S. 7 ; HERS
45 else y 1 <=
# )  Implement Design 46 and %3

f) Generate Programming File
i Fanbiniivn Tormat Nairn

Fig. no. 9.4: Decoder .vhd file

c) Create Decoder test bench file:

O3 H A DDXO®0 | QRETc RIAZR AR x|t #4@» ¥ 1o

Instance.. #O B X | 08X
Q2 sl » Smulation Ob

Instance and Proces:

§ decoderss || Object Name
g td_logic 116

Lol o
1E » 8

9!
[N

Fig. no. 9.5: Demux Test Bench file

) Redaunch
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d) Decoder test bench Simulation waveforms:

DI XD0X®| oo |lE! 1O ZEIR[ANA2BAIR et ~4(0 ) ¥ 1Ml

Instance,. wOBX . w08X 4
g9e » Smulabon Ob

Instance and Proces
B decoderts || Object Nam p
g std_logic_ 116« 1 91

[ 02|

jgib-_\ ) 4
3{ 020 | &
& v o

1 »

) N B

X Delete

| Rename

{4 Find... CtrleF
Select All CtrieA

Expand

Name
Radix
Signal Color

Fig. no. 9.6 Decoder Simulation output

e) Actual practical set up used in laboratory:
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VIl Resources Required/Apparatus/Equipment with specifications:

ilg ?jﬂ;&iﬁg Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board
FPGA +5V, +3.3V, +2.5V supply to FPGA and other hardware
1.| Development | circuit.,, On board, 2 Crystal 8MHz and 25MHz.JTAG 1 No.
kit Interface ( Boundary Scan ),PROM Interface
(XCF02S),40 pin, 4 header connector for external 1/O's
2| Desktop PC Personal computer yvith Ia}test configuration. Loaded_with 1 No.
open-source IDE, simulation and program downloading
software, UPS and Antivirus.

IX  Precautions to be followed:

1.
2.

Check the syntax / rules of VHDL Programming.
Do not power up the board before completing connections.

X Procedure:

1.

w

10.
11.

12.

Create the Xilinx ISE project for your expected FPGA design, by doing the following in
ISE:

a. Inthe ISE software, select File > New Project.

b. Inthe new project wizard, enter the project name and location, respectively.

c. Select HDL or Schematic as the Top-level source type, and click Next.
Create New Source file. Select Source Type” selects the Source type and give the name
to the
source then click “Next”.
Define Module”. Enter the entity used in design and then click “Next”.
Develop VHDL code for given problemand Synthesize the .vhd file and view RTL
schematic.
Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.
Go to implementation to simulation tab , right click on main source file and create Test
Bench file for simulation.
In order to view test files, select the box of “Simulation” in the “View Panel” of the
“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes.
Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open
the
ISim software with your test bench loaded.
ISim simulator window will open with your simulation executed, as shown in Figure
9.6. where you are able to simulate your designs and check for errors.
After simulation implement 3 as 8 decoder Using FPGA development board.
Go to User Constraints — select Floorplan Area/lO/Logic (PlanAhead) — Windows —
Properties
— now assign pin configuration and save.
Go to Implement Design — Run all.
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13. Go to Generate Programming Fileand Run

14. Go to Configure Target Deviceand Run — Impact wizard opened — select Device 2 (as per
practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC And select

Program.
Sample Program: Implement 3:8 Decoder using dataflow modeling.

3:8 Decoder:

VHDL Code

library IEEE;

use IEEE.STD_LOGIC 1164.ALL,;

use

IEEE.STD _LOGIC_ARITH.ALL,;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity Decoder3to8 is
Port (S:inSTD_LOGIC_VECTOR (2 downto
0); Q:out STD_LOGIC_VECTOR (7
downto 0));
end Decoder3to8;

architecture dataflow of Decoder3to8

is begin

Q <="00000001" when S="000" else
"00000010" when S="001"
else  "00000100"  when
S="010" else "00001000"
when S="011" else
"00010000" when S="100"
else  "00100000"  when
S="101" else "01000000"
when S="110" else
"10000000";

end dataflow;

Program Statement for Student: Implement 2:4 Decoder.

2:4 Decoder

| VHDL Code

Maharashtra State Board of Technical Education

86



VLSI Applications 316340

Xl Resources Require:

S Instrument /Components Specification Quantity

no.
1.

I Actual Procedure (use blank sheet provided if space not sufficient)

X
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X111 Observation Table (use blank sheet provided if space not sufficient)
Observations for Problem Statement given to Student.

Table 9.2: Truth Table of 3:8 Decoder

SO S1 S2 YO Y1 Y2 Y3 Y4 Y5 Y6 Y7
0 0 0
0 0 1
0 1 0
0 1 1
1 0 0
1 0 1
1 1 0
1 1 1

X1V Results

XVI Conclusions and Recommendation (Actions/decisions to be taken based on the interpretation
of results)

XVI1 Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO
1. Give the syntax of With —select statement.
2. Write the VHDL code for 2:4 decoder using the ‘if else” statement.
3. Write the test bench code for3:8 decoder .

[Space for Answers] (If required attach separate page)
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XVII  Suggested referencesfor further reading
Sr no. Link/Portal Description
https://www.tutorialspoint.com/digital-electronics/digital- )
1 ) Decoder tutorial
electronics-decoders.htm
https://www.engineersgarage.com/vhdl-tutorial-13- )
2 ) ; VHDL programmin
design-3x8-decoder-and-8x3-encoder-using-vhdl/ programming
3 https://www.elp_rocus.com/desmnlnq-3-||ne-to-8-I|ne- ISE Quick start tutorial
decoder-demultiplexer/
4 _http://ecez_dav.bloqspot.com/2012/10/vhdI-tutorlal- VHDL tutorial
introducction-part-9.html
5 https://www.allaboutcircuits.com/technical- VHDL oroarammin
articles/sequential-vhdl-if-and-case-statements/ prog g
http://vhdlbynaresh.bl .com/2013/07 ign-of-3-8- ) .
6 ttp://vhd py aresh.blogspot.com/2013/07/design-of-3-8 ISE Quick start tutorial
decoder-using-when.html
XIX Assessment Scheme

The given performance indicators should serve as a guideline for assessment regarding process
and product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
1 | Coding ability 30%
2 | Debugging ability 20%
3 | Working with FPGA 10%
Product related (10 Marks) 40%(10)
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission, Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related | Product Related Total
(15) (10) (25)
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https://www.engineersgarage.com/vhdl-tutorial-13-design-3x8-decoder-and-8x3-encoder-using-vhdl/
https://www.engineersgarage.com/vhdl-tutorial-13-design-3x8-decoder-and-8x3-encoder-using-vhdl/
https://www.elprocus.com/designing-3-line-to-8-line-decoder-demultiplexer/
https://www.elprocus.com/designing-3-line-to-8-line-decoder-demultiplexer/
http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction-part-9.html
http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction-part-9.html
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-statements/
http://vhdlbynaresh.blogspot.com/2013/07/design-of-3-8-decoder-using-when.html
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Practical No. 10: Realize T and D flip flop on FPGA Board.

Practical Significance
A flip flop is an electronic circuit with two stable states that can be used to store binary data. The
stored data can be changed by applying varying inputs. Flip-flops and latches are fundamental
building blocks of digital electronics systems used in computers, communications, and many other
types of systems. This practical will help the students to implement the T and D flip flop using
FPGA.

I Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer expected outcome through
various teaching learning experiences.
Develop VLSI-based electronic circuit/component using VHDL.

i Course Level Learning Outcome
CO4 - Develop VHDL program for given application.

v Laboratory Learning Outcomes
LLO 10.1 Test the functionality of D flipflop using VHDL code.

LLO 10.2 Test the functionality of T flipflop using VHDL code.

\Y/ Relevant Affective domain related Outcomes
a. Follow safety practices.
b. Maintain tools and equipment.
c. Follow ethical practices.

VI Relevant Theoretical Background
Flip-flops and latches are used as data storage elements. It is the basic storage element in
sequential logic.

D type FF: D type FF has only one input referred to as D input or Data input. The input is applied
to S/J and it is inverted before applied to either R/K input. the input applied at the D terminal will
appear at the output after one clock pulse hence it is referred to as Delay or D FF. for this complete
clock cycle as the input is hold this circuit is known as LATCH.

D PN S
(Input)
—D Q—
g —7
(Enable) . |~ al—

R

Gated S-R latch

This NAND inverter
avoids S to be equal!
toR

Fig. no. 10.1: D Flip Flop
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Table 10.1: Truth Table for D Flip flop

Input D Output Q
0 0
1 1

T Type FF: In a JK FF then the resulting FF is referred as T Type FF. it has only one input
refereed as t input. If T=1 then it acts as toggle switch i.e. the output changes

Toggle
input

Outputs CLK

D Outputs

Ol
0l

Fig. no. 10.2: T Flip Flop

Table 10.2: Truth Table for T Flip Flop

Input T Output Q
0 Qn
1 Qn

VIl Circuit diagram used in Laboratory with related equipment rating.
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a) Suggested Practical Circuit Diagram:
Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed @
circuit board 10-pin male header.)
\\
> ?
A

LED Color Description

Off Not connected or suspended 4 Iil
Blue Connected at 12MHz (USB full speed) "
Teal Connected at 480MHz (USB high speed)

Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable "

=N

®F Scientech 102A

Loglc Output

®®s®H » B

Fig. no.. N0.10.3.b: Lab Practical Setup
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File Edit View Project Source
)

AL 31013)

rocess

b) Create DFF .vhd file:

indow Layout Help

DAEPL ¥ obXx|ena 28R 2RI B0 FRiPEL?
[Desin #08 x| 28 -- any Xilinx primitives in this code. R
[ | view: © {8} Implementation ©) 58 Simulation 29 --library UNISIM;
= - 30 --use UNISIM.VComponents.all;
| | Hierarchy 31
G| - & or o | 32 encicy DFF is
—|=-a Xﬁﬁm'hqvm ) 33 Port ( din : in STD LOGIC;
a5 [0 DFF - Behavioral (DFFvhd) 34 clk : in STD_LOGIC:
“ﬂ_ 9| 35 reset : in STD_LOGIC;
é = 36 dout : out STD_LOGIC);
A| 37 end DFF;
% 38
E 39 architecture Behavioral of DFF is
- % 40
i B« g
= 42 begin
) @ 43 dff : process (din,clk,reset) is
» | T) NoProcesses Running | begin
71 | Processes: DFF - Behavioral |2 if (resev=11') chen
Desians R 46 dout<= '0';
Eﬁ L es!gn “.”,‘f"”y’ spons 47 elsif (clk'event and clk = '1') then
e Design Utifties 48 dout<= din; B
% User Constraints 29 eiid iE:
50 end process dff;
Implement Design 51 B
Generate Programming File 52
Configure Target Device 53 end Behavioral;
€ Analyze Design Using ChipScope 54 2
55 =
—T— »
| start| @3 peson [ Fies [ B Lbraries @ DFFvhd gL Design Summary (Synthesized) x]]
Console <08 X
Process "Synthesize - XST" completed successfully -
=

<
Console

m Errors | A\ Warmings | (g4 Find inFies Results

Fig. no. 10.4: DFF .vhd file

c) Create DFF test bench file:

Ej File Edit View Project Source Process Tools Window Layout Help
DREPLfsbbX[va| £ BB AR mEnaseipcL]Q
[Design w08 & 8 =
(1 | View: © B} implementation © i smuiatin 3= | &3 -- Stimulus process
& |Behavioral o1 —| 84 stim proc: process
5 85 begin
(2] | Hierarchy © g6 -- hold reset state for 100 ns.
il | & oFr 87 clk<='0";
@0 | B €1 xa3s400-4pqg208 88 din<='1';
g & DFF_tb - behavior (DFF_tb.vhd) 2 89 wait for 50 ns;
ot —| 90 clk<='0";
A 91 din<='0";
92 wait for 50 ns;
E 7 93 clk<="0";
- Al oe dinc='0';
b S 95 wait for 50 ns;
—| 98 clk<="1";
: Qf o din<="1";
[ 82 NoProcesses Rumning ©| oe wait for 50 ns;
P/ | Processes: DFF tb - behavior = 132 d?1’<‘<=;1"
i in<="0";
E R '"' Simulator 101 wait for 50 ns; F
% @ horal hekS 102 clk<="1";
A 1mu ate Behavioral Mode 6a el
m 104 wait for 50 ns; =
105 clk<='1";
106 din<="0";
107 wait for 50 ns; =
108 --wait for clk period+10;
109 &
| — »
[ start | @3 Design [T Fies [ Liraries| B DFF.vhd goJE Design Summary =1IE] DFF_tb.vhd g
Console <08 X
Process "Simulate Behavioral Model" completed successfully B
=
4 . »

R—
Console | @ Erors | 1\ Wamings | 6 Findin Fes Results |

Fig. no. 10.5: DFF Test Bench file

Maharashtra State Board of Technical Education

94



VLSI Applications 316340

d) DFF test bench Simulation waveforms:

L I5im (20131013) - Dertwc] R - T B ! o S

| File Edit View Simulation Window Layout Help - |8 %

DBELsDEX®w oM
Instances and Processes + 0 & X/ Objects L
Simulation Objects for dff _th

Instance and Process Name D=
i dffth dfl| Object Name Value
J std_logic 1164 st @ din 0
@ dk 1
‘@ reset 0 _
o dout 1 R dk_period 10000 ps

1§ dk_period 10000 ps

11l [} ¢ ) o< Y« I b >

| & mnstanc. [ Memory ‘ Ssource . | ¢ I li| Default.wefg (]
Console +08x
[ waRnING: A WEBPACK cense was found. Al

\WARNING: Please use Xiiinx License Configuration Manager to check out a full ISim license.

WARNING: ISim will run in Lite mode. Please refer to the 1Sim documentation for more information on the differences between the Lite and the Full version, ‘
This is aLite version of 15im,

Time resolution is 1ps
Simulator is doing circuit initialization process. ‘
Finished circuit initialization process.

15im> ) il

@ console | -] CompiationLog ® EBreakpoints 1 2 Findin Fies Results } th SearchResults

Fig. no. 10.6 DFF Simulation output

e) Actual Practical set up used in laboratory:
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VIl Resources Required:

Iflg. g‘sg;g:]imé Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208), On board +5V,
FPGA +3.3V, +2.5V supply to FPGA and other hardware circuit. On
1 Development | board, 2 Crystal 8MHz and 25MHz. JTAG Interface ( Boundary | 1 No.
kit Scan ), PROM Interface (XCF02S), 40 pin, 4 header connector
for external 1/0's
2 | Desktop PC Personal computer v_vith latest configuration. anded with open- 1 No.
source IDE, simulation and program downloading software,
UPS and Antivirus.
IX  Precautions to be followed:

a.
b.

Check the syntax / rules of VHDL Programming.
Do not power up the board before completing connections.

Procedure:

ok

o

10.

11.

12.

13.
14.

15.

Create the Xilinx ISE project for your expected FPGA design, by doing the following in ISE:
In the ISE software, select File > New Project.

In new project wizard, enter the project name and location, respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problemand Synthesize the .vhd file and view RTL
schematic.

Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

Go to implementation to simulation tab , right click on main source file and create Test Bench
file for simulation.

In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax’ to make sure that
you didn’t make any syntax errors while making changes.

Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the ISim
software with your test bench loaded.

ISim simulator window will open with your simulation executed, as shown in Fig. where you
are able to simulate your designs and check for errors.

After simulation implement T and D Flipflop Using FPGA development board.

Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows —
Properties

— now assign pin configuration and save.
Go to Implement Design — Run all.
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16. Go to Generate Programming Fileand Run

17. Go to Configure Target Deviceand Run — Impact wizard opened — select Device 2 (as per
practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC And select
Program.

Sample Program: Implement T and D flip flop using FPGA

T Flip Flop :

VHDL Code
library IEEE;
use IEEE.STD_LOGIC_1164.all;

entity Toggle flip_flop is
port(
t:in STD_LOGIC;
clk:in STD_LOGIC;
reset:in STD_LOGIC;
dout : out STD_LOGIC
);
end Toggle_flip_flop;

architecture T_FFof Toggle_flip_flop is
begin

tff : process (t,clk,reset) is
variable m : std_logic : ='0;
begin

if (reset ='1") then

m:="0}

elsif (rising_edge (clk)) then
if (t="1") then

m: =notm;

end if;

end if;

dout<=m;

end process tff;

end T _FF;

D Flip Flop:

VHDL Code
library IEEE;
use IEEE.STD_LOGIC _1164.all;

entity d_flip_flop is
port(
din:in STD_LOGIC,;
clk:in STD_LOGIC;
reset:in STD_LOGIC;
dout : out STD LOGIC);
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end d_flip_flop;

architecture D_FF of d_flip_flop is
begin
dff : process (din,clk,reset) is
begin
if (reset="1") then
dout<="0",
elsif (clk’event and clk="1") then
dout<=din;
end if;
end process dff;
end D_FF;

Problem Statement for Student:
1.  Write the VHDL code for D flip flop with respect to the structure shown:

VHDL Code

2. Using dataflow method i.e. finds characteristic equation T=? D=?

D D1

)

D2
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X1l Resources:
ﬁg' Instrument /Components Specification Quantity
1.
2.
X1l

Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIIl Observations (use blank sheet provided if space not sufficient)

Observations for Problem Statement given to Student.

Table 10.3: Truth Table for D Flip Flop

CLK D Y
0 0
1 0
1 1
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XIV Results (output of Program)

XVII Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO

1. Write the VHDL code for T flip flop using structural modeling and Data flow method.
2. Write the VHDL test bench code for T Flip Flop.
3. Compare data flow and Behavioral method

[Space for Answers] (If required attach separate page)
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XV Suggested referencesfor further reading

Sr no. Link/Portal Description

1 https://buzztech.in/vhdl-modelling-styles-behavioral-
dataflow-structural/

5 https://www.tutorialspoint.com/vlsi_design/visi_desig
n_vhdl_introduction.htm

3 https://www.tutorialspoint.com/vlsi_design/vhdl_progr
amming_for sequential _circuits.htm

4 http://ece2day.blogspot.com/2012/10/vhdI-tutorial-
introducction-part-7.html

VHDL programming

VHDL programming

ISE Quick start tutorial

VHDL tutorial

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
1 | Coding ability 30%
2 | Debugging ability 20%
3 | Working with FPGA. 10%
Product related (10 Marks) 40%(10)
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission, Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related | Product Related Total
(15) (10) (25)
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Vi

Practical No. 11: Design comparator on FPGA board.

Practical Significance

Comparator is a combinational logic circuit that is used to compare the magnitudes of two binary
numbers. Comparators are used in several different electronic circuits like analog to digital
converters, voltage level detectors, zero-crossing detectors, etc.. This practical will help the students
to develop programming skills i.e. Implement 2 bit comparator on FPGA board using Xilinx ISE
tools.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer expected outcome through various
teaching learning experiences

Develop VLSI-based electronic circuit/component using VHDL.

Course Level Learning outcome
CO4- Develop VHDL program for given application.

Laboratory Learning Outcome
LLO 11.1 Test the functionality of 2-bit comparator using VHDL code.

Relevant Affective domain related Outcome(s)
o Follow safety practices.

e Maintain tools and equipment.
e Follow ethical practices.

Relevant Theoretical Background
Depending on the number of bits, the following are some main types of comparators used in digital

circuits

e 1 bit comparator

e 2 bit comparator

e 4 bit comparator
Consider the 2-bit magnitude comparator compares the values represented by two 2-bit binary
numbers and then generates an output that indicates whether one number is equal to or greater than
or less than the other.

" (A<B)
Ag
2 Bit (A=B)
Comparator
B,
(A>B)
B(]

Fig. no..: 11.1 Block diagram of 2-Bit Comparator
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Table 11.1: Truth table of 2 Bit Comparator

Inputs Outputs
A, Ay B, Bo A>B A=B A<B
0 0 0 0 o 1 0
0 0 0 1 0 0 1
0 0 1 0 ] 0 1
0 (1] 1 1 0 0 1
0 1 0 0 1 0 0
0 1 0 1 0 1 0
0 1 1 0 ] 0 1
0 1 1 1 0 0 1
1 0 0 0 1 0 0
1 0 0 1 1 0 0
1 0 1 0 ] 1 0
1 (1] 1 1 0 0 1
1 1 0 0 1 0 0
1 1 0 1 1 0 0
1 1 1 0 1 0 0
1 1 1 1 0 1 (1]

The Boolean expression for the outputs after solving k maps for following cases

Case-1 (A>B) output= Al B1+ (A1O B1) A0 BO
Case-2 (A=B) output= (A0 ® B0) (A1 © B1)

Case-3 (A<B) output= Al BL + (ALOB1)A0 BO

Fig. no.: 11.2 Logic diagram of 2 Bit Comparator
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VIl Circuit Diagram used in Laboratory with related equipment rating.
a) Suggested Practical Circuit Diagram:
Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed O
circuit board 10-pin male header.)
e \C
o =

LED Color Description

Off Not connected or suspended
Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)

Green JTAG port open, idle
Greenflickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

(U]

= It
= :,
(tal
Push Button Switch

Sz S
L&) X

Logic Output

® 98 ®H BB

Fig. no. 11.3.b: Lab Practical Setup
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b) Actual Practical set up used in laboratory:

VIl Required Resources /Apparatus/Equipment with specifications

Table 11.2 Required Resources

El(r)'. g‘sgggrimé Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208), On board +5V,
FPGA +3.3V, +2.5V supply to FPGA and other hardware circuit. On
1 Development | board, 2 Crystal 8MHz and 25MHz. JTAG Interface (Boundary | 1 No.
kit Scan ), PROM Interface (XCF02S), 40 pin, 4 header connector
for external 1/0's
2 | Desktop PC Personal computer v_vith latest configuration. anded with open- 1 No.
source IDE, simulation and program downloading software,
UPS and Antivirus.
IX  Precautions to be followed:

a.

Check the syntax / rules of VHDL Programming.

b. Do not power up the board before completing connections.

X Procedure

1.

2
3.
4.
5. Create New Source file. Select Source Type” select the Source type and give the name to the

o

7.

8.

Create the Xilinx ISE project for your expected FPGA design, by doing the following in ISE:
In the ISE software, select File > New Project.

In new project wizard, enter the project name and location, respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problemand Synthesize the .vhd file and view RTL
schematic.

Create Test Bench file- A test bench is HDL code that allows you to provide a documented,
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repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

9. Go to implementation to simulation tab , right click on main source file and create Test Bench
file for simulation.

10. In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure that
you didn’t make any syntax errors while making changes.

11. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the 1Sim
software with your test bench loaded.

12. ISim simulator window will open with your simulation executed, as shown in Fig. where you
are able to simulate your designs and check for errors.

13. After simulation implement it using FPGA development board.

14. Go to User Constraints — select Floorplan Area/lO/Logic (Plan Ahead) — Windows —
Properties
— now assign pin configuration and save.

15. Go to Implement Design — Run all.

16. Go to Generate Programming Fileand Run

X1 Actual Procedure (use blank sheet provided if space not sufficient)

XI1 Resources

Table 11.2 Resources

Sr. Name of Resource/Instrument e .
No. /Components Suggested Broad Specification Quantity
1.
2.

X111 Observation Table
Maharashtra State Board of Technical Education 107




VLSI Applications 316340

Table 11.3: Output of 2 Bit Comparator
Sr. no Al A0 Bl BO A>B A<B =B

O O N O O & W N -

[EEN
o

[EEN
[EEN

[EEN
N

[HEN
w

[EEN
N~

[EEN
($3]

[EEN
(o]

XIV Results (output of Program)

XVII Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
guestions so as to ensure the achievement of identified CO
more such questions so as to ensure the achievement of identified CO
1. Design VHDL Code using FPGA board for 1 bit counter using dataflow modeling.
2. Write VHDL Code for 4 comparator using structural modeling.
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[Space for Answer] (If required attach separate page)
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XVIIl  Suggested referencesfor further reading.

Sr
no Link/Portal Description
1 | http://vhsichdl.blogspot.com/2013/04/vhdl-code-for-comparator- Decoder tutorial
library-ieee.html
VHDL

2 | https://www.fpgadstudent.com/2017/08/vhdl-code-for-
comparator.html

3 https://www.tutorialspoint.com/visi_design/vhdl_programming_for | ISE Quick start

programming

combinational circuit.html tutorial

4 | http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction- VHDL tutorial
part-7.html

5 https://electronicstopper.blogspot.com/2017/07/2 bit compotator - VHDL
in-vhdl-with-testbench.html programming

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
1 | Coding ability 30%
2 Debugging ability 20%
3 Working with FPGA 10%
Product related (10 Marks) 40%(10)
4 Correct connections to FPGA Board 20%
5 Answer to sample questions. 15%
6 Timely Submission , Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related | Product Related Total
(15) (10) (25)
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VI

Practical No.12: Design up-counter on FPGA Board

Practical Significance
A counter is a device which stores the number of times a particular event or process has occurred, often
in relationship to a clock signal. There are two types of counters: a) up counters b) down counters.

This practical will help the students to develop programming skills i.e. up-counter application on
FPGA board using Xilinx ISE tools.

Industry/Employer Expected Outcome

The aim of this course is to attend following industry/employer expected outcome through various teaching
learning experiences:

“Develop VLSI-based electronic circuit/component using HDL.”

Course Level Learning outcome
CO-4 Develop VHDL program for given application.

Laboratory Learning Outcome
Interpret the output of MOD-10 Up counter using VHDL code.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

¢ Maintain tools and equipment.
e Follow ethical practices.

Relevant Theoretical Background
Up counter:-

Each of the higher-order flip-flops are made ready to toggle (both J and K inputs "high") if the Q
outputs of all previous flip-flops are "high." Otherwise, the J and K inputs for that flip-flop will both
be "low," placing it into the "latch” mode where it will maintain its present output state at the next
clock pulse. Since the first (LSB) flip-flop needs to toggle at every clock pulse, its J and K inputs are
connected to Vcc or VVdd, where they will be "high" all the time.
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High
] Q J Q J Q ] Q
Clock >Ck >Ck > Ck >Ck
K Q K Q K Q K Q
Qo Q Q, Q,

(a) Sequential Circuit

cock I LITLILLM UM uroro

Q, N S [ Y N M A A (O R Y e

Q —JI 11— I " °L_ I 1 __TI L

Q I L [ L

Q | L
(b) Timing Diagram

Fig. no. 12.1: Four bit up-counter and its timing diagram

VIl Circuit diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed (’ =\
circuit board 10-pin male header.) iy A
B C “>
. )
LED Color Description
Off Not connected or suspended Z ==
Blue Connected at 12MHz (USB full speed) . e
Teal Connected at 480MHz (USB high speed) 2 : =

Green JTAG port open, idle
Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

(4]

15 identify a particular cable, use the following JTAG command:

tagconfig --setparan able number> Identify <1 = on, 0 = off>

Fig. no.. 12.2.a: Practical Setup with JTAG CABLE
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®F Scientech 102A

i

Push Button Switch

@ &’

.

Loglic Output

®®2®O

Digital Input Output interface Board

Fig. no. 12.2.b: Lab Practical Setup

b) Create binary to Up-counter .vhd file diagram :-

& ISE Project Navigator (P.20131013) - F:\l SCHEMEVI SEM | SCHEME\UPCOUNTER\UPCOUNTERise - [UPCOUNTER 4BIT.vhd] - %
[2) File Edit View Project Source Process Tools Window Layout Help -&x
D2EHIPIE| % Xwa| i 2L2RRARIA ZEDIZLRIPELQ
| Design o088 X E[ 22 o~
[ |Vew: @ 18} mplementation O [ simulation $=| 23 entity UPCOUNTER 4BIT is
| T — 1=| 214 Port ( CLK : in STD_LO
] [ Hierarchy 25 RESET : in STD_LOGIC;
] UPCOUNTER ® 26 Q : out STD_LOGIC VECTOR (3 downto 0));
£ £3 xc3550-5pq208 27 end UPCOUNTER 4BIT;
[l UPCOUNTER 4BIT - Behavioral (UPCOUNTE| 28
9 29 architecture Behavioral of UBCOUNTER 4BIT is
—| 30
A| 31 signel g tmp: std logic_vector(3 downto 0):= "0000";
| 32
% 33 begin
Al 34 process (CLX, RESET)
%| ss
< rlg 36 begin
rop a @ = if RESET = '1' then
; ) NoProcesses Running o| 3¢ oemp <= 7000175
74 | Processes: UPCOUNTER 4BIT - Behavioral Al—| 39 elsif R»s(;?-‘-’ =d'§e(C”§é)““e“
) - 40 q_tmp q_tmp H
@¢| £ Design Summary/Reports s Thap (2) rmp (1) »
%% 8 | 2
% gl Seﬂgc" Uts't"t'es‘ 42 g_tmp(3) <= g _tmp(2);
=g = 43 g_tmp(0) <= g_tmp(3);
m|F d if;
View RTL Schematic :: en::ﬂ;ess_
%  View Technology Schematic e 6 4= q tups
€)  Check Syntax 5 =
¥)  Generate Post-Synthesis Simulation M... el aviorat;
i 8@ Implement Design e ‘ v
T)  Generate Programming File
G2 Confinues Tarnat Devi ¥ < _ 2
& Stat G Desgn ) Fies [D) Lbraries E Design Summary (Synthesized) UPCOUNTER _4BIT.vhd a|
Console o08x
~
Process "Synthesize - XST" completed successfully
v
< >

[Z consde €@ Emors f\ Wamings (2§ Findin FiesResits

Fig. no.. 12.3: .vhd file diagram
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c) Create binary to Up-counter test bench file-

& ISE Project Navigator (P.20131013) - FAl SCHEME\VI SEM | SCHEME\asynchupcont\asynchupcont.ise - [COUNTER_TB.vhd] - X
[2) Fle Edit View Project Source Process Tools Window Layout Help -lax
oa X 0o » B X R mem=ieipc L
Design had =l RS €5 Clock => Clock, ~l
view: O 8} Implementation @) & Simulation €€ CLR => CLR,
Behavioral v 67 Q:=%:Q

Hierarchy c s

8] asynchupcont 70 -- Clock pri n
pq208 71 Clock process :process

(COUNTER_TB.vhd) [fil 72 begin

uut - counter - archi (asynchupcount.vhd) 73 Clock <=
74 wait for
75 Clock
76 wait for
77 end process;

o | B9 i
A
&

or;

lock period/2;
1%
lock period/2;

DO |¥FEFE
@
=)

€2 No Processes Running

»

4. | Processes: COUNTER_TB - behavior 82
£ |23  1Sim Simulator 33
A

€2 Behavioral Check Syntax
B8 Simulate Behavioral Model

wait for Clock period*10:

|
CLR <= '0'; ‘

wait;
end process; v

wwwoooo
N OoWw® a0

& Strt ©3 Desgn ) Fies [[) Libraries asynchupcount.vhd % Design Summary (Implemented) B COUNTER_TB.vhd

Console <08 X
ISim simulation engine GUI launched successfully ~

Process "Simulate Behavioral Model" completed successfully

\(éj Console @ Erors 1\ Warnings (g8 Findin Files Results :
Fig. no. 12.4: test bench file diagram
d) binary to Up-counter test bench Simulation waveforms-
5 [5im (P.20131013) - [Defauttwefg) = X
;F\Ie Edit View Simulation Window Layout Help -8 X

OPE|L $BEX®naME! 1O RBEDR SN[ 2202
4

T dock
T ar

[

Y

y = | B OO W W Y

il

X1: 1,105,906 ns

< H
E Default. wefg

=2

Fig. no.. 12.5: Simulation diagram
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e) Actual practical set up used in laboratory

V111l Required Resources/apparatus/equipment with specifications

Table 12.1 Resources

Sr.
No

Instrument/

Components Specification Quantity

Device: Xilinx FPGA (XC3S400 PQ208),0n board 1 No.
+5V, +3.3V, +2.5V supply to FPGA and other
hardware circuit.,On board, 2 Crystal 8MHz and
25MHz.JTAG Interface ( Boundary Scan ),PROM
Interface (XCF02S),40 pin, 4 header connector for
external 1/O's

FPGA Development kit

Personal computer with latest configuration. Loaded
with open-source IDE, simulation and program
downloading software, UPS and Antivirus.

Desktop PC 1 No.

IX Precautions to be followed

1.
2.
3.

Use proper Mains cord.
To avoid fire or shock hazards, observe all ratings and marks on the instrument.
Check syntax / rules for VHDL programming.

X Procedure

1.

w

Create the Xilinx ISE project for expected FPGA design, by doing the following in ISE: In the
ISE software, select File > New Project.

In new project wizard, enter the project name and location, respectively. Select HDL or
Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and Synthesize the .vhd file and view RTL schematic.
Ref Fig no.11.3.

. Create Test Bench file- A test bench is HDL code that allows to provide a documented,

repeatable set of stimuli that is portable across different simulators. A test bench can be as simple
as a file with clock and input data or a more complicated file that includes error checking, file
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input and output, and conditional testing.

. Go to implementation to simulation tab , right click on main source file and create Test Bench
file for simulation.

. In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure that
didn’t make any syntax errors while making changes.

Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the ISim
software with r test bench loaded.

. ISim simulator window will open with simulation executed, as shown in Ref Fig where able
to simulate designs and check for errors.

10. After simulation implement it using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows —

Properties —now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per

practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC And select

Program.

SAMPLE PROGRAM 1: Step 1.Develop VHDL code for Up-counter

VHDL Code using When statement

library IEEE;
use ieee.std_logic_1164.all;
use ieee.std_logic_unsigned.all;

entity counter is
port(Clock, CLR :in std_logic;
Q:outstd_logic_vector(3 downto 0));
end counter;

architecture archi of counter is
signal tmp: std_logic_vector(3 downto 0);

begin
process (Clock, CLR)
begin
if (CLR="1") then
tmp <="0000";
elsif (Clock'event and Clock="1") then
tmp <=tmp + 1,
end if;
end process;

Q <=tmp;
end archi;
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Step 2: Develop Test Bench file for simulation.

VHDL Code
LIBRARY ieee;

USE ieee.std_logic_1164.ALL;
ENTITY COUNTER_TB IS
END COUNTER_TB;

COMPONENT counter
PORT(

Clock : IN std_logic;

CLR: IN std_logic;
Q: OUT std_logic_vector(3 downto 0)
);
END COMPONENT;

signal Clock : std_logic :='0";

signal CLR : std_logic :='0;

--Outputs
signal Q : std_logic_vector(3 downto 0);

-- Clock period definitions
constant Clock_period : time := 10 ns;

BEGIN

uut: counter PORT MAP (
Clock => Clock,

CLR =>CLR,
Q=>Q

);

-- Clock process definitions
Clock_process :process
begin
Clock <=0
wait for Clock_period/2;
Clock <="1"
wait for Clock_period/2;
end process;
-- Stimulus process
stim_proc: process
begin
-- hold reset state for 100 ns.
wait for 100 ns;

ARCHITECTURE behavior OF COUNTER_TB IS

-- Instantiate the Unit Under Test (UUT)

Maharashtra State Board of Technical Education

117



VLSI Applications 316340

walit;
end process;
END;

CLR <="0}

wait for Clock_period*10;

CLR <="0}

Problem statement for student: Design VHDL Code for up counter using case statement.

Step 1.Develop VHDL code for Up-counter

VHDL Code

Maharashtra State Board of Technical Education

118



VLSI Applications 316340

Step 2: Develop Test Bench file for simulation.

VHDL Code

Xl Resources

Sr. No.

Instrument /Components

Specification

Quantity
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XI1 Actual Procedure Followed (use blank sheet provided if space not sufficient)

XII1 Observations (use blank sheet provided if space not sufficient)

Truth table of Binary up counter is (verified/ not verified) using FPGA development board.

XIV Result (Output of the Program)

XV Interpretation of Results (Give meaning of the above obtained results)

XVI1 Conclusions and Recommendation (Actions/decisions to be taken based on the
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interpretation of results)

XVIl  Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
guestions so as to ensure the achievement of identified CO

1. Design VHDL Code using FPGA board for Binary Down-counter.
2.Write VHDL code for 4 bit up-down counter using if else statement.
[Space for Answers] (If required attach separate page)
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XVIIl  Suggested referencesfor further reading

Sr no. Link/Portal Descriptio
n

4 bit binary
counter tutorial

1 https://www.pantechsolutions.net/vhdl-code-to-simulate-4-bit-binary-
counter-by-software-using-spartan-3-starter-kit

VHDL
programming
ISE Quick start
tutorial

4 https://www.geeksforgeeks.org/differences-between-synchronous- VHDL tutorial
and-asynchronous-counter/

2 https://www.Xilinx.com/support/documentation/data sheets/ds610.pdf

3 https://forums.xilinx.com/

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
Coding and Debugging ability 30%
Making connections of hardware 20%
Follow ethical practices. 10%
Product related (10 Marks) 40%(10)
Correctness of algorithm/ Flow chart 20%
Relevance of output of the problem definition. 15%
Timely Submission , Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related Product Related Total (25)
(15) (10)
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Practical No. 13: Design synchronous counter on FPGA board.

Practical significance

In Synchronous Counter all the individual output bits changing state at exactly the same time in
response to the common clock signal with no ripple effect and therefore, no propagation delay in the
system. Synchronous Counter, the external clock signal is connected to the clock input of every
individual flip-flop within the counter so that all of the flip-flops are clocked together simultaneously
(in parallel) at the same time. In other words, changes in the output occur in “synchronization” with the
clock signal. This practical will help the students to develop programming skills that is up/down
synchronous counter application on FPGA board using Xilinx ISE tools.

Industry/Employer Expected outcome
The aim of this course is to attend following industry/employer expected outcome through various
teaching learning experiences:

“Develop VLSI-based electronic circuit/component using HDL”.

. Course Level Learning outcome(s)
CO-4 Develop VHDL program for given application.

IV. Laboratory Learning Outcome(s)

V.

VI.

Develop VHDL code for 4-bitUp/Down Synchronous counter and test the circuit on FPGA board

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.

e Follow ethical practices.

Relevant Theoretical Background :
In Asynchronous binary counter the output of one counter stage is connected directly to the clock input
of the next counter stage and so on. The result of this is that the Asynchronous counter suffers from
what is known as “Propagation Delay” in which the timing signal is delayed a fraction through each
flipflop. The solution over this problem is synchronous counter. In synchronous counters, the clock
inputs of all the flip-flops are connected together
and are triggered by the input pulses. There are two types of counter :
1. Up counter
2. Down counter.
As well as counting “up” from zero and increasing or incrementing to some preset value, it is
sometimes necessary to count “down” from a predetermined value to zero allowing us to produce an
output that activates when the zero count or some other preset value is reached.
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Table 13.1: Truth table of Up / down Synchronous counter.

CLK'/UP DOWN| Q3 | Q2 | Q1 | Q0 | UPDOWN | Q3 | Q2 | Q1 | QO
event
1 1 0 0 0 0 0 1 1 1 1
1 1 0 0 0 1 0 1 1 1 0
1 1 0 0 1 0 0 1 1 0 1
1 1 0 0 1 1 0 1 1 0 0
1 1 0 1 0 0 0 1 0 1 1
1 1 0 1 0 1 0 1 0 1 0
1 1 0 1 1 0 0 1 0 0 1
1 1 0 1 1 1 0 1 0 0 0
1 1 1 0 0 0 0 0 1 1 1
1 1 1 0 0 1 0 0 1 1 0
1 1 1 0 1 0 0 0 1 0 1
1 1 1 0 1 1 0 0 1 0 0
1 1 1 1 0 0 0 0 0 1 1
1 1 1 1 0 1 0 0 0 1 0
1 1 1 1 1 0 0 0 0 0 1
1 1 1 1 1 1 0 0 0 0 0
Note: UP_DOWN =1 UP counter
UP_DOWN =0 DOWN counter
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Fig. no.. 13.1: Four-bit Up counter timing waveform.

VII. Suggested circuit diagram used in Laboratory with related equipment rating.
a) Suggested Practical JTAG cable setup: -

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

1)

Fig. 13.2.a: Practical Setup with JTAG CABLE
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& Scientech 102A

Logle Output

R R

Logic Input

Digital Input Output \nterface Board

Fig. no.. 13.2.b: Lab Practical Setup

b) Create 4 bit Up/down counter .vhd file :-

& |SE Project Navigator (P.20131013) - F:A\l SCHEME\NEWUP_DOWN_SYNC\NEWUP_DOWN_SYNC xise - [counter_up_down_sync.vhd]

@ File Edit View Project Source Process Tools Window Layout Help

D2H ADDBX[0a| »if
[Desen »O8X
[ | View: O 18} mplementation @ [ Simulation
& Behavioral v
(| Hierarchy
& NEWUP_DOWN_SYNC
5 €1 xc35400-5pq208
behavior (NEWUP_
Arieh ') uut- counter_up_down_sync - archi (count]
@
< >
P | T) NoProcesses Running
Processes: NEWUP_DOWN_SYNC_TB - behavior
P02 % 1Sim Simulator
= €)  Behavioral Check Syntax
% [ Simulate Behavioral Model
Console

OO ¥ ¥ ¥ 3|

z

<

JpINFO:ProjectMgmt - Parsing design hierarchy completed successfully.

X
=& x
BRABIAZEDIZ;ERIPEL:?
1 library ieee; A
2 use ieee.std_.
3 use ieee.std_. igned.all;
4
5 entity counter_up_down_sync is
3 port(
7 CLK, CLR, UP_DOWN : in std_logic:
8 Q : out std_logic_vector(3 downto 0));
9
10 end counter_up_down_sync;
11
12 architecture archi of counter_up_down_sync is
13
14 signal tmp: std_logic_vector (3 downto 0);
15
16 begin
17
18 process (CLK, CLR)
19 begin
20
21 if RISING_EDGE (CLK) then
22
23 if (CLR='1') then
24 tmp <= "0000";
25
26 elsif (UP_DOWN='1l') then
27 tmp <= tmp + "0
28 ELSE tmp <= tmp -
29 end if;
an A
< >
Design Summary (Synthesized) X counter_up_down_sync.vhd g_l 2 Newup_DowN_SYNC_TB.vhd*
} i - ) ) i } <08 X
A
v
>

Console o Errors _!3 Warnings

Fig. no.. 13.3: .vhd file
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¢) Create 4 bit Up/down counter test bench file-

_ ISE Project Navigator (P.20131013) - F:\l SCHEME\NEWUP_DOWN_SYNC\NEWUP_DOWN_SYNC.xise - [NEWUP_DOWN_SYNC_TB.vhd"] - X
[2) File Edit View Project Source Process Tools Window Layout Help -5
D2EPF %] % V|l HAPLPRARARIA TEDIS LR PESL
Design w08 x| & 71 ~
view: O {8} implementation Simulation 5 72
Behavioral % 73 _period/2;
74
Hierarchy " 75 _period/2;
] NEWUP_DOWN_SYNC 76 end process;
& £3 xc3s400-5pq208 77
& = [ NEWUP_DOWN_SYNC_TB - behavior (NEWUP_| 78
uut - counter_up_down_sync - archi (count{ 79
A 80
% 81
o 82 100 n
= 83
84
85
7y 5 & 86
87 clrc= '1’;
» | #) NoProcesses Running 88
= 89
P4, | Processes: NEWUP_DOWN_SYNC_TB - behavior 90
£ |2 % Isim Simulator 91 |
= T)  Behavioral Check Syntax 92
i B Simulate Behavioral Model a3 UP_DOWN <=
— 94 wait;
95
96 end process;
97
98 END;
99 |
v
< > ‘
| = Design Summary (Synthesized) Bl counter_up_down_sync.vhd B NEWUP_DOWN_SYNC_TB.vhd* %]
Console 08 x
|3 INFO:ProjectMomt - Parsing design hierarchy completed successfully. Al
i |
< > ‘
[E consoe @ Erors 1\ warnings
£ ISim (P.20131013) - [Defaultwcfg] - X
[ File Edit View Simulation Window Layout Help
O3 d ¥ X® 9o |dmx EEM AR ALB AR et B b Loos] (3 Re-launch
18 ck_period
Default.wcfg %]
Console 08X
WARNING: Please use Xiinx License Configuration Manager to check out a full ISim license. A

WARNING: 1Sim will run in Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version,

This is a Lite version of 15im.

Time resolution is 1 ps

Simulator is doing circuit initislization process,

Finished circuit initialization process,

at 5ns(1), Instance fnewup_down_sync_tbjuut/ : Warning: There is an 'U'|X'[W'| Z [ in an arithmetic operand, the result will be "X'(es).

I5im> A

B Console j CompiationLlog @ Breskpoints 4 FindinFilesResults  [gy Search Results

Fig. no..13.5: Simulation output
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e) Actual practical set up used in laboratory

VIII. Required Resources/apparatus/equipment with specifications
Table 13.2 Required Resources
Sr Instrument
NO‘ /Component Specification Quantity
S
FPGA Device: Xilinx FPGA (XC3S5400 PQ208),0n board
1 | Devel N +5V, +3.3V, +2.5V supply to FPGA and other hardware 1N
' evelg?men circuit., On board, 2 Crystal 8MHz and 25MHz.JTAG 0.
: Interface ( Boundary Scan ),PROM Interface
(XCF02S),40 pin, 4 header connector for external 1/0's
. . . . 2 No.
2 Deskton PC Personal computer with latest configuration. Loaded with open-
P source IDE, simulation and program downloading software,
UPS and Antivirus..
IX. Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.
X.  Procedure

1. Create the Xilinx ISE project for top-level FPGA design, by doing the following in ISE:In the
ISE software, select File > New Project.
2. In the Project name and Project location fields, enter the project name and location,

respectively. Select HDL or Schematic as the Top-level source type, and click Next.
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3. Create New Source file. Select Source Type” select the Source type and give the name to the source
then click “Next”.

4. Define Module”. Enter the entity used in design and then click “Next”.

5. Develop VHDL code for given problem and Synthesize the .vhd file and view RTL schematic.
Ref Fig no.13.3.

6. Create Test Bench file- A test bench is HDL code that allows to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing. Ref Fig no.13.4.

7. Go to implementation to simulation tab , right click on main source file and create Test Bench
file for simulation.

8. Inorder to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioural Check Syntax” to make sure
that didn’t make any syntax errors while making changes.

9. Double click on “Simulate Behavioural Model” in the “Process Pane”, which will
open the I1Sim software with r test bench loaded.

10. ISim simulator window will open with simulation executed, as shown in Ref Fig no.13.5.
where able to simulate designs and check for errors.

11. After simulation implement counter using FPGA development board.

12. Go to User Constraints — select Floorplan Area/lO/Logic (Plan Ahead) — Windows —
Properties— now assign pin configuration and save.

13. Go to Implement Design — Run all.

14. Go to Generate Programming File and Run

15. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per

practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC And select
Program.

SAMPLE PROGRAM 1: Step 1. Develop VHDL code for 4 bit Up/down synchronous counter

VHDL Code using When statement

LIBRARY ieee;
USE ieee.std_logic_1164.all;
USE ieee.std_logic_unsigned.all;

ENTITY counter_up_down_syncis

port (

CLK, CLR, UP_DOWN: in std_logic;

Q : out std_logic_vector(3 downto 0));

end counter_up_down_sync;

architecture archi of counter_up_down_sync is
signal tmp: std_logic_vector(3 downto 0);
begin

process (CLK, CLR)
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begin

if RISING_EDGE(CLK) then
if (CLR="1") then

tmp <= "0000";
elsif (UP_DOWN="1") then

tmp <= tmp + "0001";

else tmp <=tmp - "0001";
end if;
end if;

end process;
Q <= tmp;

end archi;

Step 2: Develop Test Bench file for simulation

VHDL Code

LIBRARY ieeg;
USE ieee.std logic_1164.ALL;

ENTITY NEWUP_DOWN_SYNC_TB IS

END NEWUP_DOWN_SYNC_TB;

ARCHITECTURE behavior OF NEWUP_DOWN_SYNC_TB IS
-- Component Declaration for the Unit Under Test (UUT)

COMPONENT counter_up_down_sync
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PORT(

CLK:IN

std_logic; CLR :

IN std_logic;

UP_DOWN : IN std_logic;

Q : OUT std_logic_vector(3 downto 0)

);
END COMPONENT;
--Inputs

signal CLK : std_logic

:='0"; signal CLR :

std_logic :='0;

signal UP_DOWN : std_logic :='0
--Outputs

signal Q : std_logic_vector(3 downto 0);
-- Clock period definitions

constant CLK_period : time := 10 ns;

BEGIN

-- Instantiate the Unit Under Test
(UUT) uut: counter_up_down_sync
PORT MAP ( CLK => CLK,
CLR =>CLR,

UP_DOWN =>

UP_DOWN, Q=>Q

);

-- Clock process

definitions

CLK _process

‘process begin

CLK <="0,

wait for CLK _period/2;
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CLK <=1,

wait for CLK_period/2;
end process;

-- Stimulus process
stim_proc: process
begin

-- hold reset state for 100 ns.
wait for 100 ns;

wait for CLK_period*10;
clr<="1"

wait for 100 ns;

clr<="0"

wait for 1000 ns;
UP_DOWN <="1"

wait for 100 ns;
UP_DOWN <="1";

wait;

end process;

END;

Problem statement for student: Design VHDL Code for 3 bit up/down synchronous counter
using if else statement logic gates etc.

Step 1.Develop VHDL code for 3 bit up/down synchronous counter

VHDL Code
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Step 2: Develop Test Bench file for simulation.

VHDL Code
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XI. Resources

Table 13.3 Resources
Sr. No. Instrument /Components Specification Quantity
1.
2.
3.

XIl. Actual Procedure Followed (use blank sheet provided if space not sufficient)
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XI11. Observations (use blank sheet provided if space not sufficient)
Truth table of up/down synchronous counter is (verified/ not verified) using FPGA
development board.

XIV. Result (Output of the Program)

XVI. Conclusion and Recommendation (Actions/decisions to be taken based on the Interpretation
of results)

XVII. Practical Related Questions

Note: Below given are few sample questions for reference. Teacher must design more such questions
S0 as to ensure the achievement of identified CO

1. Design VHDL Code using FPGA board for 3 Bit Binary Down-counter.

[Space for Answers] (If required attach separate page)
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XVII11. Suggested referencesfor further reading

Sr no. Link/Portal Description

https://www.pantechsolutions.net/vhdl-code-to-simulate- Synchronous

1 4-bit-binary-counter-bysoftware- using- spartan-3-starter- | counter tutorial
kit

2 https://circuitdigest.com/tutorial/synchronous-counter. VHDL programming

3 https://forums.xilinx.com/ ISE Quick start tutorial

4 | https://www.geeksforgeeks.org/differences-between- VHDL tutorial
synchronous-andasynchronous-

XIX. Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
4. | Coding and Debugging ability 30%
5. | Making connections of hardware 20%
6. | Working with FPGA. 10%
Product related (10 Marks) 40%(10)
7. | Correctness of algorithm/ Flow chart 20%
8. | Relevance of output of the problem definition. 15%
9. | Timely Submission of report, Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related | Product Related Total
(15) (10) (25)
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VI

Practical No. 14: Design Binary to Gray code converter using FPGA board

Practical Significance

Binary Number is normally used number system in digital electronics. In many applications coding is
essential and for the purpose variation in binary number system is required. For such applications excess-3,
gray code and other coding methods are used. The Gray code was originally designed to prevent undesired
transient states or outputs from electro- mechanical switches. Today, this code is used to facilitate error
correction in digital communications and instrumentation This practical will help students to develop
programming skills i.e. Binary to Gray code converter application on FPGA board using Xilinx ISE tools.

Industry Relevant/Employer Expected Outcome
The aim of this course is to attend following industry/employer expected outcome through various teaching learning
experiences:
“Develop VLSI-based electronic circuit/component using HDL”.

Course Level Learning Outcome
CO-4 - Develop VHDL program for given application.

Laboratory Learning Outcome
LLO 14.1 Test the functionality of 4-bit binary to gray code converter and Synthesize using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.

e Follow ethical practices.

Relevant Theoretical Background

Gray Code system is a binary number system in which every successive pair of numbers differs in only one
bit. It is used in applications in which the normal sequence of binary numbers generated by the hardware may
produce an error or ambiguity during the transition from one number to the next.

For example, the states of a system may change from 3(011) to 4(100) as- 011 — 001 — 101 — 100. Therefore
there is a high chance of a wrong state being read while the system changes from the initial state to the final
state.

This could have serious consequences for the machine using the information. The Gray code eliminates this
problem since only one bit changes its value during any transition between two numbers

Gray code equivalent of the given binary number is computed as follows:

03=Db3

g2 =b3 XOR b2
gl =b2 XOR bl
g0 =bl1 XOR b0

A binary to gray code converter can be implemented using XOR gates. For n input, n-1 gates are required.
As shown in the image below for 4 inputs, 3 XOR gates are used:
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Table 14.1: Truth table of Binary to Gray code conversion.

Binary Gray Code

B3 Gj bz | bz | by | bo g3 | 22 | 21 | 20
O O O 0] 0 O 0O L8]

O O 0] 1 O O 0 1

G O o0 | 1| o0 O | o | 1 | 1

52 2 0 0 1 1 0 0 1 0
O 1 0] 0] 0 1 1 8]

O 1 0] 1 0 1 1 1

O 1 1 O O 1 O 1

G O 1 1 1 0 1 0 L8]

B1 1 1] 0] 0] O 1] 1] 0O
1 O O 1 1 1 ] 1

1 O 1 O 1 1 1 1

1 O 1 1 1 1 1 8]

1 1 0] 0] 1 O 1 8]

GI] 1 1 O 1 1 O 1 1

Bl] 1 1 1 0 1 0 ) 1
1 1 1 1 1 O O L8]

Fig. no.. 14.1: Binary to Gray code conversion.

V11 Circuit diagram used in laboratory with related equipment rating.
a) Suggested Practical JTAG cable setup: -

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

1

" To identify a particular cable, use the following JTAG command:

tagconfig --setparar able number> Identify <1 = on, 0 = off>

Fig. no.. 14.2.a: Practical Setup with JTAG CABLE
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& Scientech 102A

Logic Output

"TER ERE

Digital Input Output Interface Board

Fig. no. 14.2.b: Lab Practical Setup

b) Create binary to gray code converter .vhd file diagram :-

& ISE Project Navigator (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\BINTOGRAY\BINTOGRAY.xise - [binary_2_gray.vhd] X
[2) File Edit View Project Source Process Tools Window Layout Help & x
DAHP Ly DbXx[va| Jrrx ,RR[ma0c[sRPEL[Q
|pesion c08Xx| & 1 1library IEEE;
(5] | View: @ 483} implementation O [ Simulation 2 wuse IEEE.STD_LOGIC_1164.ALL;
T 3 use IEEE.STD_LOGIC ARITH.ALL;
ol | Hierarchy E 4 use IEEE.STD LOGIC_UNSIGNED.ALL;
@l 8] BINTOGRAY ~= 5
== | & €3 xc3s400-5pq208 = 6
Fh| [ binary 2 gray - gate level (binary_2_grayvhy 7 entity binary 2 gray is
= 2 8 porc(
& - 9 bin : in std logic_vector(3 downto 0); --binary input
Al 10 G : out std logic_vector(3 downto 0) --gray code output
| 11
b 12 yi
- A 13
» 14 end binary 2 gray:
< - > 6 15
16 architecture gate_level of binary 2 gray is
> | €2 NoProcesses Running o v = -
P41 | Processes: binary_2_gray - gate level Af— i; SRR
% ] DsngnSummary/Repons 20 ——XOr gates.
2 9 g e 21 G(3) <= bin(3);
| = Sl | 22 G(2) <= bin(3) xor bin(2):
B R 23 G(1) <= bin(2) xor bin(1);
| e ematic — 24 G(0) <= bin(l) xor bin(0):
i View Technology Schematic 5
- 8)  Check Syntax o .
-®)  Generate Post-Synthesis Simulation M... |- 5
@ 8)  Implement Design
- T)  Generate Programming File
GLER  Cooki .t Nevi bt _ 2.
& Start B3 Design A3 Fles [ Libraries [= binary_2_gray.vhd <115 binary_2_gray (RTL1) (x]]
| View by Category ~08 x|
Design Objects of Top Level Block Properties: (No Selection)
Instances ~ ||Ppins ~ || signals 4 | [ Name v Value

& binary_2_gray

[El console @ Emors \ Wamings [ FindinFiesResults (5 View by Category

H o Type here to search

Fig. no. 14.3: .vhd file diagram

Ln 23 Col27 VHDL

Maharashtra State Board of Technical Education

140



VLSI Applications (316340)

c) Create binary to gray code converter test bench file-

& SE Project Navigator (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\BINTOGRAY\BINTOGRAY xise - [BINTOGRAY_TB.vhd*] = X
iﬂ File Edit View Project Source Process Tools Window Layout Help
BELCT:) ; A rED sRIPESL
Design #0848 X 65 G=>G 7
View: () {8} Implementation (@) @S\mu\anon 66 Vi
r;J Behavioral v 67
= 68
(7% | Hierarchy éa
dl g
5] BINTOGRAY 70
=] xc35400-5pq208 71
;] = m BINTOGRAY_TB - behavior (BINTOGRAY_TB.vh 12
& [ uut - binary_2 gray - gate level (binary 2_g 13
] A 74
€ 75
v (< > 7%
B Find: v| A 71
18
Type: | Missing Module | (] Options e
v 0

P ) NoProcesses Running

Dt Processes: BINTOGRAY_TB - behavior 82
% . 83
- ’gg 1Sim Simulator 84
Behavioral Check Syntax ¥
By 9, kbl Ml 85
I teteBoniadneldoedladidonsd G | 86
m 87
8
90 bin <
91 wait for 100 ns;
92 b
< >
& Start B3 Design ) Files D Libraries Z Design Summary l;j binary_2_gray.vhd ;h BINTOGRAY_TB.vhd* [%]
Console «+08 X
@ ERROR: ProjectMgmt - 4 error(s) found while parsing design hierarchy. Al
Started : "Launching ISE Text Editor to edit BINTOGRAY TB.vhd".
v
< >

[E] console © Eros 1\ Wamings 3§ FindinFlesResuits

Fig. no. 14.4: test bench file diagram
d) binary to gray code converter test bench Simulation waveforms-

&4 (Sim [P20131003)- [Defautowchy’]

jFile Bt View Smulation Window lajout Help

OAH G sBEX0 00| b

RAGESN AP ;n:/n_ Y h Hg;,g Line v| g ||| GRedand

Ty

Fig. no. 14.5: Simulation diagram

Maharashtra State Board of Technical Education 141



VLSI Applications (316340)

e) Actual Experimental set up used in laboratory

VIl Resources Required
Table 14.1 Resources

Sr. | Instrument/ R .
No. | Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board

+5V, +3.3V, +2.5V supply to FPGA and other

1 EZSQO ment hardware circuit.,On board, 2 Crystal 8MHz and 1 No
Kit P 25MHz.JTAG Interface ( Boundary Scan ),PROM '
Interface (XCF02S),40 pin, 4 header connector for
external 1/O's
2 | Desktop PC Loaded with open source IDE, simulation and 1 No.

program downloading software.

IX  Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

X Procedure
1. Create the Xilinx ISE project for top-level FPGA design, by doing the following in ISE:
a. Inthe ISE software, select File > New Project.
b. In the Project name and Project location fields, enter the project name and location,
respectively.
c. Select HDL or Schematic as the Top-level source type, and click Next.

2. Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.

3. Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view RTL schematic.
Ref Fig no.13.3.

5. Create Test Bench file- A test bench is HDL code that allows to provide a documented, repeatable
set of stimuli that is portable across different simulators. A test bench can be as simple as a file
with clock and input data or a more complicated file that includes error checking, file input and
output, and conditional testing. Ref Fig no.13.4.
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6. Go to implementation to simulation tab , right click on main source file and create Test Bench file

for simulation.

7. In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure that

didn’t make any syntax errors while making changes.

8. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the ISim

software with test bench loaded.

9. ISim simulator window will open with simulation executed, as shown in Ref Fig no.13.5. where

are able to simulate designs and check for errors.
10. After simulation implement it Using FPGA development board.

11. Go to User Constraints — select Floorplan Area/lO/Logic (PlanAhead) — Windows — Properties

now assign pin configuration and save.
12. Go to Implement Design — Run all.
13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per practical

Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC And select Program.

SAMPLE PROGRAM :: Step 1.Develop VHDL code for Binary to Gray conversion
VHDL Code using When statement

library IEEE;
use IEEE.STD_LOGIC 1164.ALL;

entity ENCODER8TO3 is
Port (a:in STD_LOGIC _VECTOR (7 downto 0); b
sout STD_LOGIC_VECTOR (2 downto 0));
end ENCODERS8TO3;

architecture Behavioral of ENCODERSTO3 is begin
process(a)

begin case

ais

when "00000001" => b <="000";
when "00000010" => b <="001";
when "00000100" => b <="010";
when "00001000" => b <="011";
when "00010000" => b <="100";
when "00100000" => b <="101";
when "01000000" => b <="110";

when "10000000" => b <="111";
when others => b <="77Z7"; end

case;
end process;

end Behavioral;

Maharashtra State Board of Technical Education

143



VLSI Applications (316340)

Step 2: Develop Test Bench file for simulation.

VHDL Code
LIBRARY ieee;
USE ieee.std_logic_1164.ALL;

ENTITY ENDCODERSTO3_TBIS
END ENDCODERSTO3_TB;

ARCHITECTURE behavior OF ENDCODERS8TO3_TBIS
-- Component Declaration for the Unit Under Test (UUT)

COMPONENT ENCODERSTO3

PORTY(
a:IN std_logic_vector(7 downto 0);
b : OUT std_logic_vector(2 downto 0)

);
END COMPONENT;

--Inputs
signal a : std_logic_vector(7 downto 0) := (others =>'0);

--Outputs
signal b : std_logic_vector(2 downto 0);
-- No clocks detected in port list. Replace <clock> below with
-- appropriate port name

BEGIN

uut: ENCODER8TO3 PORT MAP (
a=>a,

b=>b

);

-- Stimulus process
stim_proc: process
begin

-- hold reset state for 100 ns.
wait for 100 ns;

a <="00000001";
wait for 100 ns;
a <="00000010";
wait for 100 ns;

a <="00000100"
wait for 100 ns;
a <="00001000";

wait for 100 ns;
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a <="00010000";

wait for 100 ns;

a <="00100000";

wait for 100 ns;

a <="01000000";

wait for 100 ns;

a <= "10000000";

wait;

end process;
END;

Problem statement for student: Design VHDL Code for Gray to Binary encoder using if else statement
logic gates etc.

Step 1: Develop VHDL code for Binary to Gray conversion.
| VHDL Code using Dataflow method statement

Step 2: Develop Test Bench file for simulation.
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VHDL Code

Xl Resources

Sr.
No.

Instrument /Components

Specification

Quantity

1

2

3

X1l Actual Procedure Followed (use blank sheet provided if space not sufficient)
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XI11 Observations (use blank sheet provided if space not sufficient)

Truth table of Binary to Gray is (verified/ not verified) using FPGA development board.

XIV Result (Output of the Program)

XV Interpretation of Results (Give meaning of the above obtained results)

XVI Conclusions and Recommendation

XVIlI  Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO

1.Write VHDL Code using FPGA board for Gray to Binary using When statement.
2.Write VHDL Code using FPGA board for Gray to Binary using Dataflow method statement.

[Space for Answers] (If required attach separate page)
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XVII  Suggested references for further reading
Sr .
Link/Portal
no.

Description

1 https://www.intel.com/content/dam/www/programmable/us/en/p
dfs/literature/ug/ug usb blstr ii cable.pdf

VHDL programming

2 https://www.Xilinx.com/support/documentation/data sheets/ds61

0.pdf

EDA Tool

3 https://forums.xilinx.com/

ISE Quick start tutorial

4 https://www.geeksforgeeks.org/digital-logic-code-converters-
binary-gray-code/

VHDL tutorial

XIX Assessment Scheme

The given performance indicators should serve as a guideline for assessment regarding process and

product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%(10)
4 | Correctness of algorithm/ Flow chart 20%
5 Relevance of output of the problem definition. 15%
6 Timely Submission , Answer to sample questions. 05%
TOTAL 100% (25)
Marks Obtained Dated signature of Teacher
Process Related Product Related Total
(15) (10) (25)
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Practical No. 15: Design Digital to Analog code converter (DAC)using FPGA board

I Practical Significance
In the real world, most of the data are available in analog form. There are two types of electronic
converters namely Analog to Digital converter(ADC) and Digital to Analog converter (DAC). While
manipulating the data, these two converting interfaces are essential. This practical will help the students
to develop programming skills to Build / Test DAC application on FPGA board using Xilinx ISE tools.

Il Industry/Employer Expected Outcome
The aim of this course is to attend following industry/employer expected outcome through various teaching
learning experiences:
“Develop VLSI-based electronic circuit/component using HDL”.

111 Course Level Learning outcome
CO-4 Develop VHDL program for given application.

IV Laboratory Learning Outcome
LLO 15.1 Develop VHDL code for 8 -bit Digital to Analog converter and test the circuit using FPGA
board.

V Relevant Affective domain related Outcomes
e Follow safe practices.

¢ Maintain tools and equipment.
e Follow ethical practices.

VI Relevant Theoretical Background
Digital to Analog Converter (DAC) :- It is a device that transforms digital data into an analog signal.
A DAC can reconstruct sampled data into an analog signal with precision. The digital data may be
produced from a microprocessor, Application Specific Integrated Circuit (ASIC) or Field
Programmable Gate Array (FPGA), but ultimately the data requires the conversion to an analog signal
in order to interact with the real world.

A D/A converter takes a precise number (most commonly a fixed-point binary number) and converts
it into a physical quantity (example: voltage, pressure, temperature). D/A converters are often used
to convert finite-precision time series data to a continually varying physical signal.

Digital Data:-

Evenly spaced discontinuous values, temporally discrete, quantitatively discrete. Analog Data
(Natural Phenomena):-

Continuous range of values, temporally continuous, quantitatively continuous.
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rr00r  —
orerrr

ETETT - - DAC )
vQOEOY = -

Digita Analog

Fig. no. 15.1.a: Basic Digital to analog signal representation.

— DO —>
— D1 —>»
— D2 —>»
Digital —— D3 —= 8-Bit DAC Analog
Input  —— D4 —  (pigital to Analog Converteny | > Voltage
— D5 —>»
— D6 —>»
— D7 —>»

Fig. no. 15.1.b: Basic 8 Bit Digital to analog converter.
V11 Suggested Circuit diagram used in Laboratory with related equipment rating:

a) Suggested Circuit diagram

Fig. no. 15.2.a: Lab Practical Setup by set LSB data Bit high Analog output is low voltage
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Fig. no. 15.2.b: Lab Practical Setup by set MSB data Bit high Analog output is high voltage

b) Create DAC .vhd file diagram :--

fvi) il

Logic input

& SE Project Navigator (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\pulkit\DAC\DAC xise - [DAC_7528.vhd] X
@[ile Edit View Project Source Process Tools Window Layout Help -8 X
DREP L DDX|va| i A2BRARINBEDS:LRPEL:Q
[Design +08X &€ 19 a
View: @ ﬁlllmp‘ememauun (®) @Slmu{ahnn 5 20 library IEEE;
Hi h — 21 use TD_LOG.
g 22 use TD_L0G
] pac o | 23 use STD_LOGIC_UNS
= €3 xc3s400-5pq208 24
[Rs DAC - Behavioral (DAC_7528.vhd) 25 or sine wave.
2 26
o 27
A 28
| 29
P A %5
= Al =
* 32 entity DAC is
= 33 Port ( clk : in
O 34 st : in
;_ ) No Processes Running o s cs out
74 | Processes: DAC - Behavioral Ab—| 36 WE, Guoub L
ﬁ Design S Report 37 a_b : out std_logic;
E_t_ I Des!gnul:ﬁrnary eports 38 led : out std_logic_vector (7 downto 0);
eSigmies 39 din : out std logic vector(7 downte 0)
?{ User Constraints 40 = =
Bl SELTE A 41 ¥
V!ew RTL Schematic ) 42 end DAC:
| View Technology Schematic
) Check Syntax g2
hitect: Beh 1 of DAC
¥)  Generate Post-Synthesis Simulation M... :: grchitecture Behavioral o =
@82 Implement Design s 46 signal clk2 : std logic; o
¥)  Generate Programming File =
& Confinure Tarnst Device. hd < _ i 2
» St B8 Desgn [ Fles [ Lbraries z Design Summary (Synthesized) B DAC_7528.vhd QJ
| Console ©08 X
A
Process "Synthesize - XST" completed successfully
v
< >

Console @ Erors 1\ Warnings 3§ Findin Files Results

Fig. no. 15.3: .vhd file diagram
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¢) DAC Simulation waveforms by set input bit forcefully constant :-

£ 1Sim (P.20131013) - [Default.wcf| g Cut Ctrl+X B N
f File Edit View Simulation [y Copy Ctrl+C 8 x
Paste CtrlV ) BETME AR ALRBAIR et @ » X Lo |v]6z || ||CIRedanch
X Delete Del
Rename
04 Find.. T e e e |
Select Al CteA I________
o | ) I A A

Name e [ [ |
Radix [ I R S R

> B atizza) DiiderColo | —— 1 TTETTTTr 10TV p— —

1 ramp Reverse Bit Order i==———

1 data

{9 Go To Source Code

Show Drivers

Force Clock...

Remove

New Divider + 1,000,000 ps
— % New Virtual Bus 2
UETaUILWCTg 8
Console «+08 X
WARNING: A WEBPACK icense was found. A

WARNING: Please use Xilinx License Configuration Manager to check out a full ISim license.

WARNING: ISim will run in Lite mode, Please refer to the ISim documentation for more information on the differences between the Lite and the Full version,

This is a Lite version of ISim.

Time resolution is 1ps

Simulator is doing dircuit initialization process.

Finished dircuit initialization process.

ISim> v
@ console T Compiationlog @ Breakpoints 194 Findin FilesResults [y Search Results
Force the selected signal to a constant value Sim Time: 1,000,000 ps

Fig. no. 15.4.a: Simulation diagram
£ 15im (P203013) - Defauttavely’]
jFiIe Edit View Simulation Window Layout Help

1@ b & L00s |4z || | G Redaunch
308, Ko

p B el

, DI

T ae

- |

Fig. no. 15.4.b: Simulation diagram (arrow shows peak level of converted analog signal)
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c. Actual practical setup diagram

VIl Resources Required
Table 15.1 Resources
Sr. No. g‘sggg;g:g Specification Quantity
1 Device: Xilinx FPGA (XC3S400 PQ208), On board
EPGA +5V, +3.3\_/, jlr2.5V supply to FPGA and other
Development hardware circuit., On board, 2 Crystal 8MHz and 1 No.
Kit 25MHz.JTAG Interface (Boundary Scan), PROM

Interface (XCFO02S),40 pin, 4 header connector for

external 1/0's

2 Desktop PC Pgrsonal computer with _Iatest cfonflguratlon. Loaded 1 No.
with open-source IDE, simulation and program

downloading software, UPS and Antivirus.

3. Voltage: - DC: 600 volts; AC: 600 volts; DC Accuracy:
Digital Multi * O_.S% + 3 digit; AC Accuracy: + 1% + 3-digit,
meter ReS|star}cg: -40 M ohm; Resistance Ac_curacy: +1.5% 1 No.
+ 3-digit, AC/DC voltage, resistance,
capacitance, frequency measurement.

IX Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

X Procedure
1. Create the Xilinx ISE project for expected FPGA design, by doing the following in ISE:
a. Inthe ISE software, select File > New Project.
b. In the New project wizard enter the project name and location, respectively.
c. Select HDL or Schematic as the Top-level source type, and click Next.
2. Create New Source file. Select Source Type” select the Source type and give the name
to the source then click “Next”.
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B~ w

schematic. Ref Fig no.15.3.

5. Create Test Bench file- A test bench is HDL code that allows to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error

checking, file input and output, and conditional testing.

(o)}

file for simulation. Or

a. Directly go to simulation tab — Process DAC behavioural — ISim simulator—select input
entity bit — right click — select Force constant. Ref Fig no.15.4.a.

In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to make sure
that didn’t make any syntax errors while making changes.

8. Double click on “Simulate Behavioural Model” in the “Process Panel”, which will open the

~

ISim software with test bench loaded.

9. ISim simulator window will open with simulation executed, as shown in Ref Fig no.15.4.b

where able to simulate designs and check for errors.

10. After simulation Build and Test DAC Using FPGA development board.
11. To create .ucf file -- Go to User Constraints — select Floorplan Area/lO/Logic (Plan

Ahead) —

Windows — Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.
13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per
practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC and select

Program.
15. Verify expected result on relevant FPGA lab Kit.

SAMPLE PROGRAM 1: Step 2. Develop VHDL code for DAC

. Define Module”. Enter the entity used in design and then click “Next”.
. Develop VHDL code for given problem and Synthesize the .vhd file and view RTL

. Go to implementation to simulation tab , right click on main source file and create Test Bench

VHDL Code using if else statement
Library IEEE;
use IEEE.STD_LOGIC_1164.ALL;
use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;
use work.sine_4096_8.all; --using package for sine wave.
entity DAC is
Port (clk : in STD_LOGIC; --system clock
rst:in std_logic; --system reset
cs :out std_logic; --chip select
wr : out std_logic; --write enable
a_b :out std_logic; --output select
led : out std_logic_vector(7 downto 0); --output leds
din : out std_logic_vector(7 downto 0) --input to DAC
);
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end DAC;

architecture Behavioral of DAC is

signal clk2 : std_logic;

signal cntr : std_logic_vector(22 downto 0);
signal ramp : integer range 0 to 4100 ;
signal data : integer range 0 to 260 ;

begin

cs <='0}
wr <="0",
a_b<="1"

clk2 <= cntr(2);
led <=conv_std_logic_vector(data,8);
din <= conv_std_logic_vector(data,8);

process(clk,rst)
begin
if(rst = '"1"then
cntr <= (others =>'0";
elsif(clk'event and clk ='1"then
cntr <=cntr + 1;
if(cntr="11111111111111111111111")then
cntr <= (others =>"'0";
end if;
end if;
end process;

process(rst,clk2)
begin
if(rst = "1")then
ramp <= 0;
elsif(clk2'event and clk2 ='1"then
ramp <=ramp + 1,
if(ramp = 4095)then
ramp <=0;
end if;
data <= amp2(ramp);
end if;
end process;
end Behavioral;
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Problem statement for student: Design VHDL Code for DAC using if else statement.
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Step 1: Develop VHDL code.

VHDL Code using if else statement performed in lab practical.

X1 Resources

Table 15.2 Resources

Sr.

no Instrument /Components

Specification

Quantity

XI1 Actual Procedure Followed (use blank sheet provided if space not sufficient)
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X1l Observation Table.
Table 15.3 Truth Table DAC

Sr. Digital Data input Analog output voltage in volts
no.

1 0000 0000

2 0000 0011

3 0000 1111

4 0011 1111

5 11111111

XIV  Result (Output of the Program)

XVI  Conclusions and Recommendation (Actions/decisions to be taken based on the
interpretation of results)

XVIl Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO.

1. Write VHDL Code for ADC using FPGA board.

[Space for Answers] (If required attach separate page)
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XVIIl  Suggested references for further reading

Sr

no. Link/Portal Description

1 https://www.pantechsolutions.net/vhdl-code-to-simulate-4-bit-binary- | 4 bit binary counter
counter-by-software-using-spartan-3-starter-kit tutorial

2 https://www.Xxilinx.com/support/documentation/data sheets/ds610.pdf | EDA tool

3 https://forums.xilinx.com/ ISE Quick start tutorial
https://www.rohm.com/electronics-basics/ad-da-converters/what-are- .

4 P VHDL tutorial
ad-da-converters
https://www.elpr .com/digital-to-analog-converter-dac- .

5 ttps- JiA . elprocus.com/digital-to-analog-converter-dac VHDL programming
applications/

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage

Process related(15 Marks) 60% (15)
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Working with FPGA 10%

Product related (10 Marks) 40%(10)
4 | Correctness of algorithm/ Flow chart 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission, Answer to sample questions. 05%

TOTAL 100% (25)

Marks Obtained

Dated signature of Teacher

Process Related
(15)

Product Related
(10)

Total
(25)
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Practical No. 16: Design Stepper motor controller using FPGA Board.

I. Practical Significance
FPGA provides a good combination to achieve both high speed and high precision motion on a compact
hardware. It can easily drive full, half and micro-step mode applications due to the flexibility and the
reduced computing time with the FPGA implementation. FPGA can drive several stepper motors
simultaneously without increasing the processing time. This practical will help the students to develop
skills to interface stepper motor to FPGA and rotate in clockwise and anticlockwise direction.

I1. Industry/Employer Expected outcome(s)
The aim of this course is to attend following industry/employer expected outcome through various
teaching learning experiences:
“Develop VLSI-based electronic circuit/component using HDL”.

I11. Course Level Learning outcome(s)
CO-4 Develop VHDL program for given application.

IV. Laboratory Learning Outcome(s)
Optimize the VHDL code to Rotate stepper motor in clockwise direction

V. Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.

V1. Relevant Theoretical Background
Stepper motor: -
The basic principle of stepper motor is electromagnetic induction which means while apply a current
to the circuit, the EMF will be induced due to change of magnetic field of the circuit.

Working of stepper motor

The rotor shaft of the stepper motor is surrounded by the electromagnetic stator. The rotor and stator
have poles which would be teethed or depends upon the motor type. When apply the electrical pulse
to the stator which gets energized and produced EMF. The EMF cuts the conductor of the rotor. Now
the torque will be introduced. This torque (force) is used to rotate the rotor shaft which means the
rotor align itself along with stator.

Direction selects Stepper motor Shaft
> output rotation
A
Frequency Clock pulses
selects >

Fig. no.. 16.1: Basic Stepper motor system
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The stepper motor operates at various modes such as full step, half step, Micro step Full step: -
The full step of stepper motor is 200 steps per revolution. So the angle of rotation is 1.8 degrees
which is calculating from given formula.

Step angle = 360 degrees / no of steps. Step angle = 360 / 200 = 1.8 degrees.

Half step: -

The half step of stepper motor is 400 steps per revolution. So the angle of rotation is 0.9 degrees
which is calculating from given formula.

Step angle = 360 degrees / no of steps. Step angle = 360 / 400 = 0.9 degrees.

Micro step:-

The advanced stepper motor has come with micro step system. Micro stepping of stepper motor
means which subdivides the number of positions between poles for increasing the steps. Some
micro stepping has a capable of divide a full step (1.8 degrees) into 256 micro steps. The result
would be 51200 steps in one revolution (0.007 degrees/step).

Interfacing stepper motor with Spartan3 FPGA Development Kit:-

The motor is used to covert mechanical energy into electrical energy. Stepper motor is not like as
any other motor which means is not rotating continuously. It is rotating step by step according to
given electrical pulse. The FPGA cannot drive stepper motor directly. Because of the I/O capability
of FPGA is 3.3v. So for the driver circuit are required able to drive the stepper motor. A full rotation
divides into a number of equal steps. So this motor called as also stepper motor.

The four different color wires represent the four different windings. Red-Yellow and White-Blue
are the four-color wires.

/ Stator

Fig. no.. 16.2: Stepper motor stator and rotator

L1-Red-1a
L2-Yellow-1b
L3-White-2a
L4-Blue-2b

The control sequence for rotating the motor is shown in the table 15.1 and 15.2.
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The respective windings should be made high according to the sequence given in the table
and the controller very well executes this function.

Table No. 16.1: Clockwise Rotation of stepper motor

Step L1 L2 L3 L4
1 1 0 1 0
2 0 1 1 0
3 0 1 0 1
4 1 0 1 1

Table No. 16.2: Anti Clock Wise Rotation of stepper motor

Step L1 L2 L3 L4
1 1 0 0 1
2 0 1 0 1
3 0 1 1 0
4 1 0 1 0

The above shown sequence is in full step mode. In a single step the motor rotates by 1.8 degree.

VIl  Circuit diagram used in Laboratory with related equipment rating.
a) Suggested Practical JTAG cable setup:
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Fig. no..16.2: Lab Practical Setup

b) Create stepper motor .vhd file diagram :-

Natform

& ISE Project Navigator (P.20131013) - F:Al SCHEME\VI SEM | SCHEME\pulkit\sample\sample.xise - [ALU_code.vhd] X
[2) File Edit View Project Source Process Tools Window Layout Help -8 x
ip | |: @ 2 =R -
D2EP L)X X|oa| o p RLARBIA mB T Q
= L =
|Design <08 x| 19 ~
[ | View: @ &} implementation O 20 library IEEE;
rarcin 21 wuse IEEE.STD_LOGIC_1164.ALL:
‘El reraIchy: 22 use IEEE.NUMERIC_S
G| - € sample 23 use IEEE.STD_LOGIC_UNSIGNED.ALL:
— | & £3 xc35400-5pq208 - 24
¢8| © [Wdh ALU_code - Behavioral (ALU_code.vhd) 25 entity ALU code is
& [’ ALU_code.ucf ) 26 Port ( input_A : in SIGNED (3 downto 0):
¥ —| 22 input_B : in SIGNED (3 downto 0):
A 28 out_final : out SIGNED (3 downto 0):
| €2 NoProcesses Running | 20 select_operation : in STD_LOGIC_VECTOR (3 downto 0)):
— . 30 end ALU code;
71 | Processes: ALU_code - Behavioral Gl e =
X Design Summary/Reports % | 32 architecture Behavioral of ALU code is
@ Design Utilities = 33 begin
= User Constraints ©| 34 process(inpuc_a,inpuc_B,select_operation)
% Create Timing Constraints ® 35 Dbegin
1/0 Pin Planning (PlanAhead) - Pre-Sy.. | —| 36 case select_operation is
1/0 Pin Planning (PlanAhead) - Post-S... 37
[€  Floorplan Area/I0/Logic (PlanAhead) 38 when X707 =>
- B4\ Synthesize - XST 39 out_final <= input_A + input_B;
View RTL Schematic 20 when X"1" =>
View Technology Schematic 41 out_final <= input_A - input_B:
€2 Check Syntax 42 when X"2" =>
)  Generate Post-Synthesis Simulation M... 43 out_final <= input_A and input_B;
- €24\ Implement Design 44 when X"3" =>
22 Generate Programming File 45 out_final <= input_A nand input_B:
£-1%  Configure Target Device 46 when X"4" => v
@  Generate Target PROM/ACE File v < >
& Start 3 Design L) Fles [) Lbraries z Design Summary *HE] ALU_code.vhd a|
Console a=-E3
ISim simulation engine GUI launched successfully ~
Process "Simulate Behavioral Model" completed successfully
v

Fig. no.. 16.3: .vhd file diagram

c) Create View technology schematic diagram: -
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& ISE Project Navigator (P.20131013) - F:\l SCHEMEVI SEM | SCHEME 4 - (Tech1)] - X
¥ File Edit View Project Source Process Tools Window Layout Help -8 %
o2 | 2 ALPBRLARIAIZTHIZ: LR v
Design 08X 'k
View: @ 18} mplementation O 5 Simulation b
Hierarchy

& steppermotor

= €3 xc35400-5pq208 t prn t
[l stepmotor - Behavioral (stepper_motor.vhd) S e 0 0 r

a speed(3:0) s2out(3:0)

4
m clk
< > dirctn

) NoProcesses Running

£ | Processes: stepmotor - Behavioral rst_b

2| £ Design Summary/Reports
: Design Utilties
{|= g User Constraints ‘ ‘
— | & 2.4\ Synthesize - XsT
View RTL Schematic ® t t
i Ty S stepmotor
) Check Syntax
) Generate Post-Synthesis Simulation Model
# ) Implement Design
€2 Generate Programming File
# @  Configure Target Device
€ Analyze Design Using ChipScope ) Design Summary (Synthesized) El stepper_motor.vhd

1
t
N

[E3

stepmotor (Tech1) B8

Fig. no.. 16.4: View technology schematic diagram

d) Stepper motor Simulation waveforms-

B

AR 45EX00e|Na AT ANAPBAIA H Q) sz || Getan

/

d 16,000 s 16,200 s 16,400 ns
) -

] 1 ok

/

(8] v ) soeecio

& 2 - .
= 1) Force Selected Signal
|
f Enter parameters below to force the signal to a constant
1 LB vallie. Assignments made from within HOL code or any
go 0 reviously applied constant or lock force will be
overidden.
1 Y
.“Eil 11 Signil Name: fstepmotorfdictn
il 1 Velue Radi Binary
m Force to Vale: 1
Starting at Time Offset: 0
Cancel after Time Offset:
Cancel Apnly Help
Py
j Defaultwefg B
Console #08X

Fig. no.. 16.5: Force selected signal to generate simulation file diagram
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£ lSim (P.20131013) - [Defaultwchg] - X
JF”E Edit View Simulation Window Layout Help

DAL ABEX® 8o M ) BEIC AR ALBAR e A @ ) 3 [1os)v|Ge || || @Retand

'
W] dirctn

B Defaultwefg 8

Cansole a08x

Fig. no.. 16.6: Simulation diagram

e) Actual Practical set up used in laboratory
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VII.

Required Resources/Apparatus/equipment with specifications
Table 16.3 Required Resources

Sr. No.

Instrument

/Components Specification Quantity

FPGA Device: Xilinx FPGA (XC3S400 PQ208), On 1 No.
Development kit board +5V, +3.3V, +2.5V supply to FPGA and
other hardware circuit, On board, 2 Crystal 8MHz
and 25MHz.JTAG Interface (Boundary Scan),
PROM Interface (XCF02S), 40 pin, 4 header
connector for external 1/O's

Stepper Motor With 5V / 1.2A rating, select frequency of rotation 1 No.
of motor through DIP switches, Select direction of
rotation (clockwise or counter clockwise.) through
toggle switch.

Desktop PC Personal computer with latest configuration. Loaded 1 No.
with open-source IDE, simulation and program
downloading software, UPS and Antivirus..

IX

w

8.

9.

Precautions to be followed
1.Use proper Mains cord.
2.To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3.Check syntax / rules for VHDL programming.

Procedure
Create the Xilinx ISE project for expected FPGA design, by doing the following in ISE:
a. Inthe ISE software, select File > New Project.
b. In new project Wizard, enter the project name and location, respectively.
c. Select HDL or Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the name to the
source then click “Next”.
Define Module”. Enter the entity used in design and then click “Next”.
Develop VHDL code for given problem and synthesize the .vhd file and view RTL schematic. Ref
Fig no.16.3 and 16.4.
Create Test Bench file- A test bench is HDL code that allows to provide a documented, repeatable
set of stimuli that is portable across different simulators. A test bench can be as simple as a file
with clock and input data or a more complicated file that includes error checking, file input and
output, and conditional testing.

Go to implementation to simulation tab, right click on main source file and create Test Bench file
for simulation or directly simulate and apply entity value forcefully as shown in fig 15.5.

In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioural Check Syntax” to make sure that
didn’t make any syntax errors while making changes.

Double click on “Simulate Behavioural Model” in the “Process Pane”, which will open the ISim
software with test bench loaded.

ISim simulator window will open with simulation executed, as shown in Ref Fig no.15.6. where
are able to simulate designs and check for errors.

10. After simulation implement it Using FPGA development board.
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11. Go to User Constraints — select Floorplan Area/lO/Logic (PlanAhead) — Windows — Properties

now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per practical
Kit set up) -- open Bit file -- and initialize Chain — Right click on Xilinx IC and select Program.

SAMPLE PROGRAM :- Develop VHDL code for Stepper Motor.
VHDL Code using if else statement

library IEEE;

use IEEE.STD_LOGIC_1164.ALL; use
IEEE.STD _LOGIC_ARITH.ALL,;

use IEEE.STD_LOGIC _UNSIGNED.ALL;

--use UNISIM.VComponents.all; entity

stepmotor is
Port (clk : in STD_LOGIC;--input clock

dirctn : in STD_LOGIC;--direction

speed : in STD_LOGIC_VECTOR(3 downto 0);--frequency select
s2out: out STD_LOGIC_VECTOR(3 downto 0);--output to stepper 3

flasher<=flasher+1; counter<="00000000000000000000000";

end if; elsif(speed="0111")then
if(counter(17)="1")then
flasher<=flasher+1; counter<="00000000000000000000000";
end if;
elsif(speed="1111")then
if(counter(16)="1")then
flasher<=flasher+1,
counter<="00000000000000000000000";
end if;
end if;

if(dirctn="0")then--direction check

case flasher is

when "00"=>s2out<="1000"; --"0001”; --step 1 "0101”*; --
when "01"=>s20ut<="0100"; --"0010"; --step 2 "1001”*; --

when "10"=>s20ut<="0010"; --"0100"; --step 3 "1010™; --
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when "11"=>s2out<="0001"; --"1000; --step 4 "1001”; --
when others=>s2out<="XXXX": end case;

else case flasher is
when "00"=>s2out<="0001"; --"1000"; --step 1"0110”; --

when "01"=>s2out<="0010"; --"0100”; --step 2sout<="1010"; --
when "10"=>s2o0ut<="0100"; --"0010"; --step 3sout<="1001"; --

when "11"=>s2out<="1000"; --"0001"; --step 4sout<="0101"; --
end if;

end if;
when others=>s2out<="XXXX": end case;

end process; end Behavioral;
e Problem statement for student: Design VHDL Code for Stepper Motor using if else statement etc.

VHDL Code using if else statement
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X1l Resources

Table no. 16.4 Resources

Sr. No. Instrument /Components Specification Quantity

X1l Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIIl  Observations (use blank sheet provided if space not sufficient)

Stepper motor operations as per select direction input value is (verified/ not verified) using
FPGA development board.

XIV  Result (Output of the Program)
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XVIl Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO
1. A stepper motor with a step angle of 7.5 degrees. Write requirement of steps per revolution.

2. Write 5 wires and 6 wires stepper motor technical specification.
3. Write FPGA limitations to drive stepper motor without driver circuit.
4. If a motor takes 180 steps per revolution then give the step angle for this motor.

[Space for Answers] (If required attach separate page)

..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
0 000000000000000000000000000000000000000000000000000000060000600006006006006000060060000006060000600000000000000000000000000000000000000
0 000000000000000000000000000000000000000000000000000000000006000060060000600006006000000600000600000000000000000000000000000000000000
..............................................................................................................................
..............................................................................................................................
..............................................................................................................................
0 0000000000000000000000000000000000000000000000000000000600060000006000060060000600606000600000600000000000000000000000000000000000000

€0 0000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000
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XVIII Suggested references for further reading

Sr Link/Portal Description
no.

1 https://www.xilinx.com/support/documentation/data sheets/ds610.pdf | Decoder tutorial

2 https://forums.xilinx.com/ VHDL programming

3 https://www.researchgate.net/publication/258507854 FPGA based s | ISE  Quick  start
tepper motor controller tutorial

4 https://www.pantechsolutions.net/interfacing-stepper-motor-with- VHDL tutorial

spartan3-fpga-development-Kit

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and

product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
Coding and Debugging ability 30%
Making connections of hardware 20%
Working with FPGA 10%
Product related (10 Marks) 40%(10)
Correctness of algorithm/ Flow chart 20%
Relevance of output of the problem definition. 15%
Timely Submission, Answer to sample questions. 05%
TOTAL 100% (25)

Dated signature of

Marks Obtained Teacher
Process Related Product Related
(15) (10) Total (25)

Maharashtra State Board of Technical Education 173


https://www.xilinx.com/support/documentation/data_sheets/ds610.pdf
https://forums.xilinx.com/
https://www.researchgate.net/publication/258507854_FPGA_based_stepper_motor_controller
https://www.researchgate.net/publication/258507854_FPGA_based_stepper_motor_controller
https://www.pantechsolutions.net/interfacing-stepper-motor-with-spartan3-fpga-development-kit
https://www.pantechsolutions.net/interfacing-stepper-motor-with-spartan3-fpga-development-kit
https://www.pantechsolutions.net/interfacing-stepper-motor-with-spartan3-fpga-development-kit

VLSI Applications 316340

Practical No. 17: Implement four Bit ALU or sequence generator using FPGA

Practical Significance

An arithmetic logic unit (ALU) represents the fundamental building block of the central processing
unit of a computer. An ALU is a digital circuit used to perform arithmetic and logic operations.

A sequence detector is a sequential circuit that outputs high (1) when a particular pattern of bits
sequentially arrives at its data input. This practical will help the students to develop programming
skills i.e. four Bit ALU or sequence generator application on FPGA board using Xilinx ISE tools.

Industry/Employer Expected outcome
The aim of this course is to attend following industry/employer expected outcome through various

teaching learning experiences:
“Develop VLSI-based electronic circuit/component using HDL”.

I11. Course Level Learning outcome(s)

v

CO-5 Interpret VHDL simulation and synthesis

Laboratory Learning Outcome(s)
Develop VHDL code for 4-bit ALU and simulate it using FPGA

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.

Relevant Theoretical Background

a) An arithmetic logic unit (ALU) is a digital circuit used to perform arithmetic and logic
operations. It represents the fundamental building block of the central processing unit (CPU) of a
computer. Modern CPUs contain very powerful and complex ALUs. In addition to ALUs, modern
CPUs contain a control unit (CU).

Most of the operations of a CPU are performed by one or more ALUSs, which load data from input
registers. A register is a small amount of storage available as part of a CPU. The control unit tells
the ALU what operation to perform on that data, and the ALU stores the result in an output register.
The control unit moves the data between these registers, the ALU, and memory.

All information in a computer is stored and manipulated in the form of binary numbers, i.e. 0 and
1. Transistor switches are used to manipulate binary numbers since there are only two possible
states of a switch: open or closed. An open transistor, through which there is no current, represents
a 0. A closed transistor, through which there is a current, represents a 1.

Following fig. shows how AND operation and OR operation is performed. Four bit two inputs and
four-bit one output.
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inputs inputs inputs inputs
0 0 20 0o 1 s SR |
AND gate
0 0 0 i
ocutput output output output

Fig. no. 17.1: AND operation.

inputs inputs inputs inputs
00 10 01 11
OR gate
0 1 1 1
output output output output

Fig. no. 17.2: OR operation.

Following table shows that ALU operation performed according to select the signal. With
this logic we can develop the VHDL code.

Table 17.1: Signal and operation.

Select signal Operation
0000 Addition
0001 Subtraction
0010 ANDiIng operation
0011 NANDing operation
0100 XORing operation
0101 XNORing operation
0110 ORIing operation

b) A sequence detector is a sequential state machine. A sequence detector is a sequential state
machine which takes an input string of bits and generates an output 1 whenever the target
sequence has been detected.

There are two types

I.) Moore machine ii.) Mealy machine

i.) In a Moore machine, output depends only on the present state and not dependent on the input
(x). Hence in the diagram, the output is written with the states. The state diagram of a Moore
machine for a 101 detector is:
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0 (correct bit)

Fig. no. 17.3: State diagram of a Moore machine.
ii. In a Mealy machine, output depends on the present state and the external input (x).
VIl Suggested Circuit diagram used in Laboratory with related equipment rating.

a. Suggested Practical JTAG cable setup: -

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Greenflickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable

4]

P15 identify a particular cable, use the following JTAG command:

jtagconfig --setparam <cable number> Identify <1 = on, 0 = off>

Fig. no. 17.4.a: Practical Setup with JTAG CABLE
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lgital iInput Output Interface Board

Fig. no. 17.4.b: Lab Practical Setup

b. Create four Bit ALU .vhd file diagram :-

oa

_# ISE Project Navigator (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\pulkit\sample\sample.ise - [ALU_code.vhd] X
File Edit View Project Source Process Tools Window Layout Help -8 x
DREPIE| % X oo 2LRARARIAZTEILRIPELQ
| Design 08 x| E[ 19 - Al
E) | view: ® {8 implementation O [ Simuiation = 20 1library I
3 [ h — 21 wuse I
Q erarchy 55 use T .
| - E] sample " 23 use I ) . UNSIGNED.ALL;
1 £ xc35400-5pq208 24
= [lg% ALU_code - Behavioral (ALU_code.vhd) 25 entity ALU code is
& [ ALU_code.uct ) 26 Port ( input A : in SIGNED (3 downto 0);
v — 27 input B : in SIGNED (3 downto 0);
| A 28 out_final : out SIGNED (3 downto 0);
| B2 NoProcesses Running o| 29 select_operation : in STD_LOGIC VECTOR (3 downto 0)):
= g 30 end ALU code;
71, | Processes: ALU_code - Behavioral ol B % =
,{: % Design Summary/Reports % 32 architecture Behavioral of ALU code is
Sl Design Utilities e 33 Dbegin
5‘{ User Constraints O 34 process(input_A,input_B,select_operation)
= {Z}  Create Timing Constraints )| 35 Dbegin
L [€] /0 Pin Planning (PlanAhead) - Pre-Sy... = 36 case select_operation is
[€] /0 Pin Planning (PlanAhead) - Post-S... 37
[@  Floorplan Area/I0/Logic (PlanAhead) 38 when X"0" =>
£ P28\ Synthesize - XST 39 out_final <= input_A + input_B;
View RTL Schematic 40 when X"1" =>
View Technology Schematic 41 out_final <= input A - input_B;
€)  Check Syntax 42 when X"
F)  Generate Post-Synthesis Simulation M... 43 out_final <= input A and input B;
(- €2 4\ Implement Design 44 when X"3" =>
T2() Generate Programming File 45 out_final <= input_A nand input_B;
5%  Configure Target Device 46 when X"4" => v
1 Generate Target PROM/ACE File v < >
# St 5 Desgn ) Fles [ Lbraries Z Design Summary (Implemented) 1E] ALU_code.vhd (]
| Console «08 X
ISim simulation engine GUI launched successfully "~
Process "Simulate Behavioral Model" completed successfully
v

<

Fig. no. 17.5: .vhd file diagram

c. Apply entity values forcefully to generate simulation waveforms.
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£l 1Sim (P.20131013) - [Defaultwefg] - X
jFMe Edit View Simulation Window Layout Help

ORI XBEXE® 0 o |G BREIS AN ALRAR e =N B P HE Lo v/ [J Redaunch

{ |

¥’

Q 2 Copy
O Paste
® g o X Delete
Eg > P input_ol30] Rename
B out finall3:0 @
3 4 'm ut fral3 [ # Find.. Clik+F
select_operation[3 |
u b Tl seec et Select Al i+
Expand
I
Collapse
Ungroup
a
- Name
Radix
Signal Color
Divider Color
- REVE’,SE Elt O’der
T_; Go To Source Code 5
— Show Drivers =
=) %]
Console Force Clock... #O8x
#igim force add {falu_code/select operal  Remove Force A
ISim>
E_swm force add {/alu_code/select_opera ] : New Group
im>
#run 1.00us New Divider
L5im> X New Virtual Bus
#run 1.00us
ISim> v
@ Console j Compiationlog @ Breakpoints 194 FindinFiesResults (g SearchResults
Force the selected signal to a constant value Sim Time: 15,000,000 ps
Fig. no. 17.6: test bench file diagram
d. Bit ALU Simulation waveforms-
£ 1Sim (P.20131013) - [Defaultwcfg] - X
[ Flle Edit View Simulstion Window Layout Help
D&a e ® 0 oM x EAMS| AR ALB ARt @ » ¥ osv]éz | ||@rReond
B out fina
o
= Defaultmefg* [%]
Console 08 X
#igim force add {/alu_code select_operation} 0101 -radix bin ~
ISim>
#igim force add {/alu_code fselect_operation} 0101 fadix bin
ISim>
#run 1.00us
ISim>
#run 1.00us
1Sim> v

B console ] Compiatnlog @ Breakpoints (6 FindinFikesResults |y Search Results

Fig. no. 17.7: Simulation diagram
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e. Actual practical set up used in laboratory

VIIIl. Resources Required
Table 17.1 Resources Required
Sr. Instrument / e i
No. Components Specification Quantity
1 | FPGA Device: Xilinx FPGA (XC3S400 PQ208), On board 1 No.
Development | +5V, +3.3V, +2.5V supply to FPGA and other
kit hardware circuit.,, On board, 2 Crystal 8MHz and

25MHz.JTAG Interface (Boundary Scan), PROM
Interface (XCF02S),40 pin, 4 header connector for
external 1/0's

2 | Desktop PC  Personal computer with latest configuration. Loaded 1 No.
with open-source IDE, simulation and program
downloading software, UPS and Antivirus.

IX Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

X Procedure
1. Create the Xilinx ISE project for top-level FPGA design, by doing the following in ISE: In the
ISE software, select File > New Project.
i. In the Project name and Project location fields, enter the project name and location,
respectively. Select HDL or Schematic as the Top-level source type, and click Next.
2. Create New Source file. Select Source Type” select the Source type and give the name
to the source then click “Next”.
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3.
4.

5.

I.
9.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and synthesize the .vhd file and view RTL schematic.
Ref Fig no.17.7.

Create Test Bench file- A test bench is HDL code that allows to provide a documented,
repeatable set of stimuli that is portable across different simulators. A test bench can be as
simple as a file with clock and input data or a more complicated file that includes error
checking, file input and output, and conditional testing.

Go to implementation to simulation tab, right click on main source file and create Test Bench
file for simulation or directly simulate and apply entity value forcefully as shown in fig 16.8.
In order to view test files, select the box of “Simulation” in the “View Panel” of the “Design”
panel. In the “Process Panel,” double click on the “Behavioural Check Syntax” to make sure
that didn’t make any syntax errors while making changes.

Double click on “Simulate Behavioural Model” in the “Process Pane”, which will open the
ISim

software with test bench loaded.

ISim simulator window will open with simulation executed, as shown in Ref Fig no.16.9.
where are able to simulate designs and check for errors.

10. After simulation implement it using FPGA development board.
11.Go to User Constraints — select Floorplan Area/lO/Logic (Plan Ahead) — Windows —

Properties —
now assign pin configuration and save.

12 Go to Implement Design — Run all.
13. Go to Generate Programming File and Run
14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2 (as per

practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC and select
Program.

SAMPLE PROGRAM: - Step 1. Develop VHDL code four Bit ALU.

VHDL Code using When statement
library IEEE;

use IEEE.STD_LOGIC_1164.ALL,;
use IEEE.NUMERIC_STD.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity ALU_code is

end ALU_code;

architecture Behavioral of ALU_code is
begin

process(input_A, input_B, select_operation)
begin

Port (input_A: in SIGNED (3 downto 0);
input_B: in SIGNED (3 downto 0);
out_final: out SIGNED (3 downto 0);
select_operation: in STD_LOGIC_VECTOR (3 downto 0));

case select_operation is
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when X"0" =>out_final <= input_A + input_B; when X"1" =>out_final <= input_A -

input_B;
when X"2" => out_final <= input_A and input_B;
when X"3" =>out_final <= input_A nand input_B;
when X"4" => out_final <= input_A xor input_B;
when X"5" =>out_final <= input_A xnor input_B;
when X"6" => out_final <= input_A or input_B;
when others => null;

end case;
end process;
end Behavioral;

Problem statement for student: Design VHDL Code for Gray to Binary encoder using if else
statement logic gates etc.

Step 1: Develop VHDL code for four Bit ALU.

Xl Resources
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Table 17.2 Resources
ﬁlz. Instrument /Components Specification Quantity
1
2
3

X1l Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIIl  Observations (use blank sheet provided if space not sufficient)

ALU operations as per select input value is (verified/ not verified) using
FPGA development board.

XIV  Result (Output of the Program)
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XVI Conclusions and Recommendation

XVIl Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design more such
questions so as to ensure the achievement of identified CO
1.Write VHDL Code using FPGA board four Bit ALU using Case statement.

2. Write VHDL Code using FPGA board for sequence generator using if else statement.
[Space for Answers] (If required attach separate page)
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XVIII Suggested references for further reading

Sr Link/Portal Description
no.
1 https://www .Xxilinx.com/support/documentation/data sheets/ds61| VHDL
0.pdf programming
2 https://forums.xilinx.com/ ISE Quick start tutorial
3 https://en.wikipedia.org/wiki/Arithmetic logic unit VHDL tutorial
4 https://study.com/academy/lesson/how-to-design-sequence- Sequence Detector
detectors-steps-example.html

XIX  Assessment Scheme
The given performance indicators should serve as a guideline for assessment regarding process and
product related marks:

Performance indicators Weightage
Process related(15 Marks) 60% (15)
Coding and Debugging ability 30%
Making connections of hardware 20%
Working with FPGA 10%
Product related (10 Marks) 40%(10)
Correctness of algorithm/ Flow chart 20%
Relevance of output of the problem definition. 15%
Timely Submission, Answer to sample questions. 05%
TOTAL 100% (25)
Dated signature of
Marks Obtained Teacher
Proces&si 5F\;elated ProduacO?elated Total (25)
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